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1 Olive Tree Lab Suite Manual

Version 4.3
USER MANUAL

1.1 Olive Tree Lab Suite Introduction

Welcome to Olive Tree Lab, a suite of 3D acoustical software applications in one working
environment. These applications are, Room Acoustics (Room), Open Plan Office (Office) and
Outdoor Sound Propagation, (Terrain). Think of Olive Tree Lab as the equivalent of MS Office in
Acoustics, many applications talking to each other seamlessly.

Olive Tree Lab is the first ever acoustical software application which offers such flexibility among
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calculations in the various fields of acoustics within the same environment. No more transferring
incompatible data from one application to another. 

Olive Tree Lab is the first acoustical software application to include a Multilayered Structure Builder
based on the Transfer Matrix Method which calculates surface impedance, sound absorption
coefficient and sound transmission in structures or materials. It is the first ever acoustics software
to apply spherical wave propagation over impedance surfaces. This approach enables the
calculation of non-common acoustical phenomena such as surface waves and ground waves. 
Such waves have great impact on the simulation of outdoor sound propagation but also room
acoustics, especially at grazing incidence.

Within the coming year of Building, the software applications for the calculation of building
acoustics, sound transmission and radiation in buildings and structures, the OTL will provide a
complete unique approach in solving most of  the problems encountered by professionals in their
work.

Why OTL?
Have you wondered why your measured data never matched your predictions? Well, finally, after

years of frustration we finally decided to develop a software where our numbers finally matched.

Written from an engineer's and acoustic designer's point of view, we addressed your needs in

solving an acoustical problem.

We all need standards to abide by, and we have included them, but there are some cases

standards are not enough, and that's why we have our advanced calculation methods as well, to

deal with complex scenarios that need accuracy and not estimation.

We tried to make the software as intuitive as possible, we wish we could just implant "How to Use"

concept directly in your mind, but alas, there is always some frustration with learning a new

application. What we tried to do is to make it as fun as possible, and hope it's not too

overwhelming for you. Do contact us if you have any problems or need to know "How to do"

something.

What does OTL include?

 Olive Tree Lab - Room is a 3D room-acoustic modelling software on ISO3382-
1&2. Equipped with a powerful calculation engine, it allows users to evaluate the acoustical quality
of the spaces under study. Users can calculate impulse responses in a room providing system
designers and consultants with a unique set of tools for all aspects of professional applications,
from realistic modelling and simulation of room acoustics and sound system performance.  

Using Ray Tracing, the user can define the number of rays they wish to calculate, and auralise the
sound of the room.

Olive Tree Lab - Office is a 3D Open Plan Office modelling software based on
ISO 3382-3:2012 Acoustics – Measurement of room acoustic parameters – Part 3: Open plan
offices. Olive Tree Lab - Office deals with the optimisation of open plan offices in terms of speech
privacy and work distraction by activities in neighbouring working stations. Olive Tree Lab - Office
assists designers (acousticians, architects and others) in assessing the acoustics of open plan
office working spaces and offers the possibility to minimize interference among working spaces by
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virtually experimenting with the use of acoustical materials and smart furniture layout.

 Olive Tree Lab - Terrain is an Outdoor Sound Propagation software which
simulates and predicts Outdoor Sound Propagation and Noise Barrier efficiency, taking into
account geometrical spreading, atmospheric absorption, atmospheric turbulence, spherical wave
complex ground impedance, reflection and diffraction effects of natural or man made objects. The
results are displayed as level vs frequency or level vs spatial mapping. Moreover, an excess level
meter in the form of an LED meter indicates in real time whether noise criteria are met when
changing any of the model parameters, geometry, materials, noise emission or noise criteria
levels.
 

OTL-Terrain simulates sound propagation by the use of a ray model in a 3D environment. Apart

from sources and receivers, there can also be

 

objects (walls and other objects imported in the Geometry Viewport in the user interface)

ground/s created in Terrain and

barriers, a special group of entities in the application, used for noise control.

To enable such simulations an in-house path detector algorithm is applied with unlimited order of

reflections and diffractions in a 3D environment. Such power makes OTL-Terrain very sensitive to

any 3D objects placed in the model, therefore when modelling a model, caution should be used

since too much 3D representation would yield long calculation times whilst minimalistic modelling

might produce less accurate predictions. This is especially true in the case of comparing

measurements with predictions, since Terrain would consider surfaces and surface edges as

candidates for reflection and diffraction, taking into account their presence. 

OTL-Terrain offers advanced methods of calculations as well as ISO 9613-2 calculation methods. 

The multilayered structure builder is based on the Transfer Matrix

Method which calculates surface impedance, sound absorption coefficient and sound transmission

loss in structures or materials.  For porous materials the builder utilises the Allard-Johnson and the

Delany-Bazley models (6 parameter and 1 parameter model respectively). For perforated plates

the Vigran (2012) and for thin elastic plates the classical thin plates theory, are used.

OTL is the first ever acoustics software to apply spherical wave propagation over impedance of

multilayered surfaces, to calculate Excess Attenuation. This approach enables the calculation of

non-common acoustical phenomena such as surface waves and ground waves.  Such waves have

great impact on the simulation of outdoor sound propagation but also room acoustics, especially at

grazing incidence.

Polar Plot

The Sound Distribution & Scattering Polar Plot can be used to calculate sound distribution and

scattering, and in the future other coefficients such as sound diffusion and scattering coefficients.

This tool is very handy in room acoustics in designing auditorium sound reflectors and can be used
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in many ways for example to detect from individual reflectors first order reflections or first order

diffractions or first order sound reflections and diffractions to investigate sound distribution within

the audience. Once the desired result is obtained the cumulative effect of reflectors (all or part)

can be investigated in the 3D environment with infinite number of reflections and diffractions. In

other words, the initial design may need improvements, due to the effect of all the geometry in a

3D model. 

Features

Feature Suite

Standards  

ISO 9613-2

ISO 3382- 1

ISO 3382-2

ISO 3382-3

IEC 60268-16

Calculations  

Impulse Response Calulations

Auralisation (Binaural)

HRTF

Atmospheric Refraction

Precise Frequency Calculations

Precise Room Acoustics Calculations (T20, T30, T60, EDT, STI, C50, C80, D50)

Precise Open Plan Office Calculations (STI, D2,S, Lp,A,S,4 m,  Lp, rD, rP, Lp,B,)

Show Paths Functionality

Calculations of selected paths

Source Directivity

LP Indicative Calculations 

Indicative Open Plan Office Calculations 

Indicative Room Acoustics Calculations Real-Time

Multilayered Structures 

Sound Distribution & Scattering Polar Plot

Mapping Results  

Insertion Loss
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Excess Attenuation (LpTotal / LpDirect) Before 

Excess Attenuation (LpTotal / LpDirect) After

Lp before 

Lp after 

ISO 9613-2 

RT Mapping

STI Mapping

Mapping Criteria  

LP BNL - NR Criteria

Lp BNL - A-weighted  Criteria

Frequency Domain Results  

Insertion Loss

Excess Attenuation (LpTotal / LpDirect) Before 

Excess Attenuation (LpTotal / LpDirect) After

Lp Before

Lp After

Time Domain Results  

Impulse Response 

Room Acoustics, ISO 3382-1&2 (T20, T30, T60, EDT, STI, C50, C80, D50)

Auralisation (Binaural)

Calculation Options  

Atmospheric Turbulence Calculations

Fresnel Reflector Correction

Infinite Impedance- Spherical Wave Reflection Coefficient

Coherent Source Contribution

Reflection detection between diffraction points Infinite

Extra Features  

Advanced Calculation Options

Advanced Barrier Shapes

Absorptive Materials for Barriers

Ready made desks layouts

Point Receivers
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Line Receivers

Point Sources

Line Sources

Modeling Tools  

CAD tools

Import Images

Import/Export DXF/DWG

Database  

Noise Sources

Receivers Criteria

Material Properties for porous, perforated and elastic plates

Ground and surface types; flow resistivity

Materials Absorption Coefficients

Sound propagation principles used in OTL
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Hopefully this User Manual would be able to assist you in getting to know OTL, however should

you have any questions please don't hesitate to asks us at support@pemard.com.

Please note that some icons may have changed in appearance or colour, but their functions

remain the same as described in this manual.

1.2 Room Modes Introduction

Olive Tree Lab – Room Modes is a powerful 3D room-acoustics modelling software which
calculates the rooms resonances, with arbitrary geometry and different types of sound absorbing

mailto:support@pemard.com
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materials, based on methods of wave based geometrical acoustics. Users can efficiently map the
SPL distribution of a room using either the precise image source method or our unique and
efficient hybrid ray tracing algorithm. In addition the user can also estimate the reverberation time
of the room based on its material properties.

See "Room Modes" Section

Features

Feature
Room
Modes

Calculations  

Multilayered Structures (Absorption Coefficients)

Mapping Results  

Lp after 

Mapping Criteria  

LP BNL - NR Criteria

Calculation Options  

Fresnel Reflector Correction

Infinite Impedance- Spherical Wave Reflection Coefficient

Coherent Source Contibution

Extra Features  

Point Sources

Modeling Tools  

CAD tools

Import Images

Import/Export DXF/DWG

Database  

Noise Sources

Material Properties for porous, perforated and elastic plates

Ground and surface types; flow resistivity

Materials Absorption Coefficients
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2 Installing Olive Tree Lab Suite

2.1 Installation & Activation

For the trial version (valid for 14 days), download Olive Tree Lab and run the setup file. In order to
access OTL trial, you will need an internet connection. You will then be asked to contact us for a
trial Key activation license. Once you receive the activation key, select to activate OTL-Suite.
 
Once the trial period of 30 days has expired, you will need to purchase a license. Licenses can be

either delivered on a dongle  or electronically. 

For  the Dongle,  once its  inserted in  a USB port,  OTL will  be  activated  immediately.  Please note
that after the trial period, the software will not work.

Electronic  licenses  can  be  transferred  to  another  PC  by  clearing  it  from  the  existing  one  and
activating it on another. To clear your license, please go to Help>Clear License.
 

 

2.2 Equipment Requirements

a) Windows  Vista,  Windows  7,  Windows  8,  Windows  10,  Windows  Server  2003,  Windows
Server 2008 R2 (Required)

b) .Net Framework 4.5 or higher (Required)
c) Dual Core or better processor (Recommended)
d) Graphics Card with Direct X 10 and above(Recommended)

2.3 License Agreement

IMPORTANT PLEASE READ THE TERMS AND CONDITIONS OF THIS END-USER LICENSE
AGREEMENT ("EULA")  CAREFULLY:

This EULA is  a legal  agreement  between you (either  an  individual  or  a  single  entity)  and P.E.
MEDITERRANEAN  ACOUSTICS  RESEARCH  &  DEVELOPMENT  LTD  ("PEMARD")  for  the
Olive  Tree  Lab  Software  that  accompanies  this  EULA  which  may  include  associated  software
components, media, printed materials, and "online" or electronic documentation ("OTL").  

By installing, copying, or otherwise using OTL, you agree to be bound by the terms of this EULA.
This  license agreement  represents  the  entire  agreement  concerning  the  program  between you
and PEMARD,  (referred to as "licenser"),  and it  supersedes any prior  proposal,  representation,
or  understanding  between  the  parties.  If  you  do  not  agree  to  the  terms  of  this  EULA,  do  not
install or use OTL.

OTL  is  protected  by  copyright  laws  and  international  copyright  treaties,  as  well  as  other
intellectual  property  laws  and  treaties.  All  copyrights  to  PEMARD  are  exclusively  owned  by
PEMARD. The software product OTL is licensed, not sold.

1. GRANT OF LICENSE. 
   OTL is licensed as follows:

https://www.mediterraneanacoustics.com/downloads.html
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(a) Installation and Use.
PEMARD  grants  you  a  non-  exclusive  right  to  install  and  use  OTL  for  use  on  one  single
computer workstation. For any additional computer workstations, a separate license agreement
will be required. 
(b) You acknowledge that you have evaluated the trial version of the software prior to purchasing
it, and accept it “As Is” and that PEMARD has a “NO REFUND” Policy.

2. DESCRIPTION OF OTHER RIGHTS AND LIMITATIONS.
(a) Maintenance of Copyright Notices.
You must not remove or alter any copyright notices on any and all copies of OTL software.
(b) Distribution.
You may not distribute registered copies of OTL to third parties. Evaluation versions available for
download from PEMARDS’s website http://www.pemard.com may be freely distributed.
(c) Prohibition on Reverse Engineering, De-compilation, and Disassembly.
You may not reverse engineer, decompile, or disassemble OTL.
(d) Rental.
You may not rent, lease, or lend OTL.
(f) Compliance with Applicable Laws.
You must comply with all applicable laws regarding use of OTL.

3. TERMINATION
Without  prejudice  to  any other  rights,  PEMARD  may terminate  this  EULA if  you  fail  to  comply
with the terms and conditions of this EULA. In such event, you must destroy all copies of the OTL
software(s) in your possession.

4. COPYRIGHT
All title, including but not limited to copyrights, in and to OTL software and any copies thereof are
owned by PEMARD.  All title and intellectual property rights in and to the content which may be
accessed  through  use  of  OTL  is  the  property  of  the  respective  content  owner  and  may  be
protected  by  applicable  copyright  or  other  intellectual  property  laws  and  treaties.  This  EULA
grants  you  no  rights  to  use  such  content.  All  rights  not  expressly  granted  are  reserved  by
PEMARD.

5. NO WARRANTIES
PEMARD expressly disclaims any warranty for OTL. OTL is provided 'As Is' without any express
or implied warranty of any kind, including but not limited to any warranties of merchantability, non
infringement,  or  fitness  of  a  particular  purpose.  PEMARD  does  not  warrant  or  assume
responsibility for the accuracy of calculations, or completeness of any information, text, graphics,
links or other items contained within OTL.  PEMARD  makes no warranties respecting any harm
that may be caused by the transmission of a computer virus, worm, time bomb, logic bomb, or
other  such  computer  program.  PEMARD  further  expressly  disclaims  any  warranty  or
representation to Authorized Users or to any third party. The entire risk arising out of the use or
performance of Software remains with Licensee.

6. LIMITATION OF LIABILITY
In  no event  shall  PEMARD  be liable for  any damages (including,  without  limitation,  lost  profits,
business interruption, or lost information) rising out of 'Authorised Users' use of or inability to use
OTL,  even  if  PEMARD  has  been  advised  of  the  possibility  of  such  damages.  In  no  event  will
PEMARD be liable for loss of data or for indirect, special, incidental, consequential (including lost
profit), or other damages based in contract, tort or otherwise. PEMARD shall have no liability with
respect to the content of OTL or any part thereof, including but not limited to errors or omissions
contained  therein,  libel,  infringements  of  rights  of  publicity,  privacy,  trademark  rights,  business
interruption,  personal  injury,  loss  of  privacy,  moral  rights  or  the  disclosure  of  confidential
information.  Software  may  be  subject  to  expansions,  amendments  and  up-dates  without  any
warning.

http://www.mediterraneanacoustics.com
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7. LOST, STOLEN, DAMAGED DONGLES
All  software  developed  by  P.E.  Mediterranean  Acoustics  Research  &  Development  Ltd
(PEMARD)  is  supplied  with  a  copy  protection  device.  This  is  also  known  as  a  Dongle.  This
dongle represents the value of the program and cannot be replaced free of charge, if lost.
 
7.1 LOST OR STOLEN DONGLE
Should a Dongle be lost or stolen:
a)  In  the  event  that  a  Dongle  is  lost  or  stolen,  this  is  equivalent  to  losing  your  licence  for  the
software and consequently the cost to replace the licence(s) is the current purchase price of the
software.
b)  PEMARD shall  have  no  responsibility  or  obligation  in  the  replacement  of  the  Dongle  or  the
software  products  licensed  for  use.  Therefore  Customer  assumes  the  full  loss  of  the  software
products. Hence the software products must be repurchased from PEMARD.
c) In the event of a lost or stolen Dongle, Customer shall contact PEMARD without undue delay
to notify PEMARD that the Dongle in no longer in its possession.
d)  PEMARD  recommends  that  all  Customers  amend  the  software  products  purchased  as  an
insurable item on their business insurance policies.
e) Customers who have insured their software products against loss and/or theft may file a claim
with  their  insurance  company(s)  in  case  the  Dongle  is  stolen.  Once  a  settlement  value  is
received, Customer may contact PEMARD for further assistance.
 
7.2 DEFECTIVE DONGLE
Should a Dongle fail or become defective, it may be replaced based on the following:
a) There is no charge for the replacement of a defective Dongle.
b) Customer shall contact PEMARD to obtain a thirty (30) days temporary license
c)  Customer  shall  return  the  defective  Dongle  to  PEMARD  by  registered  mail  as  soon  as
possible,  but  not  later  than  thirty  (30)  days  after  receipt  of  the  temporary  licensed  issued  by
PEMARD to Customer. Once the Dongle has been received by PEMARD, a replacement Dongle
will be issued.
d)  Failure  to  return  the  defective  Dongle  within  the  allotted  time  period  of  thirty  (30)  days  will
result in the expiration of the thirty (30) days temporary license, and will result in the invoicing of
the software products provided in the new license file and the new Dongle.
 
7.3 DAMAGED DONLGE
Should a Dongle become damaged or break, it may be replaced based on the following:
a) There is a charge of  for the replacement of a damaged Dongle.
b) Customer shall contact PEMARD to obtain a thirty (30) days temporary license
c) Customer shall  contact PEMARD for a sales quotation for  a replacement Dongle.  The sales
quotation  is  to  be  used  to  generate  a  purchase  order  for  the  necessary  amount  plus  any
applicable costs, i.e. taxes and shipping.
d)  Customer  shall  return  the  damaged  Dongle  to  PEMARD  by  registered  mail  as  soon  as
possible,  but  not  later  than  thirty  (30)  days  after  receipt  of  the  temporary  licensed  issued  by
PEMARD  to  Customer.  Once  the  Dongle  has  been  received  by  PEMARD,  along  with  the
purchase order or required form of payment, the replacement Dongle and corresponding license
file will be shipped to the Customer.
e)  Failure  to  return  the  damaged  Dongle  within  the  allotted  time  period  of  thirty  (30)  days  will
result in the expiration of the thirty (30) days temporary license, and will result in the invoicing of
the software products provided in the new license file and the new Dongle.
 
8. SOFTWARE MAINTENANCE AND BUG FIXES
PEMARD  provides  maintenance  for  OTL  through  replacement  of  executable  modules,  or
updates. The availability of updates is announced on PEMARD’s Web sites and via e-mail.
While  we  attempt  to  provide  fixes  for  serious  problems,  there  might  be  cases  where  it  is
impractical  or  impossible  to  generate  a  fix,  due  to  compatibility  issues  or  the  potential  for
introduction of unwanted side effects.
Updates will take place automatically upon start-up of OTL.
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9. ACCEPTANCE
You acknowledge that you have read this license, fully understand it and agree to be bound by its
terms and conditions by clicking YES when prompted to do so when installing the program.
 
THIS POLICY IS SUBJECT TO CHANGE WITHOUT NOTICE.
 

2.4 Registration

Most users would have registered prior to buying to the software, If you haven't registered already
then it is recommended that you do so in order for us to notify you of any upgrades, bug fixes or
plug-ins as they become available. You may also be eligible for reduced upgrade prices to other
products in our Olive Tree Lab Software. You can register and update your registration at any time
in the future by visiting www.pemard.com
 
 
Note: You can retrieve your Signature Key number at any time by choosing Signature from the
Help menu.
 

2.5 Support & Update

Hopefully, this User Manual will help you master OTL, but if you still have questions, you may visit
our website for technical support and video tutorials or contact us for assistance.
 
Terminology:
 
Updates include minor versions, for example, from 1.0 to any 1.x update.
 
Upgrades include new major version of the product for example, from OTL 1.x to OTL 2.x, OTL
3.x, OTL 4.x, and so on.
 
Updates
 
Updates may contain new features, bug fixes in the existing program. OTL will automatically check
for updates upon start up.
 
To  find  out  your  current  version  at  any  time,  choose  About  OTL  from  the  Help  menu,  a  new
window will open with your version number on it. We recommend you check for program updates
soon after you install the program, to ensure that you are running the most up-to-date version of
OTL.
 
You have the right for free upgrades to any new minor version (for  example, from 2.0 to any 2.x
version).
 
Program Upgrades
 
Existing  clients  have discounts  on  new upgrades  of  the  software  (for  example,  from  OTL  3.x  to
OTL  4.x,  OTL  5.x  and  so  on).  Clients  with  support  agreements  get  the  amount  paid  to  date
discounted from upgrades (see below).

Annual Software Support Agreement

Clients  who  have  purchased  a  software  support  agreement  with  their  software  are  entitled  to
discount equalling the amount of software support they have paid up to date, provided it  has not

http://www.mediterraneanacoustics.com
http://www.olivetreelab.com/
https://www.youtube.com/playlist?list=PLbTycE_NwfQeFAZ3N_ubXdxy4TiCN6Drn
https://www.youtube.com/playlist?list=PLbTycE_NwfQeFAZ3N_ubXdxy4TiCN6Drn
https://www.youtube.com/playlist?list=PLbTycE_NwfQeFAZ3N_ubXdxy4TiCN6Drn
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elapsed  or  has  been  interrupted.  Please  contact  us  or  your  local  distributor  for  support
agreements.
  
For more information about recent releases, please visit our Web site at: www.olivetreelab.com

http://www.olivetreelab.com
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3 Theoretical Background
In this section, we will provide an introduction to the theoretical background behind the available
calculations in Olive Tree Lab 3 and an overview of the available calculations and calculation
options.

General Approach in Calculating Sound Propagation

OTL is based on PEMARD’s methodology for calculating sound propagation. PEMARD’s
methodology of calculating sound propagation is focused on preserving the wave based nature of
sound and uses simplifications only in cases when there is no practical alternative. For this reason,
we always aim to use the latest and most accurate calculation models for our calculations, based
on peer reviewed scientific publications. Extended material regarding the accuracy on our
calculations can be found on our website (www.pemard.com) and in our published papers.

The basic principles of sound propagation are the same, regardless of the nature of the project.
Sound propagates in a similar way both in outdoor situations and in indoor situations. This fact
allows us to use common calculation methods to solve any type of acoustical problem. PEMARD’s
methodology is all about solving the following high level equation

Where preceiver is the total sound pressure arriving at the receiver, z is the number of sound

sources, n the number of sound paths arriving from that source at the receiver, py the source’s

sound pressure,  the distance attenuation of a spherical wave and the product of
various coefficients representing the attenuation due to various phenomena that occur on the
sound path, like sound reflection and sound diffraction.

In Olive Tree Lab, the calculation process is divided to two major steps a) the detection of sound
paths and b) the calculation of the detected sound paths. For the detection of sound paths a
combination of techniques is used like an advanced image source algorithm, a diffraction detection
algorithm, a hybrid tracing technique and special functions for reflected diffracted paths.

Path Detection

Image Source Algorithm

Olive Tree Lab uses an optimized Image Source algorithm for the detection of valid sound paths
based on Mechel’s improvements (Room Acoustical Fields, Mechel, 2013) along with some in-
house optimizations that result in a fast and accurate detection of sound reflection paths.

Hybrid Tracing Algorithm

For the purpose of calculating room acoustics parameters we use a hybrid tracing algorithm,
similar to the one proposed by Vorlander (Simulation of the transient and steady-state sound
propagation in rooms using a new combined ray-tracing/image-source algorithm, Vorlander,1989),
along with some in-house optimisations.

Diffraction Detection Algorithm

We use an in-house developed algorithm for the detection of sound diffractions between any edge
combination using the Broyden–Fletcher–Goldfarb–Shanno (BFGS) optimization algorithm.
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Reflected Diffracted Paths / Reflections between Diffractions points

Olive Tree Lab detects, additionally to sound reflections and sound diffractions, paths that include
both diffractions and reflections. These sound paths are important contributions to the sound field,
especially in cases where a small number of wave fronts arrive at the receiver, such as outdoor
sound barrier cases.

Sound Path Calculation

For the calculation of the sound paths and the final frequency response estimation, Olive Tree Lab
uses a number of calculation methods to calculate the different effects on sound.

Sound Attenuation

Olive Tree Lab sources can be point sources which emit spherical sound waves or point sources
with a Directivity Index that can be imported from a .clf file. Even OTL’s line sources are composed
by a number of point sources. Theoretically, all other types of sound sources can be reproduced by
using point sources. Therefore, sound pressure attenuation is based on the spherical wave
attenuation and it is described by the following equation.

Where preceiver is the relative sound pressure of a spherical sound wave at distance   and k is

the wave number.

In cases where the source has a directivity associated with, the axial spectrum (the spectrum of a
directive source in the front direction of the source) of preceiver is multiplied by the Relative

comlex frequency response H(r,θ,φ) in that particular direction [CLF_specs]. Please see ‘Importing
a CLF file’ section

Sound Reflections from Surfaces

There are two ways to calculate the effect of a sound reflection on a sound wave in OTL. These
are:

a) by calculating a material’s impedance and using it for the calculation of the material’s
reflection coefficient

b) by using measured data like absorption coefficients. OTL supports both ways of calculation.

Sound Reflections based on Materials Impedance

Calculating the reflection coefficient based on the material’s parameters is the most realistic
method for calculating the effect of sound reflections. The main reason for this is that angle of
incidence is taken into account. OTL includes calculations of material impedance for both semi-
infinite materials as well as multi-layered structures. Impedance from multilayered structures is
calculated using Vigran’s model. OTL also supports two models of sound impedance calculations
1) Delany-Bazley’s 1-parameter model (Acoustical properties of fibrous absorbent materials,
Delany and Bazley, 1970) 2) Allard’s 6-parameter model.

Sound Reflections based on absorption coefficients

Despite the fact that calculating the sound reflection coefficient from the impedance material is the
most accurate way to calculate the effects of sound reflections, unfortunately material parameters
are not widely available. On the other hand, measured absorption coefficients for different
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materials are much easier to find.

Sound Diffractions from Edges

OTL can calculate sound diffraction coefficients over multiple edges. Calculations are based on
the work of Hadden & Pierce (Sound diffraction around screens and wedges for arbitrary point
source locations,Hadden & Pierce,1981) and the work of Min and Qiu (Multiple acoustic diffraction
around rigid parallel wide barriers, Min & Qiu, 2009).

Fresnel Corrections for Finite Sized Reflectors

Finite size of reflectors can be taken into consideration by Olive Tree Lab 3. The Calculations for
finite size of reflectors is based on Clay et al. (Specular reflections of transient pressures from
finite width plane facets, Clay et al, 1993)

Atmospheric Absorption

When sound is propagated across large distances the sound gets absorbed by the atmosphere
normally leading to a high frequency roll-off of the sound pressure level.

Atmospheric Turbulence

OTL can model the effect of turbulence using the physically based Kolmogorov spectrum (V. E.
Ostashev, “Acoustics in Moving Inhomogenous Media”,1997) (J. Forssén M. Ögren, “Thick barrier
noise-reduction in the presence of atmospheric turbulence: measurements and numerical
modelling”, 2002). The presence of atmospheric turbulence can reduce the effectiveness of noise
barriers and other barriers in attenuating the SPL at a receiver. 

The user can either input the CT
2 and Cw

2 structure parameters, or the γT Kolmogorov structure

parameter which is given by:

Where

CT  and Cw are the turbulence structure parameters

T0 is the atmospheric temperature

c0 is the wind speed

The coherence factor due to turbulence Cb is then calculated using the Kolmogorov structure

parameter:

Where

k is the wave number

R is the source/receiver distance
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γρ is  where hS is the source height and hR is the receiver height

Sound Path Summation

Olive Tree Lab supports two types of sound path summation, coherent summation and incoherent
summation

Coherent Summation

For the coherent summation the following equation is used 

Where         the total squared sound pressure, z the number of sound sources, n the

number of sound paths of each individual source s and      the sound path’s pressure. The
coherent summation is always applied when adding sound paths coming from the same source, in
order to maintain the wave based nature of the wave fronts, and can be optionally applied for
summation between different but coherent sound sources.
Incoherent Summation

For the incoherent summation the following equation is used

Where ptotal the total squared sound pressure, z the number of sound sources, n the number of

sound paths of each individual source s and pi  the sound path’s pressure. The incoherent

summation is optionally applied for summation between different and incoherent sound sources.

Room Acoustics Reflectograms

For the calculation of room acoustics parameters, Olive Tree Lab 3 skips the wave based
calculation of sound paths, and calculates reflectograms by calculating the energy of each path
individually. This is done for performance reasons. This way some wave based effects that occur
in the addition of the sound paths are missed but this does not affect significantly the results of the
Room Acoustics Parameters.

Nevertheless, users can still proceed with a wave based calculation of the valid sound paths in a
Room

Acoustics calculation if they wish to do so. More details regarding this will be given in later
modules.



Part

IV
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4 Getting Started

4.1 Overview

Working with OTL is the same for all three applications (Terrain, Room and Office), with the
exception that each application has added features related to its field.

Double-click the icon on your desktop, or from Start>Programs to run OTL.  

When you launch OTL, the main application window will open at the Start Page tab. Here you can
choose to start a new blank project or select one of the options available.

You may select another option at any time by returning to the Start  Page or from the drop down
menu under File>New. Previously opened projects will be displayed in the left side of the window,
OTL remembers the last projects created and will list them automatically on the left under recent
projects.

For  ease  of  use,  we  have  also  created  a  tutorial  section  on  the  right  hand  side  where  you  can
access short video tutorials on using OTL.

Geometry Viewport

When launching a project (whether new or existing), in any of the applications, the Geometry
Viewport (window) will be enabled displaying your geometry or what we refer to as the
Configuration.

Configurations
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By default a blank configuration is created when a new blank project is launched, with a 100 x 100
Ground. Configurations can be found in the Configuration Explorer tab found on the left hand side
of the Geometry Viewport.

Users can rename configurations, clone them and import other configurations into their project for
comparison without having to open another project. The same applies for calculation Curves.

To  import  a  Configuration,  Select  File>Import>Import  Configuration.  The  imported  Configuration
will appear in the Configuration Explorer tab found on the left hand side. Select the .nbc file located
in your project's folders,, under Configurations.

To clone a configuration, select the configuration you wish to clone from the Configuration Explorer
tab, right click and select clone configuration. Other options also include Delete, Rename and
Export Configuration.

Importing Drawings and Images

3D models in dxf and dwg formats can be easily imported into OTL, Please refer to section "Import
DWG/DXF".
The same goes for 2D images such as Google Earth locations. Please refer to section "Importing
Images".

Side Panels (See also Side Panels for details)

In the Geometry Viewport, there are various panels on the left hand side and the right hand side
which relate to the various parameters in OTL. The tabs can be enabled or disabled from the View
option in the main toolbar found at the top. Please refer to "Side Panels" section.

Status Bar
 
At the bottom of OTL - Terrain Geometry Viewport, you will find the Status Bar. The Status Bar
provides the following information:
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Render Mode (Shaded/Rendered/Wireframe/Hidden Lines)
The Excess Level Meter colour indicator - the colour displayed would be the range in which the
Indicative Calculations fall within. This range can be set by the user in the Options>Excess
Noise Level Meter tab.
The Grid Editing Plane (Note: The grid can be moved up and down using the +/-).
Normal values: The normal to the editing plane, "A normal is a line perpendicular to a surface".
Perspective view (ON/OFF).
Selection type (Pick/Box).
Selection Type (Surface/Object)
Snap to Grid (ON/OFF)
Snap to surface (ON/OFF)
Show Normals (ON/OFF)
Show Dimension (ON/OFF)
Coordinates - system used Cartesian.

 

Editing Plane
 
In order to set the Editing Plane, click x, y or z depending on the plane you wish to view or edit.
Using the +/-, moves the Editing Plane to the corresponding value set in the Options>Geometry
Viewport>Sizes>Grid Move Step. Alternatively, if you wish to set the Editing Plane according to an
existing point or surface use the right click menu, and select Move Editing Plane.
The Editing Plane can be seen on the Status Bar at the bottom of the Geometry Viewport.
 
 

Customising the Way You Work
 

Options Menu

You can set your preferred parameters at any time using the Options tab, found on the left side of
the Geometry Viewport or View>Options.
 
Values include:

Decimal Places Values for Distance and Noise Levels (dB)
Geometry Viewport Colours, Geometry Viewport Sizes (Grid, Snap, Steps,Clone), Geometry
Viewport Controls (designated preferred mouse buttons for Zoom, Pan and Rotate)
Excess Noise Level Meter Values and Limits

 
 

Using the Right Click Menu
 
Certain functions and features are available on the right click menu, depending on which entity the
user right clicks on. Functions vary depending on the entity selected.
 
The Right Click Menu offers the following functions:
 
Basic Functions
 

Copy Screenshot
Save Screenshot
Send Screenshot Report
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Move Editing plane

Additional short cuts for Walls:

Delete Selection
Change Selection Colour
Make Transparent/Opaque
Merge/Separate Walls to One/Multiple Object
Convert Walls to Ground
Convert Walls to Patches
Flip Normals of Selected Surface(s)
Make Selected Surface(s) Double Sided
Send to Origin (selected entity becomes the origin axis i.e. 0,0,0)
Clone Selected Items (set the Clone distance and axis in Options>Geometry Viewport>Sizes
tab)
Group Selected Items in Object Tree

 
Additional short cuts for Barrier
 

Make Barrier Infinite (makes the barrier length infinite)
Convert directly to any Barrier shape and type (Thin/Thick Wedge-shape, Thin/Thick I-shape,
Thin/Thick Γ-shape, Thin/Thick Π-shape)

 
Additional short cuts for Ground
 

Convert Ground to Wall
 
Docking System:
 
1) A window can be one of four types:

a) Docked Document – These windows are displayed in a full-page manner. Examples
include the Start Page or the Geometry Viewport.
b) Docked and Pinned –These windows are docked either at the sides or the top and bottom
of the screen. A window that is docked and pinned is always visible. To unpin a window click
on the push pin located at the top right corner of the window.
c) Docked Auto-hide – These windows are hidden with only their tab being visible unless the
mouse pointer hovers above the tab. To pin them click on the push pin located at the top right
corner of the window.

d) Floating Windows –  These windows that are not docked in a container. Double clicking on
the bar at the top of a floating window will return it to its last state. A window can become
floating if it is type a) or b). Type c) windows need to become type b) before becoming floating
windows. Double clicking on the tab of a type a) or b) window will turn it into a floating window.

2) A window dock has to be type a), b) or d) before it can be changed. Type c) windows cannot be
moved around until they are pinned.
3) If multiple windows are pinned on the same edge dragging them by the title bar (the blue bar on
top) will move them together. Dragging by the tab will only move one of them.
4) While dragging a floating window blue arrows appear in areas where the window can be
docked. If an arrow doesn't appear then the window cannot be docked in that location.
5) Complex docking arrangements can be created by docking windows at the top/bottom/left/right/
over another docked window.
6)  In order to dock a window relative to another window the latter cannot be type c.
 

Saving a Project

When saving a project in OTL, you will be asked whether you wish to create a directory. A directory
is then automatically created and includes the following:
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1. The .otlt Terrain project - actual OTL project
2. Configurations folder - contains the configuration, file extensions are .nbc 
3. Curves folder - Calculation results curves, file extensions are .crv
4. Database folder - the database used in the project including any newly added database. File

extension is .xml
5. Plots folder - 3D Mapping plots, file extensions are .plt
6. Polar Plots - polar plot calculations, file extensions are .pplt
7. Results - contains the calculation results, file extensions are .otlr

In order to be able to open an OTL project, one must have all parts in the same directory, or
zipped together if they are to be transferred.

4.2 Application Tool Bars

The Tool Bars
 
Most of the options available in the menu bar are also available as short cuts in the tool bars.
Some functions are also available using the Right Click option.
 

TOOL FUNCTION DESCRIPTION SHORT CUT
KEY

New Blank
Project
(Start Menu or
File>New)

Opens a blank project with only Ground 100x100 Ctrl + N
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Open Existing 
Project
(Start Menu or
File>New)

Opens an existing OTL Project Ctrl + O

Open Example
Project
(Start Menu or
File>New)

Opens an example project that has been included
for Outdoor Sound Propagation, Room Acoustics
and Open-Plan Office.
See Example Projects.

Open Isei's
Configuration
(Start Menu or
File>New
Configuration)

An experimental set up based on, T. Isei, T. F. W.
Embleton, J. E. Piercy: Noise reduction by barriers
on finite impedance ground. J. Acoust. Soc. Am. 67
(1980) 46-58. See Example Projects.

 

New Empty
Configuration 
File>New
Configuration>N
ew Empty
Configuration

Opens a New blank configuration into your existing
project. To toggle between configurations, go to
Configuration Explorer on left hand side of
Geometry Viewport and select the configuration.

Display Modes:
Rendered,
Shaded, Wire
frame, Hidden
Lines

Allows the user to view the model in Rendered
mode, Shaded mode, Wire frame or Hidden lines.

Calculations Includes the various calculations tools.

Calculations>Sh
ow All Paths

Shows all reflection and diffraction paths between
source and receiver with the effect of the barrier/
surface according to settings in the calculations
options, disregarding the number of strongest
paths.

Calculations>Sh
ow Paths
according to
Calculations

Shows all reflection and diffraction paths between
source and receiver with the effect of the barrier/
surface limited to the number of strongest paths set
in the calculations options

Calculations>Sh
ow all paths
without barrier

Shows all reflection and diffraction paths between
source and receiver according to calculations
options, disregarding the number of strongest
paths but without the effect of the barrier/surface,
even though there is a barrier/surface in the model
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Calculations>Sh
ow paths without
barrier according
to calculation
options

Shows all reflection and diffraction paths between
source and receiver without the effect of the
barrier/surface  according to calculations options
but limited to the number of strongest paths set in
the calculations options

 
Calculations>Act
ivates/
Deactivates
Real time
Indicative
calculations

While activated, Indicative Results are given in
Real Time whenever any parameter is changed or
object is moved.
Note: Activating the Indicative button ON, could
make calculations slower depending on the
complexity of the project. Therefore it is best to
kept in the OFF position until it is needed and
used. 

Calculations>Ru
n Indicative
Calculations

This feature runs calculations in 1/3 octave centre
frequencies only, displaying results in 1/1 octave
bands in the Indicative Graph (located in the
Results Graph tab on the right of the Geometry
Viewport) after being appropriately processed. It
checks whether solutions meet noise criteria. For it
to show properly assign source and receiver
levels.  See Results & Outputs.

Calculations>Ru
n ISO 9613-2
Calculations

Runs calculations based on ISO 9613-2, indicating
the eight standard octave-band midband
frequencies from 63 Hz to 8kHz. See Results &
Outputs.

Calculations>Ru
n Precise
Calculations

Runs precise calculations. Results are displayed in
high frequency resolution in the Output Window as
well as in Precise Graph (shown in the Results
Graph panel on the right of the Geometry

Viewport). Also shown in 1/3rd and 1/1 octave
bands  after being appropriately processed from
high frequency resolution results. Results can be
exported in clipboard, in .txt or .csv formats. See 
Results & Outputs.

Calculations>Ru
n Impulse
Response
calculations

Runs precise calculations and results are displayed
in Time Domain tab in the Output Window. Results
can be seen in dB and Pa. See Results &
Outputs.

Calculations>Ru
n Auralisation

Enables the user to listen to calculated results.
Users can use  built-in default sounds  or import
and save their own .wav files, provided they are in
16 bit resolution.

Calculations>Ma
pping

Mapping allows calculations at a specified range of
frequencies over an area of number of receivers at
a density specified by the user. See Mapping

Pan The Pan command repositions the view in the
geometry area.
Pan does not change the location of objects in the
view port, it simply only changes the view.
this can also be activated using Ctrl+ middle button
on your mouse.

Ctrl + Middle
mouse button

Rotate Mode Rotate to reposition the view. This feature can also
be activated using the middle button on your
mouse. 

Middle mouse
button
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Zoom to Fit
Zooms to Fit the whole configuration.

Ctrl + F

Grid Toggles ON and OFF the Grid. The grid size can
be modified from View>Options>Viewport tab. 
Note: The grid size is independent to the snap
step.

Views Allows to alternate between different views, Front,
Rear, Right, Left, Bottom, Top, Isometric.

F2 Front, Rear
F3 Right, Left
F4 Top, Bottom
F5 Isometric

Toggle
Perspective

Toggles Perspective ON/OFF. 

Toggle Origin
Visibility

Toggles ON and OFF the axis origin visibility.

Select by Box
(Lasso Tool)

Box selection allowing the user to select Visible
Entities, All Entities, or all Enclosed Entities.

Ctrl+Alt+V, Ctrl
+Alt+A, Ctrl+Alt+E

Pick Tool Pick tool allows the user to select Entities.

Select Surface Click to select a single surface of a grouped object,
such as barriers or walls.

Select Object Click to enable selection of objects.

Snap to Grid 
ON/OFF

Enabling the Snap function will help move in
distinct steps allowing the user to select points
when drawing barriers & walls. Snap steps can be
changed from the Options, Geometry Viewport,
Sizes tab. Tip: Hovering over a surface will snap to
a point on the surface.

+/- to move grid
up and down.

Snap to Surface 
ON/OFF

Enabling the Snap to Surface function will ensure
no gaps will be left between barrier and surface
when drawing.

Import DXF,
DWG
or 
File>Import

Imports 3D models from third party CAD
applications. Please note: OTL is not a CAD
application, it offers only basic CAD features to edit

imported 3D models from 3rd party CAD
applications. All imported objects are acoustically

hard (flow resistivity set to 20,000,000 in Pa s/m2.
The user can change flow resistivity by double
clicking on the object and changing the value using
the Obstacle tab on right hand side.
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Import Images
or
File>Import

Imports 2D images. User can save Google Earth
images and import them into projects, then place
noise sources, receivers and barriers according to
image.

Ctrl+Shift+I

Add Noise
Source

Select and click to insert Noise Source. Insert

Add Line Source Select to draw line source. To draw Line Source,
click on point where you would like your line source
to start from, draw a line and click on point where
you would like your line source to end. See 
Inserting Noise Sources.

 

Add Receiver Select and click to insert Receiver.  

Line of
Receivers

Select to insert a Line of Receivers.  

Draw Barrier Select and click to draw barrier. Tip: Enabling the
Snap function will help move in distinct steps.
Enabling the Snap to Surface function will ensure
no gaps will be left between barrier and surface. 
See Creating Barriers.

Draw Ground Select and click to draw ground. By default a
100x100m ground surface is drawn by OTL with
flow resistivity of 20,000,000 in Pa s/m2. See
Drawing a Ground.
 

 

Cad Tools This offers the user basic features to modify their
model or to draw a simple model.

 

CAD
Tools>Draw
Wall

Draw walls to create a basic model. Tip: Enabling
the Snap function will help move in distinct steps.
Enabling the Snap to Surface function will ensure
no gaps will be left between wall and surface.

CAD
Tools>Generate
Average Ground

Replaces any existing grounds with a single

average ground, averaged using the least squares

method

CAD
Tools>Insert
Rectangle

Draw a flat surface for rectangular shapes only. For
non-rectangular shapes, it would be best to use
the Create Surface on Points (see below).

CAD
Tools>Create
Surface on
Existing Points

Allows the user to create a surface using points by
selecting at least 3 points. After the points have
been selected, right click to finalise. 

CAD
Tools>Extrude

Allows Users to Extrude surfaces and lines.



36 Olive Tree Lab - Suite User Manual

Copyright © 2018  P.E. Mediterranean Acoustics Research & Development Ltd. All Rights Reserved.

CAD
Tools>Draw
Line

Allows Users to draw lines.

CAD Tools>Cut
Surface

Allows Users to cut out an area on an existing
surface

CAD Tools>Add
Patch

Allows Users to create overlaying materials on
existing walls

CAD Tools>Split
Surface

Allows Users to split a surface into various
surfaces, such as Grounds, Walls and assign
different properties.

CAD
Tools>Insert
Point

Allows Users to insert point vertices, and change
coordinates using the Point panel on right hand
side of Geometry Viewport.

CAD
Tools>Make all
walls and
surfaces Double
sided

When a 3D model is imported, it enables the user
to make all the wall and ground surfaces double
sided.

CAD
Tools>Show/
Hide Normals

Shows the active side of faces. In order to reverse
the normals, select the surface and right click,
then Flip Normals.

 

Auto Correct
Normals 

Automatically correct the active side of faces.

Show Directions Shows the directions of Source and Receiver

CAD Tool :
Move/Rotate

Move and rotate entities inside the Geometry
Viewport, and Source-Receiver directivity. 

 

CAD Tool: Move
Origin

Move the axis location from the default origin to
any other coordinate.

 

CAD
Tools>Resize
Object

Resizes any single coplanar surfaces for walls,
grounds and images . To Resize, select surface,
click resize and select a point you wish to resize
from. Using the resize function with Shift pressed
for rectangles, confines resizing right angled edges
towards the direction extended to.

 

CAD
Tools>Move
Object

Moves selected entity. Click on the object, select
Move Object and place object where you want to
move it to. A shadow of the object will be displayed
until the user selects the new position.

M

CAD
Tools>Stretch
Object

Allows Users to stretch an object in any direction.

CAD
Tools>Scale
Object

Allows User to scale an object to desired scale
factor.
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CAD
Tools>Evaluate
Distance from
Point to Object

Measures axial distance between selected point 
and object.
See How to Measure Distances. 

CAD
Tools>Evaluate
Distance from
Point to Point

Measures actual distance between two selected
points.
See How to Measure Distances.

CAD
Tools>Toggles
Dimensions On/
Off

Allows the user to toggle ON/OFF the dimensions
visibility between two points.

Camera Mode Allows the user to view the environment from either
the Source or Receiver's position as well as move
the source and receiver in camera mode.

Arrow keys allows
user to move the
camera view
whilst Source/
Receiver is in
same position.
W: Moves Object
Front
S: Moves Object
Back,
A: Moves Object
left
D: Moves Object
right
Page Up: Moves
Object up 
Page Down:
Moves Object
Down

Refresh Forces a redraw of model

Print to Report Prints results and project details in a report
template. Please note this feature currently only
works with Office 2007 and Office 2010.

Ctrl+P

 
 
 
 

4.3 Side Panels (Explorer tabs)

On the left and right hand side of the Geometry Viewport, the user will find the tabs for the different
properties of entities, which can be modified.
 

The Side Panels/Explorer Tabs are located on the right and left hand side of
the Geometry Viewport and include:
 
The Configuration Explorer  : 
A configuration is your model set up.
 
You  may  have  more  than  one  configuration  in  a  single  project.  Configurations  can  be  cloned,
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deleted,  renamed  and  exported  using  the  Configuration  Explorer  found  on  the  left  side  of  the
Geometry Viewport by right clicking on the selected configuration. 
 

The Object Tree : 
The  Object  Tree  outlines  all  the  entities  available  in  your  configuration.  Please  see  Object  Tree
section.
 
 

Calculations Options 

In  the  Calculations  Options  tab,  the  user  can  specify  calculation  parameters  such  as  order  of
reflections,  order  of  diffractions,  path  lengths,  atmospheric  absorption,  turbulence  and  spectrum
analysis, etc The Calculation Options can be found on the left hand side of the Geometry Viewer or
by selecting View>Calculations from the drop down menu.
 
Please refer to Calculations & Calculations Options section.
 
 

Options 

In the Options tab, the user can set their preferred options for the Geometry Viewport such as grid
sizes,  move steps  for  entities  etc.  as  well  as  colour  selections  and  transparency.  The  user  may
reset  settings  to  default  settings  at  any  time  by  selecting  Help>Reset  All  Settings.  The  same
applies  to  the  docking  settings  in  the  Geometry Viewport.  In  the  event  the  user  wishes  to  reset
back to default settings, select Help>Reset Dock Window Positions. Please see Options section.

Transparency

Users can change the amount of transparency of an object if  it  has been made transparent. See
Transparency in Options section. 
 

Paths 

After  running  calculations,  all  paths  are  listed  in  a  table,  with  each  path's  distance  (sound  ray)
between source and receiver,  along with the number  of  reflections  and diffractions  within  a  path
displayed in separate columns as R and D respectively. The Excess Attenuation is also displayed
in the last column as EA in dB.
By clicking on the name of the path in the table, the corresponding path will be highlighted in the
Geometry Viewport for easy viewing, and vice versa. 
 
 

Source 

Upon  inserting  a  noise  source,  or  double  clicking  on  a  source,  the  ‘Source’  tab  automatically
opens. The user can change the source type by selecting one from the ‘Sources’ database or add
their  own custom spectrum source. By default,  the source type is a Flat Spectrum Noise Source
set at Lp 1m free field = 80 dB per 1/3 octave band. When more than one noise source is in use,
the user can choose which receivers are to be taken into account in the calculations by clicking the
"Is  Active"  check  box.  The  user  can  also  choose  from  a  selection  of  3D  representations  of
sources.
See Inserting Noise Sources.
 
Note:  Since  calculation  results  in  the  Output  Window  are  allowed  and  shown  in  any  frequency
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range,  according  to  user's  settings  in  the  Calculations  Options,  by default  the  level  of  the  noise
sources in the model below 25Hz is set at the 25Hz 1/3 octave band, according to the frequency
step set  by the user. Similarly, for frequencies above 10kHz, if spectrum analysis is performed for
frequencies above 10,000 Hz, then by default the noise level is set to the 10kHz 1/3 octave value,
and according to the frequency step set by the user.
 

Barrier  

The user can change the type of barrier, which includes Thin/Thick Wedge-shape, Thin/Thick I-

shape, Thin/Thick Γ-shape, Thin/Thick Π-shape, as well as their dimensions. 

See Creating Barriers.

 

Receiver 

Upon inserting a receiver or double clicking on the receiver, the ‘Receiver’ tab automatically opens.
The  user  can  modify  the  receiver's  position,  and  input  the  background  noise  level  either  using
measured levels (in 1/1 octave band) or the appropriate value for the required Noise Criteria of the
area. When more than one receiver is in use, the user can choose which receivers are to be taken
into account in the calculations by clicking the "Active" check box.

 

Meteo 

The  user  can  set  the  meteorological  conditions  such  as  temperature,  relative  humidity  and
atmospheric  pressure  as  well  as  turbulence  parameters.  Speed  of  sound  and  atmospheric
absorption and refraction is calculated accordingly.
For large distances between the source and the receiver, wind speed and temperature profiles can

be set in order to take into account the refraction of the sound by the atmosphere. See 

Meteorological Conditions (c0).

 
 

Wall 

Walls are objects that have been imported from a third party CAD application or created using the
CAD Tools in OTL. The user can assign a material to the wall from the side panel. By default all
imported or created walls are acoustically hard (flow resistivity set to 20,000,000 in Pa s/m2. The
user  can  change  material  types  or  properties  by  double  clicking  on  the  wall  from  the  Geometry

Viewport and changing the value using the Wall tab on right hand side.  See also Creating Walls
and Materials.
 

Surface 

Users  can  select  surfaces  on  Walls  and  Barriers  to  assign  different  materials.  For  example  if  a
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user wishes to assign a different surface material on one side of a barrier, by enabling the Select

by Surface  option  from  the  top  toolbar  of  the  Geometry Viewport  the  user  can  click  on  the
surface  they wish  to  edit.  This  will  enable  the  Surface  tab  where  the  surface  properties  can  be
edited. 

Ground 

The user can assign a ground material using the database provided or create their own material in

the side panel. They may also set the G Factor settings for the ISO 9613-2 calculations. See

Drawing a Ground. section.

 
 

Results Graph  
 

Indicative Graph

The ‘Indicative’ tab in the ‘Results’ side panel  displays indicative calculations for Levels, Room

Acoustics, Open Plan Office calculations as well as a a Level bar graph for multiple receivers.

These results can be used to quickly check whether noise criteria are being met in a problem set

up. Indicative calculations are always performed in a 1/3 octave band resolution and the results are

presented in 1/1 octave bands. The only objects taken into account by indicative calculations are:

Noise Sources, Receivers, Barriers and Grounds. Every other object in the 3D model is

disregarded. See Indicative Calculations

 
The  user  can  activate/deactivate  real  time  indicative  calculations.  While  activated,  Indicative
Results are given in real time whenever any parameter is changed or any object is moved (source,
receiver, barrier, wall and ground, or material type)
 
Note: Enabling the ‘Real-time update of indicative graph’ button in the ‘Calculation Tools’ window
could make calculations as well as the overall  performance of  the software slower depending on
the complexity of the project. Therefore this feature is best disabled until it is needed and used. 

Precise Graph

Precise  Calculations   are  calculations  in  1/3  octave  centre  frequencies  only,  displaying  the
results  in  1/1  octave  bands  in  the  Precise  Graph  tab  of  the  ‘Results’  side  panel.  The  Precise
calculations  results  are  also  shown  in  the  Output  Window  with  high  frequency  resolution
calculations,  (as  opposed to  just  1/3  octave band centre  frequency analysis),  which  can also  be
seen in 1/3 and 1/1 octave bands after being appropriately processed. 
Results can be exported to the clipboard, in .txt or .csv file formats from the Output Window. See
Precise Calculations. 
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Precise Table
Precise  calculation  results  are  also  displayed  in  a  table.  To  export  the  data  to  another  software
(such as Excel), click on the top corner cell of the table to select all the values, then press Ctrl C to
copy the data. 

Precise Calculations Table

 
 

ISO 9613-2 Graph (for outdoor only) 

These  calculations  are  based  on  the  ISO  Standard  9613-2:1996(E)  "Acoustics  -  Attenuation  of
sound during propagation outdoors - Part 2: General method of calculation".

Results are displayed in the ‘Graph’ and ‘Table’ tabs as with the ‘Precise Graph’ tab. See also

Outdoor Sound Propagation Calculations

Receiver Line 
The Receiver Line allows you to view the LpBefore and LpAfter of  each Receiver.  The User can
select one, some or all Receivers to view their contribution.
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Excess Level Meter

Results are also shown in the form of an LED meter (which can also be enabled to update in real
time) which indicates whether noise criteria are met when changing any of the model parameters,
geometry, materials,  noise emission or noise criteria levels.The user can close this  meter  at  any

time  by  clicking  the   and  reopening  it  by  clicking  the  circle  at  the  bottom  of  the  Geometry

Viewport. 

In order to change values or set limits, you can do so using the Options Menu>Excess Noise Level
Meter tab. 
 

Reset All Settings

Resets all  the User's customised settings to the default  ones selected with the installation.  Such
settings include colours, sizes, default rendering mode, last used polar plots and mappings etc.

4.3.1 Object Tree

The Object Tree outlines all the entities available in your configuration. Once you click on an entity
in the Object Tree the corresponding entity will  be highlighted in the Geometry Viewport for  easy
identification. 

You can choose to view entities by various categories:

Group;  Grouped  entities,  i.e.  if  you  have  grouped  some entities  such  as  walls,  or  sources,  or
receivers, etc.
Entity;  Displays all  the  entities  according  to  their  selections,  i.e.  Sources,  Receivers,  Grounds,
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Walls
Type;  Displays  the  type  of  material  assigned  for  Grounds,  Walls  and  Barriers  and  source
spectrum and receiver criteria for Sources and Receivers
State; Displays whether the entity is Active or Inactive in the calculations
Remedial; Displays whether Walls and Barriers are remedial or non-remedial.
Colour; Displays the entities according to the colours assigned to them.
Transparency; Displays whether an entity is transparent or not.

Selecting the tick  box next to each entity in the ‘Object Tree’ side panel removes the entity from
the ‘Geometry Viewport’. The entity however is still taken into account in the calculations. In order
to disable an entity the ‘Is Active’ checkbox has to be deselected from the entity’s side panel. 

Objects can also be renamed by double clicking on the object. Object groups can be renamed by
right-clicking on the group from the object tree and selecting ‘Rename’.

 
In order to select multiple entities, such as Sources,  Receivers,  Barriers,  Walls  etc..  click  on the
entity group you wish to select and all entities within that group will be selected. Under the group
display option, you can click on the first entity in the Object Tree and drag the mouse over the rest
of the entities in that category to select multiple entities. Alternatively under any display option, you
can use Ctrl and click on multiple entities in both the Object Tree and the Geometry Viewport.

 

Object Tree displayed on left side of Geometry viewer.

 
By clicking on an entity or multiple entities in the Object Tree, OTL will automatically zoom into the
selected entity displayed in the Geometry Viewport. If multiple entities are selected, OTL will zoom
into the selected entities collectively.
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Clicking on entity in Object Tree will zoom into selected entity

Clicking on multiple entities in Object Tree will zoom into selected entities

Changing Multiple Entities

To  change  entities  collectively  such  as  sources,  receivers  and  walls,  go  to  Object  Tree  panel,
multiple select the entities you wish to change using Ctrl and click with your mouse, then change
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their parameters from their side panel found on the right hand side of the Geometry Viewport.

4.3.2 Options

The Options panel allows the user to specify their preferences. It is also a very helpful tool when
modeling as it allows the User to specify certain parameters which would make modeling easier. 

The Options menu is split into three tabs, Viewport which allows changes in the Geometry Viewer
such as:

Grid Size; specifies the Grid size

Snap Step; the step with which you wish to snap onto your Grid, for example if you specify a Grid
Size of 5 m, but you wish to be able to snap an entity on it at intervals of 0.5m, then you would
specify 0.5m in the Snap Step option.
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Entity Move Step; Allows you to set the distance you wish to move an entity. By selecting an
entity and clicking on the arrows or PgUp and PgDn, a display will appear next to the entity
showing the ‘Entity Move Step’ value as the default value. Pressing ‘Enter’ from the keyboard will
move the entity at the distance specified in the steps.  You may also change this distance by
entering the distance manually when you select an entity and click on an arrow or up or down.
You may also move entities using the Move/Rotate tool (See Move Objects in Cad Tools
section).

Grid Move Step; specifies the steps you wish to move your Grid. When pressing + or -, the Grid
will move up or down according to the number of steps specified. You can also specify the steps
manually, after pressing +/-, enter the distance and press enter. This will move your Grid to
specified height and directions. Alternatively, you may also use the Move Editing Plane>Offset
Editing Plane option found when you right click in the Geometry Viewer, this will open a pop up
window where you can specify the distance and press the +/- buttons in the window.
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Picking Radius; is the radius you wish you cursor to snap on. 

Source Sphere Radius; when using the None option for Noise Source 3D representation, a
sphere is displayed. The Source Sphere Radius specifies the radius size of the sphere.
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Clone Distances; specifies the distances you wish to clone (copy) an entity to. To clone an entity,
right click on the specific entity and select Clone Selected Item. You can also use Ctrl C to copy
an entity. A blue line will then appear in the ‘Geometry Viewport’ showing where the entity will be
copied. 

Viewport Points Size; specifies the size you want your points to be visible in the Geometry
Viewer. By increasing the size, the point will be larger. To insert a point use the Insert Point tool 

(See Insert Point Section in Cad Tools).

Under the "Colours" tab, users can select to change the colours for various entities:
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Transparency

Users  can  now  change  the  amount  of  transparency  of  the  objects  made  transparent.  By  right
clicking on an entity in the Geometry Viewer, you can select to make your entity Transparent, then
you can set the transparency percentage in the "Options" Side Panel under the "Colours" tab of the
"Viewport" tab, found on the left hand side of the Geometry Viewer:
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In the next Figures, transparencies of 100% and 50% are used:
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Entities can still be seen and selected using this feature.

The Values tab allows users to specify the number of decimal points they wish to use. This is
reflected in the co-ordinates of entities. 

The Excess Noise Level Meter tab allows users to change values or set limits they wish to have for
the Excess Level Meter found on the right hand side of the Geometry Viewer in the form of an LED
meter See also Excess Level Meter under Side Panels (Explorer Tabs).
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4.3.3 Meteorological Conditions (c0)

Users can specify the meteorological conditions found in the Meteo panel on the right hand side of

the Geometry Viewport:
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Temperature on Ground

The temperature at ground level used to calculate the speed of sound at ground level.

Sound Speed Gradient

In the Meteo Panel the user can set a sound speed gradient which will take into account the effect

of atmospheric refraction on the sound paths. The sound speed gradient is the value a of equation:

c(z) = c(0)(1+az)

The user has two options to define the sound speed gradient.

A) Set

Indicates whether the user will set the sound speed gradient.

B) Calculate

Indicates whether the user will define the necessary parameters to calculate the sound speed

gradient in the ‘Sound Speed Gradient Parameters’. These could be used in cases where

meteorological measurements are available. The required inputs are:

Temperature at Height

Specifies the temperature give at a specified height in Celcius

Temperature Height

Specifies the height where the temperature reading was taken in m.

Wind Speed

Specifies  the wind speed at a specified height in m/s.

Wind Speed Height

Specifies the height where the wind speed reading was taken, in m.

Wind Direction

The wind direction in OTL is defined as the angle of the wind relative to the +y-axis (North) in a
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clockwise direction. The wind is blowing from North to South.

Roughness Constant

Specifies the roughness constant in m.

These parameters define the logarithmic sound speed profile by the following equation:

Where:

z is the vertical height

z0 is the roughness constant

The three coefficients A, B and C are given by:

And C is the speed of sound at ground level while zu is the wind speed height, u(zu) is the wind

speed at height zu, ∆v  is the wind speed direction and  is the temperature gradient.

Using the logarithmic sound speed profile an equivalent linear sound speed profile is defined using

the Harmonoise method as described in Appendix B of ‘Nord2000. Comprehensive Outdoor

Sound Propagation Model. Part 2: Propagation in an Atmosphere with Refraction’ 

The other weather parameter (‘Atmospheric Pressure’ and ‘Relative Humidity’) are constant for the

entire atmosphere and are used for calculating the sound speed.

Effects of sound speed gradient on sound paths
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Depending on the magnitude and sign of the equivalent sound speed profile the effect of refraction

is the following:

Moderate positive sound speed gradient (a=0.001)

Moderate negative sound speed gradient (a=-0.001)

Strong Positive gradient (a = 0.1)
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Strong Negative gradient(a=-0.1)

In the case where there is a strong negative gradient the receiver is in an acoustic shadow zone

therefore no sound rays reach him. However there is still sound energy in the shadow zone due to

diffraction from the ground which is calculated.

Meteorological stability Categories 

In cases where meteorological data is unavailable it is possible to make estimates of the sound

speed gradient parameters using the Pasquill Stability Categories. These 6 categories range from

Class A, which represents a very unstable atmosphere to Class F which represents a very stable
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atmosphere. Using the time of day and by estimating the degree of cloud cover typical values for

the wind speed can be obtained using the table below:

Wind speed

(m/s) at 11m

Daytime incoming solar radiation (mW/

cm2)

One hour

before sunset

or after sunrise

Night-time cloud cover

(octas)

>60 30-60 <30 Overcast 0-3 4-7 8

<1.5 A A-B B C D F or G F D

2.0-2.5 A-B B C C D F E D

3.0-4.5 B B-C C C D E D D

5.0-6.0 C C-D D D D D D D

>6.0 D D D D D D D D

Because wind speeds and temperature gradients are not independent from each other, once the

value of the wind speed has been decided upon an estimation of the temperature gradient can be

decided upon based on the probability of occurrence outlined in the table below:

Zero Wind Strong Wind Very Strong

Wind

Very large negative temperature gradient Frequent Occasional Rare or never

Large negative temperature gradient Frequent Occasional Occasional

Zero temperature gradient Occasional Frequent Frequent

Large positive temperature gradient Frequent Occasional Occasional

Very large positive temperature gradient Frequent Occasional Rare or never
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Typical temperature gradients for different Pasquill classes are given in the table below:

Pasquill class A B C D E F

Temperature Gradient -0.08 -0.035 0 0 0 0.025

4.4 Example Projects

OTL has 3 project examples to start you off. One for Outdoor, one for Room and one for Open-
Plan Office.

To launch the project examples, select the Open Project Example from the Start Menu.

Outdoor Sound Propagation Project - Terrain Example
Project
The example project used for Outdoor Sound Propagation involves a basketball court next to
residential houses.

There is a man shouting in the middle of the court (Noise Source) at a distance of approx. 24.5m
from the Receiver.
Receiver is a residential house, at a height of 3.48 m from the ground. The ground under the noise

source is  a outdoor basketball  flooring with flow resistivity of  10,000,000 in Pa s/m2.  The ground

under the receiver is grass with flow resistivity of 300,000 in Pa s/m2.

 
Barrier is a thin, Π shape with the following properties:
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Room Acoustics Project - Room Example Project
The project is an actual theatre called Latsia Theatre (Latsia Theatre)

Completed in 2005, this theatre seats approximately 500 people and is primarily intended for
theatrical and speech events. Architect Ikaros Ioakim and acoustician Panos Economou.
Measured RT data are given below.

http://www.panacoustics.com/Projects/LatsiaTheatre.aspx
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Open-Plan Office Project - Office Example Project

Consists of an open-plan office from "NT Technical Report, Acoustic design of open-plan offices",
July 2010 by Erling Nilsson, Björn Hellström. A plan drawing from the paper is included in the
Configurations, and can be found in the Configurations Explorer tab under "Fig.22 page 42". Not
enough information is given in the paper about materials, therefore, some assumptions were
made.
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The drawings show the measuring points that were taken. 

The project is Vattenfall – Stockholm. Around twenty people work in the helpdesk office. The office
measures 18 x 11 metres. A schematic plan of the office prior to acoustic design can be found in
Figure 22. The height of the sound-absorbing screens between the desks, prior to acoustic
treatment, was 1.6 metres. The flooring was plastic, and the passage dividing the office into two
parts had a needle-felt carpet. The ceiling was clad with suspended, sound-absorbing ceiling tiles,
with the exception of the ceiling in the passage, which had no sound-absorbing material. The
furnishings in the helpdesk office can be seen in Figure b1. Most of the staff in the office are
divided into units of four people per working group.

In the Output Window, the STI values are given under the Open Plan Office tab:
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4.5 Video Tutorials

We have created a playlist of video tutorials, which will be frequently updated. In order to view the
tutorials, either click on the playlist directly or on the individual tutorials:

    

     

https://www.youtube.com/playlist?list=PLbTycE_NwfQeFAZ3N_ubXdxy4TiCN6Drn
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https://www.youtube.com/watch?v=2-CKpjk3Vhk&list=PLbTycE_NwfQeFAZ3N_ubXdxy4TiCN6Drn&index=1
https://www.youtube.com/watch?v=GdXwrFsrld4&list=PLbTycE_NwfQeFAZ3N_ubXdxy4TiCN6Drn&index=2
https://www.youtube.com/watch?v=eszAuT2Dovk&list=PLbTycE_NwfQeFAZ3N_ubXdxy4TiCN6Drn&index=3
https://www.youtube.com/watch?v=5hX8nCW-VS4&list=PLbTycE_NwfQeFAZ3N_ubXdxy4TiCN6Drn&index=29
https://www.youtube.com/watch?v=3D8tWjOwnwI&list=PLbTycE_NwfQeFAZ3N_ubXdxy4TiCN6Drn&index=25
https://www.youtube.com/watch?v=b0rR5TdSJhk&list=PLbTycE_NwfQeFAZ3N_ubXdxy4TiCN6Drn&index=5
https://www.youtube.com/watch?v=AZZHhDX0tbU&list=PLbTycE_NwfQeFAZ3N_ubXdxy4TiCN6Drn&index=6
https://www.youtube.com/watch?v=bQmAJX5_9hQ&list=PLbTycE_NwfQeFAZ3N_ubXdxy4TiCN6Drn&index=7
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https://www.youtube.com/watch?v=g5ji7ZTrlbg
https://www.youtube.com/watch?v=jGjt95ofeA4&list=PLbTycE_NwfQeFAZ3N_ubXdxy4TiCN6Drn&index=9
https://www.youtube.com/watch?v=ZfZL_4aXO0w&list=PLbTycE_NwfQeFAZ3N_ubXdxy4TiCN6Drn&index=10
https://www.youtube.com/watch?v=pI0Psaijf74&list=PLbTycE_NwfQeFAZ3N_ubXdxy4TiCN6Drn&index=11
https://www.youtube.com/watch?v=NquDXgerCgs&list=PLbTycE_NwfQeFAZ3N_ubXdxy4TiCN6Drn&index=12
https://www.youtube.com/watch?v=ahpwUgVPi74&list=PLbTycE_NwfQeFAZ3N_ubXdxy4TiCN6Drn&index=13
https://www.youtube.com/watch?v=nXXXXhCsRZE&list=PLbTycE_NwfQeFAZ3N_ubXdxy4TiCN6Drn&index=14
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https://www.youtube.com/watch?v=gcB7Iq6B9Ys&list=PLbTycE_NwfQeFAZ3N_ubXdxy4TiCN6Drn&index=15
https://www.youtube.com/watch?v=hq63Igiy7GA&list=PLbTycE_NwfQeFAZ3N_ubXdxy4TiCN6Drn&index=16
https://www.youtube.com/watch?v=IULHTm1onWI&list=PLbTycE_NwfQeFAZ3N_ubXdxy4TiCN6Drn&index=17
https://www.youtube.com/watch?v=GSHhu01r-38&list=PLbTycE_NwfQeFAZ3N_ubXdxy4TiCN6Drn&index=24
https://www.youtube.com/watch?v=x73S_4kw9yI&list=PLbTycE_NwfQeFAZ3N_ubXdxy4TiCN6Drn&index=18
https://www.youtube.com/watch?v=3suUNjKXiQM&list=PLbTycE_NwfQeFAZ3N_ubXdxy4TiCN6Drn&index=19
https://www.youtube.com/watch?v=WJdqMeqNJoA&list=PLbTycE_NwfQeFAZ3N_ubXdxy4TiCN6Drn&index=20
https://www.youtube.com/watch?v=GxquoiZIHmw&list=PLbTycE_NwfQeFAZ3N_ubXdxy4TiCN6Drn&index=21
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4.6 Step-by-Step Tutorial

We have provided a training course with step-by-step tutorials on using OTL Suite. To access and
download the files, please do so from this link:

https://www.mediterraneanacoustics.com/tutorial.html

Although the course is for version 3.0, most of the content apply also to version 4.0, with the
exception of any new features which have been incorporated in version 4.0, such as Atmospheric
Refraction, Source Directivity and HRTF.

https://www.youtube.com/watch?v=Y1iizXKN5sY&list=PLbTycE_NwfQeFAZ3N_ubXdxy4TiCN6Drn&index=22
https://www.youtube.com/watch?v=jFV1DpgO_RA
https://www.youtube.com/watch?v=j1CZh8-rYG4
https://youtu.be/Glk1whiOlVw
https://www.youtube.com/watch?v=-bZTSq-c9zY
https://youtu.be/AIJmxF1Savk
https://www.mediterraneanacoustics.com/tutorial.html
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5 Inserting Noise Sources

Insert Single Noise Source

To insert a Noise Source, click on the Add Noise Source icon . 
 
To position a single Noise Source: 
 

Activating the Snap to Grid function  will help the user move in distinct steps. Snap steps can
be set in the Options>Viewport>Sizes tab located on the left hand side of the Geometry Viewport.
 

Using  the  Snap  to  Surface  function    will  help  the  user  position  the  Noise  Source  near  a
surface. Points will be highlighted in yellow to indicate you are on a surface plane. 
 
Note:  Avoid  leaving  the  Source  directly  onto  the  surface  plane.  It  is  best  to  offset  (move)  the
Source  from  the  surface  in  order  to  avoid  placing  the  Source  on  locations  where  mathematical
singularities may apply.  
 
 
If  more  than  one  source  is  present,  the  user  can  choose  which  sources  to  be  included  in  the
calculations by activating the "Is Active" check box.
 
Source Type can be either selected from the Database or manually added. There are also some
3D  representations  of  noise  sources  which  the  user  can  select.  Please  note  that  3D
representations  of  sources  are  just  for  visual  purposes,  the  user  would  still  have  to  select  the
source  type  from  the  database.The  default  3D  noise  source  representation  is  a  large
dodecahedron speaker.
 
Note: In OTL all noise sources are treated as point sources without any directional characteristics.
 
To insert custom Source, select Database>Project Data>Sources from the top menu.  A separate
Noise Source Detail window will open where you can either manually insert levels, or import your
own spectrum by selecting Import From File. See Database section for more detail.
 

Insert Line Source

To draw Line Source, click on Line Source icon , click on point where you would like your line
source to start from, draw a line and click on the point where you would like your Line Source to
end.  You  will  be  asked  to  enter  a  separation  distance  between  sources  or  angle  between  2
consecutive sources and receiver   (in  case you have already placed a  receiver)  and specify the
line-source heights (beginning and end). You will notice that the mouse cursor is now followed by a
shaded representation of a noise source.
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Line Source Division
 

Note:  Line sources are grouped and are edited collectively. 

Line Sources are grouped
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Cloning Sources

The  user  can  clone  the  noise  Source  using  right  click,  Clone  Source  or  by  clicking  the  Clone
Source Type in the Source tab located on the right side of the Viewport. The cloned source will be
placed at a specified distance and axis according to user's settings in Options>Viewport>Sizes tab,
located on the left hand side of the Viewport. The user can modify the source properties using the
Source tab.

Source Panel

 
To clone a line source, first set your clone settings found in the Options panel on the left hand side
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of  your  geometry panel.  Go to  Viewport>Sizes>Clone distance and set  the  distance  you  wish  to
clone your sources on. Select the line source and right click to Select Clone Selected Items. Your
sources will be cloned according to the distance you have specified.

The use of  Copy (Ctrl C) can also be used to clone entities. Select the Entity, type Ctrl + C, a blue
line will appear indicating where you would like to clone your entity. Click to paste your clone.



77Inserting Noise Sources

Copyright © 2018  P.E. Mediterranean Acoustics Research & Development Ltd. All Rights Reserved.



Part

VI



79Inserting Receivers

Copyright © 2018  P.E. Mediterranean Acoustics Research & Development Ltd. All Rights Reserved.

6 Inserting Receivers

Insert Single Receiver

To insert a Receiver click on the Add Receiver icon  You will notice that the mouse cursor is
now followed by a shaded representation of a Receiver. To position it: 
 

Activating the Snap to Grid function  will help the user move in distinct steps. Snap steps can
be set in the Options>Viewport>Sizes tab located on the left hand side of the Geometry Viewport.
 

Using the Snap to Surface function  will help the user position the Receiver near a surface.
Points will be highlighted in yellow to indicate you are on a surface plane. 
 
Note:  Avoid  leaving  the  Receiver  directly  onto  the  surface  plane.  It  is  best  to  offset  (move)  the
Receiver from the surface in order to avoid placing the Receiver on locations where mathematical
singularities may apply.  
 
The  user  can  clone  the  Receiver  using  right  click,  Clone  Receiver.  The  cloned  receiver  will  be
placed  on  the  specified  distance  and  axis  which  can  be  set  up  and  modified  in  the
Options>Viewport>Sizes tab on the left  hand side of  the Viewport.  The user can then modify the
receivers  by  clicking  on  each  of  them  and  modifying  their  parameters  from  the  Receiver  tab
located on the right side of the Viewport.
 
When more than one receiver is  in use, the user can choose which receiver to participate in the
calculations by clicking the "Is Active" check box.
 
Note:  When there  are  more  than  one  receivers  in  the  model,  calculations  are  performed  for  all
receivers.  In  the  Output  Window,  there  are  results  for  all  receivers  under  different  calculations
headings.  In  the  Precise  and  Indicative  graphs  results,  the  user  can  see  for  each  receiver  the
results by selecting the receiver in the Viewport.
 

Changing Multiple Receiver Criteria
 
To change multiple receivers collectively, go to Object Tree panel, select the receivers you wish to
change using Shift or Ctrl and click with your mouse or the down arrow, go to the Receivers panel
found on the right hand side of the Viewport, and select desired noise criteria.
 

Cloning Multiple Receivers
 
To clone several receivers, first set you clone settings found in the Options panel on the left hand
side of your geometry panel. Go  to Viewport, Sizes, Clone distance and set the distance you wish
to clone your  receivers  on.  Select  the receivers  you wish to clone using Shift  or  Ctrl  and mouse
click, and right click. Select Clone Selected Items. Your receivers will be cloned according to the
distance you have specified.
The use of  Copy (Ctrl C) can also be used to clone entities. Select the Entity, type Ctrl + C, a blue
line will appear indicating where you would like to clone your entity. Click to paste your clone.

Insert Line Receiver
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Inserting a Line of Receivers  works the same way as Line Source, with the exception that
receivers are not grouped as one entity. To select multiple Receivers, you still need to select them
all either from the Object Tree or from the Viewport using Ctrl/Shift and click with your mouse. You
can then change their properties collectively. 

In the Results Graph tab, you can see the Receiver Line, where you can select all or some of your
Receivers to see the LpBefore and LpAfter.

Receiver Line Panel



Part

VII



82 Olive Tree Lab - Suite User Manual

Copyright © 2018  P.E. Mediterranean Acoustics Research & Development Ltd. All Rights Reserved.

7 Creating Barriers
Creating a barrier is a simple three step procedure. Select the Barrier function by clicking the

Barrier button   in either the ‘CAD Tools’ or the left toolbar. You will notice that mouse cursor

is now followed by the barrier icon. The Snap to Grid function , will help move it in distinct
steps. You can set the snap step and grid steps in the "Sizes" tab of the "Viewport" tab in the

Options side panel. If you wish to draw a barrier on a surface, make sure the snap to Grid  is

disabled, and the Snap to Surface is enabled . 
 
Step 1: Set the Editing plane to the x, y or z axis.(Press x,y,z).
Step 2:  Select the first  point of  the barrier:  the coordinates are shown next  to  the mouse cursor
while  hovering over  the ground.  Click  once to start  the barrier  and extend it  to  any direction  you
wish.
Step 3: After selecting the second point, thus the length of the barrier, click again to start forming
the height of the barrier. The Grid will now be in a vertical position to help with the height definition.
Step 4: After selecting the third and final point click it. Now the barrier is finished.
Alternatively: Select the first point of barrier, drag the barrier in the direction you wish,
input the length of the barrier manually and click enter, drag the barrier upwards for height
selection, input the height of the barrier manually and click enter.

 
In order to draw a horizontal barrier or sloped barrier, change the axis by pressing x,y,or z,
and then draw your barrier as suggested above. 
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Double click on the Barrier and view its properties from the "Barrier" side panel on the right hand
side. You can make fine adjustments to its dimensions and form. By default OTL places a thin I
barrier, but you may change your selection at any time from the barrier type selection in the
"Barrier" side panel panel or by right clicking on the barrier. Barrier types include thin/thick wedge
(∆) shape, thin/thick I-shape, thin/thick Γ-shape,  thin/thick Π-shape.
 
 

Thin I-shape Barrier Thick I-shape Barrier
 

  Thin Π-shape Barrier
 

Thick Π-shape Barrier
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Thin Γ-shape Barrier Thick Γ-shape Barrier
 

Thin ∆ shape Barrier Thick ∆ shape Barrier

Barrier types available.
                    

 When creating the barrier starting from left to right, you will notice that when you convert the
barrier  type  from  I  (default)  to  Π  for  example,  the  side  walls  are  created  inwards  towards  the
viewing perspective. In order to change the barrier side to the opposite direction, a - (negative) can
be placed in front of the angle value in the ‘Shape’ tab of the ‘Barrier’ side panel found on the right,
or  by adding 180° to the current value. Alternatively,  the user may also recreate the barrier  from
the beginning with the appropriate direction. Either way, the calculations will not be effected.

 
Create a Barrier on a Surface
 
There are different ways to create a barrier on a surface. We suggest using the method mentioned
below to avoid gaps between the barrier and other surfaces. These gaps will allow the creation of
unwanted propagation paths, thus delivering poor calculation results. (The same applies to walls).

Working with the Snap to surface function: Activate the Snap to surface function by clicking

the Snap to Surface  tool. Click the Barrier  tool and simply hover with the mouse cursor
the surface you want your barrier on. You will know you are on a surface plane by the blue cursor
follow point. The cursor will automatically snap on the surface or edge and the rest is completed in
the three basic steps described in the How to Create a barrier (above). Double click on it to make
fine adjustments to its dimensions and form.

 

How to create a barrier on a surface’s edge
 
To draw on edges only, make sure that both Snap to Grid and Snap to Surface are disabled.
Hover the mouse cursor along the desirable edge and you will notice that the cursor follow point
turns blue, indicating the presence of a vertex. Use those points while creating the barrier
(described in How to create a Barrier above) to make a perfect alignment with the edge without
worrying about unwanted gaps. Double click on it and view its properties from the ‘Barrier’ side
panel on the right hand side.
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The select by Surface tool  allows Users to select a surface within an object and assign a
different material. For example, if you had a thick Barrier and wanted to change the surface on one
side only, you would enable the Select by Surface and select the surface you wish to edit. The
"surface" sidde panel on the right hand side would then be enabled allowing you to select a
different surface material. 

To go back to the Barrier properties, enable the Select by Object  and click on the Barrier to
enable the Barrier panel.

Please note: It is not possible to resize Barriers, only Walls, Grounds and Images can be
resized.
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8 Drawing a Ground
When you first start a project, by default a 100x100m ground surface is drawn by OTL with flow

resistivity of 20,000,000 in Pa s/m2 (20,000,000 Pa s/m2 corresponds to a hard surface, 300,000

Pa s/m2 corresponds to grass, and 10,000-15,000 Pa s/m2 corresponds to mineral wool
depending on thickness). In order to modify the materials of the Ground or the material properties,
double click on it or open the property tab on the right hand side of the Geometry Viewport.

When importing a 3D model in DXF/DWG, it's best to delete your Ground and redraw it later. You
may also convert Walls to Ground by right clicking on the selected Wall, and selecting the Convert
Walls to Ground option.

Drawing the Ground is very similar to creating a barrier. The steps followed are the same with the
only difference being that the ground is drawn in the horizontal plane.
 

Step 1: Click Draw Ground , and select a starting point anywhere on the Viewport.
Step 2: Click on the two points you wish to start from and drag the Ground to the desired length.
Step 3: Click to finalise.
 
 

 Pressing Shift key down whilst drawing, draws along the axis in a straight line.
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You can draw as many Grounds as you wish. Alternatively you can split your Ground into several
surfaces.

Splitting a Ground into several surfaces

Using  the  Split  Surface  tool,  you  can  split  any  surface  into  as  many  surfaces  as  you  wish.  For
example if you wish to split your Ground into three areas and specify different surfaces for each,
this can easily be done without having to redraw several ground.

Select your Ground, then select the "Split Surface" tool  found in the CAD Tools  window.
You don't need to click precisely on an edge, just click anywhere on the Ground where you wish to
begin the split, and then again towards the end. OTL will automatically split the surface for you.

You can then assign different surface materials and colours for each new surface.
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Replacing multiple grounds with an average ground.

Using the Generate Average Ground tool   you can replace multiple grounds with a single

average ground averaged using the least squares method. This is useful in situations where a

terrain model was imported from a .dxf file and then a refraction calculation is needed which

assumes a flat ground (please refer to the Refraction section for details).

The previous multiple grounds will be lost after a single average ground is generated.
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Select the Average Ground Tool, a warning message will pop up that your Ground will be replaced:

Select Yes, and the new averaged Ground will appear:
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9 Import & Export of DXF/DWG
 

Import 3D CAD Models (DXF/DWG)    
 
This  function  enables  OTL  users  to  import  3D  models  from  third  party  CAD  software  such  as
Sketch Up and AutoCAD.
 
To import a 3D CAD Model use one of these methods:
 

File >Import> Import DXF/DWG

From the tool bar button: 
 
 

Before you begin importing your model into OTL, you have to bear in mind that OTL supports
entities  that  are  “3D  Faces”,  therefore,  an  Auto  CAD  model  which  includes  types  such  as
“Surfaces”, “Regions” or “3D Solids” need to be remodelled first.
 
The easiest way to convert entities into “3D Faces” is by doing the following:
 
a.Launch your drawing in AutoCAD or any CAD software and select all Regions, Surfaces and 3D
Solids.
b.In order to convert the selected types into lines, use the “EXPLODE” command after  selection.
Note that each CAD software uses different commands.
c.Run  the  “EXPLODE”  command  once  in  order  to  convert  Regions  into  lines,  and  twice  for
Surfaces and 3D Solids.
d.Use the  lines  created  to  design  “Mesh”  entities.  This  can  be  done  with  one  of  the  commands
EDGESURF’, ‘RULESURF’, ‘REVSURF’ or ‘TABSURF’.
e.Select the objects that are “Mesh” types, and run the command “EXPLODE”. Now your items are
converted to “3D Faces” and you can import the .dwg, or .dxf, file in OTL.
f.You are able to define the number of the 3D Faces produced with the commands “SURFTAB1”
and “SURFTAB2”, before running the commands mentioned in step (c). 
 
Please  bear  in  mind  that  the  number  of  surfaces  affects  the  calculations  time,  in  other
words, the more surfaces there are the longer the calculations become.
 
Once you initiate the import action you will be prompted to select the DXF/DWG file location from
your disk. If there is no unit information stored in the file, you will be asked to specify the units (by
default units are set in meters) additionally you can apply a scale factor at will.
 
Notes on Importing DXF/DWG files
 
 

If  the project consists of “closed” buildings it is recommended not to make the surfaces double
sided as this will increase the calculations time. Instead, after importing the 3D model, check the

surface normals (a cone will be visible on the surface’s active side . Note: you may need to
go into the wire frame viewing mode to see it) and by selecting the wanted surfaces use the “Flip
normals of selected surface/s” by using the right click menu.

At any time you can use the Make all Surfaces Double Sided function located in CAD Tools,
or the “Make Selected Surface/s Double Sided” using the right-click menu when clicking on Wall/
Obstacle/Ground surfaces to make adjustments to the project. 
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If you are using Google Sketch Up as your 3D CAD software to design the model to be imported
in  OTL,  you  should  be  aware  of  the  following:  Sketch  Up  has  the  function  to  group  multiple
surfaces into a single entity or component. For OTL to import the .dxf or .dwg file correctly the
grouped  surfaces/components  needs  to  be  ungrouped  into  single  surfaces  (referred  to  as
Explode  command).  Grouped  surfaces  are  not  recognized  by  OTL  on  import  and  will  not  be
rendered inside the Geometry Viewport.

 
In  order  to  do  this  in  Sketch  Up,  right-click  the  grouped  surfaces/component  and  select  the
Explode command.  Afterwards  the  model  can be exported  to  a  .dxf  or  .dwg  file  and  imported
into OTL.

 
Currently the following 3D CAD Models entities are supported in OTL (please see Tip above):

 
oPoint
oLine
oArc
oAttribute
oCircle
oEllipse
oLWPolyline
oPolyline
o3DPolyline
oSpline
oText

oMText
oAttribute
o3DFace
oPolygonMesh
oBlock Reference
oLinear Dimension
oAligned Dimension
oRotated Dimension
oSolid
oPolyface Mesh

 
 

 You may import a polyline model and create the surfaces in OTL using the Create Surface

on Existing Points .
 
For those already using other 3D Acoustical Modelling software which support the export of  DXF
files, they might be able to import these files directly into OTL. 
 

 
Export Model into AUTOCAD (DXF, DWG):
 
The user can export the model to Autocad (DXF/DWG), from File>Export Model

Hint on reducing number of unwanted surface in DXF models using Sketch Up (especially
terrains) before importing into OTL. 

OTL deliberately has a limit to the number of entities imported, being 10,000 in order to minimise
calculation time. 
There are some cases where models have over 10,000 entities, and fail to import. In order to
reduce the number of surfaces, the first step is to export the model (say from Sketch Up) without
lines, i.e. only faces. 

When exporting the file from Sketch Up for example, to DXF, select the options button and make
sure you only export faces. Make sure that Edges, and other options are unticked.
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Import the DXF into OTL. 

Delete the Ground in OTL before importing the dxf, (it can be redrawn later if needed), or
convert the imported wall representing the ground to Ground using the right click menu, and
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selecting Convert Walls to Ground. If you have a texture in the Sketch Up file, it will be imported as
an extra face therefore it is best to delete the texture prior to exporting from Sketch Up.

The above example in the screenshot was reduced from approxiamately 15,000 surfaces to
5000 surfaces.
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10 Import/Export Configurations & Curves

Import Configuration

To import a configuration from another project, select File>Import>Import Configuration. 

Locate the project and select the .nbc configuration file. 

The new configuration can be seen in the ‘Conf Explorer’ side panel found on the left hand side: 

Export Configuration

To export your configuration, select the configuration you wish to export in the Explorer tab, right
click and select Export Configuration.
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Save the .nbc configuration file. This file can then be imported into another project.

Cloning a Configuration
To clone a configuration, right click on the configuration in the ‘Conf Explorer’ side panel and select
‘Clone Configuration’. The cloned configuration will appear with a different coloured background so

it can be easily distinguished.
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Adding New Configurations

Users can 
Add New Empty Configuration - creates a blank configuration
Add New Standard Configuration - creates Isei's configuration

Selecting the "Add New Empty/Standard Configuration", will create a new configuration visible in
the "Conf.Explorer" side panel. Users can easily toggle between the two configurations.

To rename a configuration, double click on it.

After running calculations, Users can also see the results between the different configurations in
the Output Window and compare them.



101Import/Export Configurations & Curves

Copyright © 2018  P.E. Mediterranean Acoustics Research & Development Ltd. All Rights Reserved.

Users can change the colour of a curve by right clicking on it, and selecting "Edit Curve".

Import/Export Curve
 
Users can import/export result curves from/to the clipboard in either a .txt or .csv (comma
separated values) file format. These curves can then be used in 3rd party software or they can be
imported again at a later stage into OTL using either the ‘Output’ Window or from the
File>Import>Import Curve menu. The curve can then be viewed in the ‘Output’ Window.

One can also import a calculation curve from another project exported beforehand, by selecting
the relevant .txt or .csv file.

From the ‘Output’ Window, Select Import Curve (From file), and select the .csv file you wish to
import. 
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Import Curve from file

The ‘Curve Data’ window will open with the values. Choose name, color and data type of your
curve and click Save.
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The imported Curve will be displayed in the "Output" Window:
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Imported Curve displayed in Output Window

To import  data from the clipboard,  copy the values you wish to import  from an Excel  file  (in  two
columns, frequency vs level) and then select the Import Curve (Clipboard). A pop up window will
appear as above with the values, click Save.
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It is also possible to export a curve to the clipboard from another project, and then import it  from
the clipboard into your configuration in order to compare the two.

To export a curve, you may either right click on the specific Curve you wish to export (Octave,

Third Octave, High Resolution) from the left side panel of the ‘Otuput’ window or choose one of the

‘Export…’ buttons above the graphs directly. You may export a curve to either a .csv file or the
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clipboard.

Export Curves
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11 Importing 2D Images

Import 2D Image 
 
Users can import Google Earth images or any other 2D image in order to assist in the modelling of
the project. 

If importing from Google Earth, in order to ensure that the scale is the same, measure the distance
between Source and Receiver using Google Earth’s ruler tool. Then measure the distance of the
area horizontally and vertically as shown below:

Use the Ruler function to measure distances
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Measure distances, and dimensions are displayed in window

 

Save your image using Save As.

In OTL, import the saved image and a pop up window will allow you to input the exact scale. Enter
the measurements obtained from Google Earth. Now the distance between your Source and
Receiver are the same as those measured in Google Earth.
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Google Earth Image imported into Terrain



111Importing 2D Images

Copyright © 2018  P.E. Mediterranean Acoustics Research & Development Ltd. All Rights Reserved.

When importing a 2D image into OTL, ensure that any grounds are transparent in order to
make the image clearly visible. 

How to insert a ground(s) over an imported 2D image:

Select ‘Top’ view from the ‘Views’ menu  located in the top Toolbar or press F4. Draw your
Ground(s) over the Google image using the ‘Insert Ground’ tool located in the left toolbar or the
‘CAD Tools’ window. To draw the ground more easily ensure that the ‘Snap To Grid’ and ‘Snap
To Surface’ functions are switched off. This will help the ground snap the edges of the 2D
image  

Three Grounds on top of Google Image to separate Road from Built up area

 

You can rename your grounds for easy identification in the ‘Object Tree’ side panel located on the
left hand side of the Geometry Viewport.
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Rename your Gound by double clicking on Object Tree

Assign your Ground properties (this can also be done at a later stage). You can select the
particular Ground(s) from the ‘Object Tree’ side panel.

Assign Materials for Ground

Select your Ground and make it transparent by using selecting the Make Transparent option of
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the right-click menu. You can always make the Ground Opaque again using right click, Make
Opaque.

Right click on Ground and Make Transparent

If you do not wish to make the Ground transparent, another option is to move your Google
image down by 0.02m, this will prevent the Ground and image from overlapping with each other,
and make the Ground clearly visible.

Modelling on top of your Google Image

See CAD Tools for modelling.
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12 Using CAD Tools
Although OTL is not a CAD software, it incorporates some basic yet very useful CAD Tools.

General Information about CAD Tools 

In order to see the normals of a surface, select the "Show/Hide Normals" tool from the "CAD
Tools" window, where the reflected sides will be displayed as opaque and the non-reflective sides
will be displayed as transparent. Double sided surfaces are shown as opaque.

The normals  are also indicated as cones.  For  room  acoustics  and open-plan  office  calculations,

use  the  "Auto  Correct  Normals"   from  the  "CAD  tools"   window  and  ensure  that  the
normals are pointing inside the room prior to calculations.

The  option  for  making  all  surfaces  double  sided  is  very  helpful  for  projects  which  don’t  have
“closed” objects. A “closed” object is for example a cube with 6 surfaces. A single surface is not a
“closed object”, therefore turning it into a double sided type would ensure that sound paths could
reach it from either of its sides.

For  outdoor  calculations,  users  can  calculate  without  using  the  normals.  Should  you  wish  to
calculate  using  the  surface  normals,  ensure  you  select  the  Use  Surface  Normals  in  the
calculations options menu. This also reduces calculation time:
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To open the "CAD Tools" window, select "CAD Tools"  button from the left toolbar.
 

The toolbar can be resized however you like, just drag the edges and it will auto resize accordingly.
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Insert Barrier
Please refer to Creating Barriers section.

Insert Ground
Please refer to Drawing a Ground section.

Insert Wall
Creating a wall is similar to creating barriers. In order to create a wall, select the ‘Insert Wall’ tool

from the ‘CAD Tools’ widow . You will notice that the mouse cursor is now followed by the wall
icon.
 
 
Step  1:  Select  the  first  point  of  the  Wall.  The  coordinates  are  shown  next  to  the  mouse  cursor
while hovering over the ground. Click once to start the wall and extend it to any direction you wish.
If you wish to extend in a straight line along an axis, hold down the Shift key at the same time.
Step 2: Keep on picking points until you have the whole outline of your wall selected.
Step 3:  Right click the mouse to enter the height picking mode
Step 4: Click to select the height and to finalise the wall.

Alternatively: Select the first point of the wall, drag the wall in the direction you wish, input
the length of the wall manually and press the Enter key. Continue the same procedure until
you  have  your  design  completed,  then  finalise  the  wall  outline  by  right  clicking.  Once
finalised, drag the wall upwards or downwards for height selection, input the height of the
wall manually and press Enter key.

NOTE:  By  holding  the  Shift  key  whilst  drawing,  will  draw  the  wall  along  the  axis  in  a
straight line.
 

 Clicking the starting point as the last point will activate the height definition thus no right click
is needed.
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Generate Average Ground.
Please refer to Drawing a Ground section.

Create a Rectangle

The Rectangle function   enables OTL users to create a wall  surface on the x,y,z plane that
has the same properties as a wall. Click the ‘Insert Rectangle’ tool from the ‘CAD Tools’ window.
You  will  notice  that  the  mouse  cursor  is  now  followed  by  the  Rectangle  icon.  Click  on  the  two
points you wish to start  from and drag the rectangle to the desired length.  Alternatively you may
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also enter the length dimensions manually. Click to finalise. In order to change the plane, click x, y
or z depending on the plane you wish to create your rectangle on.

Create Surface on Existing Points
This allows the user to create a surface using points. In order to create a surface, click the ‘Create
Surface on Existing Points’ tool from the ‘CAD Tools’ window. Select at least 3 points, then finalise
the drawing by right clicking, and a surface will be created using the points selected. By holding the
Shift key whilst drawing, you ensure that the surface is drawn in a straight line along the axis. 
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This  is  very useful  when  creating  irregular  shaped  roofs.  Make  sure  that  the  ‘Snap  to  Grid’  and
‘Snap to Surface’ functions are disabled in this case. 

Note: Points have to be coplanar in order for a surface to be created.

This  is  very useful  when creating irregular  shaped roofs.  Make sure that  the  Snap to  Grid  

and Snap to Surface  are disabled in this case. 

Create Cylinder

To create a cylinder shape, use the "Create Cylinder" tool from the "CAD Tolls" window. Select
the point where you would like to begin your cylinder, drag until desired radius and click. The height
definition will then be enabled. Either drag to desired height or enter the height manually.

To draw a Cylinder on top of a Wall, make sure the "Snap to Grid" function is OFF  and

"Snap to Surface" function is ON .
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Create a Cylindner

Insert Office Layouts
Users can insert typical office layouts to create their open plan office. There are currently three
layouts to choose from:

 Dog Bone office layout

 Long office layout

 Cross office layout

To insert one of the layouts, select the layout you wish to use from the "CAD Tools" window, and

click where you would like to insert it. Make sure the "Snap to Grid" function  is enabled if you
wish to insert the layout on the Grid.

The  layout  is  considered  as  one  grouped  object.  To  resize  or  move,  select  the  object  from  the
Object Tree or by just clicking on it. If you wish to select a surface only, say the partition to assign

absorptive material, enable the "Select by Surface" function , and then select the surface you

wish to edit. Make sure you switch back to "Select by Object" function  once you are finished. 
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Extrude

The "Extrude Tool"   allows the extrusion of  lines or surfaces to produce various shapes. To
Extrude,  select  the  shape  or  line  you  wish  to  extrude,  select  the  "Extrude  Tool"  from  the  "CAD
Tools"  window, and drag towards  the  desired  direction.  Users  can also  specify the  height  of  the
extrusion by inputting the length manually as well.

Extrude Tool
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The newly formed object is grouped as a Wall.  In order to assign properties, double click  on the
object  and  the  "Wall"  side  panel  will  open.  Note  that  the  object  is  grouped.  In  order  to  Extrude
another surface, you must ungroup the object and then select the surface you wish to extrude. To
do so, select the object, right click and select ‘Ungroup Walls to Multiple Objects’ from the menu.
Then select a surface and Extrude again.

The Extrude tool also works with lines. After drawing the lines, select the lines you wish to Extrude
from the Object Tree and select Extrude. Drag the lines to desired height or enter them manually.
See also Draw Lines.

Note: Lines must be coplanar in order to be extruded.

Draw Lines

To draw lines, select the ‘Draw Lines’ tool,   from the ‘CAD Tools’ window, click  to select  the
first point, drag the line towards the desired direction, and press escape when you have completed
your  drawing or  right  click.  If  you  wish  to  draw a  straight  line  on  an  axis,  hold  the  Shift  key.  To
select all the lines simultaneously, go to the ‘Object Tree’ side panel, found on the left hand side of
the Geometry Viewport, select Lines, and all the lines will be selected. Other ways to select Lines

simultaneously is  to  use the ‘Select  By Box’  function,  ‘Select  All  Entities’,  and drag the box
around  Lines.  You  have  to  remember  to  deselect  the  Ground  if  your  Ground  is  visible  in  your
model, by using Ctrl and clicking on the Ground.

Cut Surface

The Cut Surface tool  allows users to cut a surface within a surface. This could be on a Wall or
Ground. Barriers cannot be cut.

Steps:
1. Enable the Grid for guidance
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2. Select the surface you wish to cut, right click and select "Move Editing Plane> Move to Planar
Surface" or press G for shortcut.
3. Click on the surface you wish to move the editing plane on, in other words the surface you wish
to cut on.
4. Select the ‘Cut Surface’ tool from the ‘CAD Tools’ window
5. Click  to create the shape you wish to cut.  The last point must join the first  point you originally
started  with  in  order  to  finalise  the  shape,  otherwise  you  will  receive  an  Invalid  Lines  error
message. 
6. Right click to finalise teh shape. Once you right click to finalise, your surface will be cut and you
will be able to see through the surface.

By holding the Shift key whilst drawing the area, you ensure that the surface is drawn in a straight
line along the axis. 
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Add Patch

The  "Add  Patch"  tool   creates  a  surface  on  a  wall.  This  is  especially  useful  when  adding
remedial acoustic panels for example where you would like to add a different surface material.

Steps:
1. Enable the Grid for guidance
2. Select the surface you wish to add a patch to, right click and select "Move Editing Plane> Move
to Planar Surface" or press G for shortcut.
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3. Select the ‘Add Patch’ tool from the ‘CAD Tools’ window 
4. Click to create the shape you wish to add. The last point must join the first point you originally
started  with  in  order  to  finalise  the  shape,  otherwise  you  will  receive  an  Invalid  Lines  error
message. 
5. Right click to finalise the shape. Once you right click to finalise, your patch will be added and you
would be able to select it to change colour and material.

By holding the Shift key whilst drawing the area, you ensure that the surface is drawn in a straight
line along the axis. 

When creating a patch, OTL creates a second surface on top of the wall which acts as remedial by
default. The back of the patch is considered as part of the existing wall the patch is created on and
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will have the same properties as the wall. If you change the properties of the surrounding wall, you
will  also  need  to  change  the  back  panel.  If  you  decide  to  delete  the  patch,  then  you  must  also
delete the back panel. Once deleted, there will be a gap in the wall, and you will need to recreate

the surface using the ‘Create Surface from Existing Points’  or "Rectangle" tool  from the
"CAD Tolls" window. To select the back  panel,  go to the ‘Object  Tree’  side panel  and select  the
relevant wall representing the back panel. In the ‘Object Tree’ side panel, the patch will be named
as "Patch on Wall".

To  assign  material  properties  to  the  patch,  either  select  it  from  the  ‘Object  Tree’  side  panel  or
double  click  on  the  Patch  to  open  the  properties  panel  on  the  right  hand  side  of  the  ‘Geometry
Viewport’.

 

Split Surface

The "Split Surface" tool  allows you to split a surface into several parts. An example would be if
you need to split your Ground and assign different properties. 

Steps:

1. Select the surface you wish to split.
2. Select the ‘Split Surface’ tool from the ‘CAD Tools’ window 
3. Click the first point and drag towards desired direction. It doesn't have to be on an edge
4. Click again to finalise the split
5. You can also split a surface within a surface

You can now change the colour of each surface and assign different materials.
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Insert Point

The ""Inset Point" tool allows users to insert vertices and edit the coordinates of each vertex
directly. You can create a surface or draw lines between each point. 

Steps:
1. Select the "Insert Point" tool from the "CAD Tools" window.
2. If you are inserting the points onto the Ground directly, enable the "Snap to Grid" function. If you

are inserting the points onto a surface, make sure you enable the "Snap to Surface" function, if
you are inserting a point onto an edge (a roof for example), make sure that both "Snap to Grid"
and "Snap to Surface" functions are disabled.

3. Click where you would like to insert your points, the ""Insert Point" tool will remain enabled until
you press the Esc key.

4. In the "Object Tree" side panel, you will then be able to see the inserted points and select them.
This will open the "Point" side panel allowing you to edit the coordinates.

Insert Point Tool

Once you have inserted the points, you can then use the Draw Line Tool or create Surface on
Existing Points to join them.

Note: Points must be coplanar in order to create surfaces from them
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Draw line between Points

Users can then just use the "Extrude" tool to extrude either lines or surface. See Extrude Tool.

Make all Walls and Ground Double sided

In order to see the active surfaces in a model, using the Show/Hide Normals tool , will enable
users to see the surface’s active side by displaying a cone. In order to change the normals on a
surface, select the surface and right click to select Flip Normals of Selected Surface/s.

Reflected sides will be displayed as opaque and the non-reflective sides will be displayed as
transparent. Double sided surfaces are shown as opaque.

If you would like to have normals on both sides of a surface, you can use the Make all Surfaces

Double Sided function located in CAD Tools, or the “Make Selected Surfaces Double Sided”
using the right-click menu when clicking on Wall/Obstacle/Ground surfaces to make adjustments
to the project. 

In projects consisting of “closed” buildings it is recommended not to make the surfaces double
sided as this will increase calculations time. Instead, after importing the 3D model file check the

surfaces normals , (Note: you may need to go into the wire frame viewing mode to see it) and
by selecting the wanted surfaces use the “Flip normals of selected surface/s” by using the right
click menu.

The option for making all surfaces double sided is very helpful for projects which don’t have
“closed” objects. A “closed” object is for example a cube with 6 surfaces. A single surface is not a
“closed object”, therefore turning it into a double sided type would ensure that sound paths could
reach it from either of its sides.
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For  outdoor  calculations,  users  can  calculate  without  using  the  normals.  Should  you  wish  to
calculate  using  the  surface  normals,  ensure  you  select  the  Use  Surface  Normals  in  the
calculations options menu. This also reduces calculation time.

Show/Hide/Correct Normals
Displays the active sides of surfaces in a model, indicated as cones and shown by pressing the

‘Show/Hide Normals’ tool  located in "CAD Tools" window. One sided surfaces enable correct

path calculations only if a sound ray reaches it from its active side (shown by the normal).

Reflected sides will be displayed as opaque and the non-reflective sides will be displayed as

transparent. Double sided surfaces are shown as opaque.

In order to auto correct the active side of a surface, use the "Auto Correct Normals" tool in
the "CAD Tools" window.

Show/Hide Normals displays which side of the surface are active
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"Auto Correct Normals" attempts to corrects the direction of the normals of all surfaces

"Make all Walls Double Sided", makes both sides of all surfaces active

Move an Object
 
There are several ways to move objects:
 

1. Using the "Move/Rotate Selection" tool:  Click  the "CAD Tools"  button    and then the

"Move/Rotate  Selection"  tool   to  open the  "Move/Rotate  Selection"  window and  select  the
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Move tab. Click on the object you wish to move, enter the desired move step in the appropriate
field  in the "Move" tab, and choose the horizontal direction by clicking the cross forming arrow
buttons, or the vertical direction by clicking the Up/Down arrows that are on the right.

2. Using the keyboard:  Select  an object  and move it  in  the x/y axis  (front/back,  left/right)  using
the up/down and left/right arrows. To move it in the Z axis (up/down) use the PgUp/PgDn keys.

The move step can be set in the Viewport>Sizes tab in the Options tab  located on the left
side of the "Geometry Viewport", or manually by typing in the desired move step.

3. Using the "Move Selected Object" tool .  Select the object you wish to move, select the
"Move Selected Object" function and you will see a blue line indicating the position you wish to
move the object to. Click on the new position, and then edit  the coordinates if  you wish, using
the right hand side panels on the right side of the "Geometry Viewport".

4. Select the Object and use Short cut key M. This activates the "Move Selected Object" function
and you will see the blue line indicating the position you wish to move the object to. Click on the
new position.

Rotate an Object/Entity 

Click  the  CAD Tools  button   and  then  the  Move/Rotate  Selection  button    to  open  the
Move/Rotate Selection window and select the Rotate tab.

You can either enter the Rotation axis Coordinates or select an Edge or 2 Points as an axis.  To
rotate  the  source  and Receiver  directivity,  use  the  ‘Rotate  On  Point’  radio  button  and  select  the
source/receiver’s direction axis you wish to rotate on. If an object is selected that is not a source/
receiver  the  origin  axis  will  be  used  instead.  If  you  want  to  rotate  a  source/receiver  towards  a
specifici point select the ‘Rotate Towards a Point’ radio button and click the ‘Pick  a point’  button.
Click the desired point on the viewport with the mouse cursor and the front of the source/receiver
will rotate towards that point.use the ‘Rotate On Point’ radio button and select the source/receiver’s
direction axis you wish to rotate on. If an object is selected that is not a source/receiver the origin
axis will be used instead. If you want to rotate a source/receiver towards a specifici point select the
‘Rotate Towards a Point’ radio button and click the ‘Pick a point’ button. Click the desired point on
the  viewport  with  the  mouse  cursor  and  the  front  of  the  source/receiver  will  rotate  towards  that
point.
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Pick an edge: Click the Pick an edge button and the edges in the project will turn red for you to
select one that will act as the rotation axis.

Pick two points: Click the Pick two points button to select two vertices or midway points. The blue
line between the points indicates the rotation axis.
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Rotate Source-Receiver Directivity

To rotate the source and Receiver directivity, use the ‘Rotate On Point’ radio button and select the
source/receiver’s direction axis you wish to rotate on. If an object is selected that is not a source/
receiver the origin axis will be used instead. If you want to rotate a source/receiver towards a
specifici point select the ‘Rotate Towards a Point’ radio button and click the ‘Pick a point’ button.
Click the desired point on the viewport with the mouse cursor and the front of the source/receiver
will rotate towards that point.use the ‘Rotate On Point’ radio button and select the source/receiver’s
direction axis you wish to rotate on. If an object is selected that is not a source/receiver the origin
axis will be used instead. If you want to rotate a source/receiver towards a specifici point select the
‘Rotate Towards a Point’ radio button and click the ‘Pick a point’ button. Click the desired point on
the viewport with the mouse cursor and the front of the source/receiver will rotate towards that
point.
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Move Origin

To move the Origin, click the "Move Origin" tool  from the "CAD Tools" window   and then click
where you would like to place your new origin.

Resize Objects
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The "Resize Object" tool   allows the resizing of Walls and Ground (Barriers can not be
resized).  Using the "Resize Object" tool while holding the Shift key confines resizing on an axis.

Select the Object you wish to resize, and select the "Resize Object" tool from the "CAD Tools"
window. You will see the object highlighted by points which you can drag towards the desired
direction and size. If you wish to resize on the horizontal plane make sure your axis is set to z, if
you wish to resize vertically, select x or y for the axis.

Resizing an Object horizontally (Z axis)

Resizing an Object vertically (x or y axis)
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Move Selected Objects

Select the object you wish to move, select the "Move Selected Object" tool  from the "CAD
Tools" window, and you will see a blue line indicating the position you wish to move the object to.
Click on the new position, and then edit the coordinates if you wish, using the corresponding side
panel on the right hand side of the Geometry Viewport.
 
See also Move/Rotate Objects

Stretch Object

The "Stretch Object" tool   allows the stretching of Walls and Ground (Barriers can not be
stretched).  Using the "Stretch Object" tool while holding the Shift key confines stretching on an
axis.

Select the Object you wish to stretch, and select the ‘Move Selected Objects’ tool from the ‘CAD
Tools’ window. You will see the object highlighted by points which you can drag towards the
desired direction. If you wish to stretch on the horizontal plane make sure your axis is set to z, if
you wish to stretch vertically, select x or y for the axis.

Stretching an Object horizontally (z axis)
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Stretching an Object vertically (x or y axis)

Scale Object

The "Scale Object" tool  allows users to scale up or down their model. Select the Object you
wish  to  scale   (only  Walls,  Grounds  and  Images  can  be  scaled,  this  tool  is  not  available  for
Barriers), and select the ‘Move Selected Objects’ tool from the ‘CAD Tools’ window. You will see
the object  will  be highlighted by red points  indicating the points  where you can scale your  entity.
Select the point you wish to scale and type in the scale factor in the ‘Scaling’ window that pops up.
Click the ‘Scale’ button and your object will be scaled accordingly. 

To  scale  a  whole  model,  you  need  to  select  all  entities  and  group  them  first,  then  select  the
grouped object and scale using the same procedure as above.
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Scaling an Object

Measure Distance from Point to Point and Point to Object

To measure distances between two points, i.e. Source-Receiver, use the "Measure Distance from

Point to Point" tool .  Make sure your "Snap to Grid" function is OFF .

Select a point to start measuring and click on a second point. A pop up window will open displaying
the distance. You will also be asked whether you wish to keep the dimensions visible. By clicking
‘Yes’ the dimensions will be displayed in your Geometry. You can toggle the dimension visibility
ON/OFF at any time using the ‘Toggle Dimensioning Layer Visibility’ tool in the ‘CAD Tools’

window. .
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Measuring distances Point to Point, e.g Source-Receiver

Keep Dimensions visible in Viewport

To measure a distance between a point and object (such as Walls, Barriers), use the "Measure

Distance from Point to Object" tool  found in the "CAD Tools" window. Make sure that "Snap to

Grid" function is OFF . Select a point to start measuring and then click on an object (e.g.
Barrier). A pop up window will open displaying the distance. You will also be asked whether you
wish to keep the dimensions visible, by clicking yes the dimensions will be displayed in your
Geometry. You can toggle the dimension visibility ON/OFF at any time using the "Toggle
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Dimensioning Layer Visibility" tool  in the "CAD Tools" window.

Measuring Point to Object such as Source-Barrier

Keep Dimensions visible in Viewport

Convert Walls to Ground/Convert Ground to Walls
Walls can be converted into Ground and vice versa by selecting the wall, then using the right click
menu select the ‘Convert  Walls to Ground’  or  ‘Convert  Ground to Walls’.  This  is  useful  in  cases
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when a 3D model has been imported and the user wishes to convert a surface to Ground.

 

Creating a Model using Lines/Polylines

The various CAD software available in the market handles and exports surfaces in DXF/DWG in
various ways. Ideally, OTL  handles DXF/DWG files containing mesh entities.
 
The  best  way  to  overcome  any  problems  of  importing  non  compatible  models  into  OTL  is  by
importing 2D, or better  even, 3D models  comprised of  lines/polylines.  Using the “Create Surface

on Existing Points”  tool, you can fill in the missing surfaces using the imported lines’ vertices
as guidelines for irregular shapes. 

In order to import lines/polylines only, make sure you export Lines only (and not faces) from your
CAD software such as Sketch Up for example:

1.Go to File>Import>DXF/DWG and browse through the dialogue window for the line/polyline dxf
model you wish to import, and select the "Optimised" option for the triangulation method.

Export Lines only in SketchUp
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2. Re-draw the model using CAD tools, make sure you have the "Snap to Grid" function OFF 
.

3. For irregular shapes, click the “Create Surface on Existing Points”  tool. You will notice that
the cursor is now followed by the tool’s icon.
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13 Using the Camera
The purpose of the camera is to allow the user to solve noise problems by viewing the model

either from the Source or Receiver. For a noise barrier to be effective, there should be no sight-line

between the source and receiver. By moving either the source, receiver or barrier, and with the use

of the Excess Level Meter, the user could decide on a preliminary level where to position these

entities.

In order to activate the Camera function, click on the ‘Place Camera on object’ button and then
click on the object you wish to place the camera on.

In order to move the camera view without moving the object, use the arrow keys to move up,
down, right and left or use the camera controls located at the top of the ‘Geometry Viewport’.

 

 
An example of placing a camera on an object:
 

 

Example: Here the camera is placed on the Source. The Receiver can be seen, therefore the
barrier would not be effective. The user can move the Source, Receiver, Barrier until there is no
sight-line.
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14 Calculations & Calculation Options
The Calculation Options panel is located on the left hand side of the Geometry Viewer. 
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The calculation options is split into 3. tabs. Path Detection, Calculations, and Advanced.

Path Detection tab is split into 2 tabs one for Indicative and Precise calculations (used for outdoors
and indoors), and one for Room and open-plan office (OPO) calculations.

The Use Surface Normals option specifies whether you wish to calculate the surface's orientation,
i.e. reflective side (See Using Cad Tools and Room Acoustics Calculations sections). By selecting
the Use Surface Normals option, will accelerate calculation time. 

The Sort Sound Paths by Absolute or Relative Level option, is relevant in cases where more than
one source are included in the model with different spectrums. ‘Absolute’ will sort the strongest
paths according to their source spectrum (i.e. paths will be sorted based on their Sound Pressure
Levels) while ‘Relative’ will only take into account the effect of the environment and ignore the
source spectra (i.e. paths will be sorted based on their Excess Attenuation):
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The Calculations tab.
The options under the Calculations tab is applicable to all calculations, indoors and outdoors.

The Spectrum analysis options are applicable to Open-plan office and Precise calculations:
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Advanced tab.
The advanced tab is applicable to outdoor calculations, Polar Plot and Mapping. (See Outdoor
Sound Propagation Calculations section).

All calculation tools are located in the Calculation menu . Depending on which version of OTL
you have, some calculation features may not be available. For the full suite, the following
calculations are available:
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14.1 Outdoor Sound Propagation Calculations

Olive Tree Lab -Terrain includes both PEMARD's advanced calculation methods as well as ISO
Standard 9613-2:1996(E) "Acoustics - Attenuation of sound during propagation outdoors - Part 2:
General method of calculation".

Users can either run PEMARD's advanced calculation methods or ISO standard 9613-2, or both.

ISO 9613-2 Calculations Settings - based on ISO
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Standard 9613-2:1996(E) 
"Acoustics - Attenuation of sound during propagation outdoors - Part 2: General method of
calculation".
 
It  is strongly recommended for Users to be aware of the limitations imposed by ISO 9613-
2:1996. A good knowledge of the standard would enable the correct interpretation of OTL -
Terrain calculation results.
 
Users can select and set the ISO settings by selecting the source, then selecting ISO Settings
from the Source control panel found on the right hand side of the Geometry Viewport.
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Once selected, users then have the option to input the ISO settings which  account for Amisc, i.e

foliage, industrial sites and housing
 

 
Where :
                    
 

Foliage Afol the attenuation of sound during propagation through foliage (Annex A, A.1 of

ISO 9613-2)

Industrial
sites

Asite, the attenuation during propagation through an industrial site (Annex A, A.2 of

ISO 9613-2)

Housing Ahous, the attenuation during propagation through a built-up region of houses

(Annex A, A.3 of ISO 9613-2)

B is the density of the buildings along that path,given by the total plan area of the
houses divided by the total ground area (including that covered by the houses)
(Annex A, A.3.3 of ISO 9613-2)

db is the length of the sound path, in metres,through the built up region of houses
(Annex A, A.3.3 of ISO 9613-2)

P(%) the percentage of the length of the facades relative to the total length of the road or

 
Note: Noise sources are considered to be omnidirectional point sound sources radiating into free
space, Dc = 0 dB. (Part 6 of ISO 9613-2).

 
Ground Attenuation
 
Users have to determine the ground attenuation regions for modelling purposes.
 
Ground Attenuation, Agr is mainly the result of sound reflected by the ground surface interfering

with the sound propagating directly from source to receiver. (ISO 9613-2, Part 7.3)
 
Three distinct regions for ground attenuation are specified in ISO 9613-2 (Part7.3.1 of ISO 9613-2)
as:
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a) the source
region:

stretching over a distance from the source towards the receiver of 30hs, with a
maximum distance of dp (hs is the source height, and dp the distance from
source to receiver, as projected on the ground plane)

b) the receiver
region:

stretching over a distance from the receiver back towards the source of 30hr,
with a maximum distance of dp (hr is the receiver height)

c) a middle
region:

stretching over the distance between the source and receiver regions. If dp<
(30hs + 30hr), the source and receiver regions will overlap, and there is no
middle region

 
The acoustical properties of each ground region are taken into account through a ground factor G.
Three categories of reflecting surfaces are specified as follows:
 
  

a) Hard
ground

which includes paving, water, ice, concrete and all other ground surfaces having
a low porosity. Tamped ground, for example, as often occurs around industrial
sites, can be considered hard. For hard ground G = 0.
NOTE 10 (from ISO 9613-2) It should be recalled that inversion conditions over
water are not covered by this part of ISO 9613.

b) Porous
ground

which includes ground covered by grass, trees or other vegetation, and all other
ground surfaces suitable for the growth of vegetation, such as farming land. For
porous ground G= 1.

c) Mixed
ground

 if the surface consists of both hard and porous ground, then G takes on values
ranging from 0 to 1, the value being the fraction of the region that is porous.

 
OTL-Terrain determines ground (attenuation) regions based on G factors (mentioned below), set
by the user for each ground surface. Depending on the type of ground (soft, hard or mixed) Source
or Receiver find themselves on, OTL-Terrain calculates ground attenuation accordingly.
 
G Factor can be found in the Ground Property Panel on the right hand side of Geometry Viewport,
or by double clicking on the Ground, in order to open the Ground property panel:
 
 

 

  In order to set ISO G Factor, Users can either:
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1. Draw patches of Porous (G=0), or Hard (G=1) ground, and place Sources and Receivers above

the ground according to their location. OTL-Terrain will determine above which ground types,
Sources and or Receivers are located.

2. Draw one ground surface and then enter the mixed Ground Factor G (manually calculated
based on guidance of ISO 9613-2) in the appropriate field .

 

 Drawing Ground :

If Ground patch is rectangular, then select the Draw Ground,  and draw ground as you
would as described in Drawing a Ground section.

 

If Ground shapes are irregular, then select the Draw Wall,  from the Cad Tools, , and
follow the steps outlined in the How to Create Walls. Once completed, remember to convert
walls to ground by clicking on the wall, and selecting Convert to Ground. This is also useful in
cases when a 3D model has been imported and the user wishes to convert a surface to Ground.

 
 
Meteorological Corrections (C0)  

Users can specify the meteorological conditions, found in the Meteo panel on the right hand side of
the Geometry Viewport.
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Where:
 
C0 is a factor, in decibels, which depends on local meteorological statistics for wind speed and

direction, and temperature gradients, (Part 8 of ISO 9613-2).
Experience indicates that values of C0 in practice are limited to the range from zero to

approximately +5 dB, and values in excess of 2 dB are exceptional. Thus only very elementary
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statistics of the local meteorology are needed for a 1dB accuracy in C0 (Part 8, Note 22 of ISO

9613-2).

 
Screening (Abar)  

All calculations are according to ISO 9613-2 Part 7.4. C2 = 20 (in equation 14)

 

Reflections

Reflections up to 1st order.
ρ, sound reflection coefficient (energy based) of equation 20 (part 7.5). OTL-Terrain calculates ρ
according to flow resistivity values of the surface of obstacles.

PEMARD's Advanced Calculations - Precise

Calculations 

PEMARD's calculations are based on the following methods and limitations:

Hadden & Pierce Diffraction 3D model implemented with finite impedance faces using Salomons
semi-analytical  method  including  ground  effects.  Multiple  barrier  diffraction  is  calculated  in  a
recursive way at any diffraction order.
Ground effect using the One Parameter Theory of Chessell based on Delany and Bazley.
Reflections  from  finite  surfaces  based  on  Clay–Medwin’s  work  to  include  Fresnel  zones
contribution at any order level.
Atmospheric absorption based on ISO 9613 -1.
Turbulence coherence factor based on HARMONOISE WP3
Atmospheric  Refraction  based  on  the  heuristic  model  for  Outdoor  Sound  Propagation  vy  A.
L’Espérance et al. and the HARMONOISE equivalent linear sound speed profilesound prop.

Note: Calculation options only apply to PEMARD's Calculation methods, ISO calculations are fixed
according to ISO 9613-2.

 

Calculation Results - Display
 
Spatial sound level distribution – Noise mapping 
All  versions of  OTL,  can display results  in  terms of  spatial  sound level  distribution,  over  an  area
selected by the user. Levels are displayed in 1/3 octave frequency band. See Mapping.
 
Frequency Analysis
Spectrum  results  can  be  displayed  within  any  frequency  range  with  a  constant  bandwidth  or
constant percentage bandwidth frequency analysis or both. At any switch-over frequency value one
may apply a different frequency analysis method. Results are at the same time displayed in 1/3 (25
– 10000Hz) and 1/1 (31 – 8000 Hz) octave bands after being processed from the high resolution
frequency analysis. See Results & Output.
 
Excess Level Meter
The  Excess  Level  Meter  indicates  whether  a  source,  receiver,  barrier  and  ground  configuration
within a 3D model, meets set noise criteria. See Explorer Tabs.
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Calculations Options

The  user  can  specify  calculation  parameters  such  as  number  of  reflections,  diffractions,  path
lengths, atmospheric absorption, turbulence and spectrum analysis.
 
Please  note  that  calculations  options  are  independent  for  each  configuration  and  are  saved
individually when saving a project.

Depending  on  the  version  of  OTL  you  have,  certain  options  may  not  be  available  or  may  be
available but can not be modified. 

The Calculations Options panel is spilt into three tabs. 

Path Detection Tab:
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Reflection Order
The maximum order of reflections allowed for a sound path. 

Use Surface Normals
Indicates whether reflection orders will only occur on the side of a wall with a surface normal

Number of Top Strongest Paths Per Receiver
The maximum number of sound paths that will be used for calculations.

Note:  In  the  event  that  the  number  of  Noise  Sources  is  higher  than  the  Number  of  Top
Strongest Paths, the paths shown will be restricted to the number set in the top strongest
paths. Therefore, there will be sources having no paths to the Receiver.

Sort Strongest Sound Paths by Absolute or Relative levels
When the User selects Absolute Level' , the source defined by the User will be taken into account
when sorting the strongest paths.
When  the  User  selects  'Relative  Level',  the  source  defined  by  the  User  will  not  be  taken  into
account  when sorting the strongest paths.
 
Maximum Diffraction Order Allowed Per Path

3D Model

Represents the maximum number of diffraction points allowed for a sound path i.e. if a sound
path  has  one  barrier  diffraction  and  one  wall  diffraction  but  the  Maximum  Total  Model
Diffractions per Path is set to 1 then this path will be rejected from the calculation. 

Barriers

Represents the maximum number of barrier diffraction oints allowed for a sound path.

Walls

Represents the maximum number of wall diffraction points allowed for a sound path.

Note:  Calculation times become longer with higher diffraction orders.
 
Maximum Path Length
Represents  the  maximum  length  a  sound  path  can  have.  Paths  having  larger  distances  than
Maximum Path Length will  be rejected from the calculation. The propagation time for  the path is
also shown. 
 
Note: This option allows shorter calculation times by minimising the calculation area of the
3D Model.  The  default  is  set  at  100m.  Should  your  model  be  bigger  than  this  value,  then
allow  for  longer  path  lengths,  alternatively  there  might  be  no  results  after  running
calculations.

A) Reflections Between Diffraction Points (Referred to in below captions as check box A)
Indicates whether reflections will  be added between diffraction points during the path calculation,
as diffraction points are considered to be secondary sources. As this option is an additional feature
not usually taken into account by standard calculation procedures, the setting of this option might
affect the final outcome of the calculation and should be used with caution. 

Please note that unlimited orders of reflections between diffractions is only available in the
full OTL-Suite, OTL-Terrain is limited to only 1 reflection between diffractions.
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B)  Reflected  -  Diffracted  /  Diffracted  -  Reflected  Paths  (Referred  to  in  below  captions  as
check box B)
Indicates whether Reflected - Diffracted and Diffracted-Reflected paths are calculated. Reflected -
Diffracted paths are paths which first reflect on a surface and then diffract on an edge. Diffracted -
Reflected paths are paths which first diffract on an edge and then reflect on a surface.
 
C) Reflected - Diffracted / Diffracted - Reflected Paths Source Receiver only (Referred to in
below captions as check box C)
Indicates  whether  Reflected  -  Diffracted  and  Diffracted-Reflected  paths  will  be  calculated  only
between a source and a receiver or between diffraction points as well. 
 
Note: There can be many outcome combinations based on the above path options. The following
screenshots could give a rough idea of what each of the options could produce when checked ON.
The following screenshots were produced using a project called "A Two I-Barriers Model" available
for download here.
 

Check Boxes A,B,C OFF, No Ground reflections
 

http://www.mediterraneanacoustics.com/Login?returnurl=%2fProducts%2fDownloads%2fProjects-Page
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Check Boxes A ON, B & C OFF, Ground reflections between Diffraction points
 

Check Boxes A OFF, B ON & C OFF, Reflected - Diffracted / Diffracted - Reflected Paths
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Check  Boxes  A  OFF,  B  &  C  ON,  Reflected  -  Diffracted  /  Diffracted  -  Reflected  Paths  Source
Receiver only
 

All check boxes A,B & C ON.

Tips on calculation time duration 
 
OTL-Terrain offers many options as to which sound ray paths would contribute to calculations. The
choice of which paths eventually contribute to the calculations results is always defined by the top
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strongest paths (in the Calculation Options Tab, see below), therefore the higher this number is the
more refined the results are. This happens at the expense of the duration of calculation times.
 
It is widely considered that for a thin infinite barrier on a ground, the standard number of paths are
4 (over  its  top)  while  for  a  finite  barrier  on  ground  (symmetrical  to  the  source  receiver  axis)  the
standard number paths are 8, (4 over its top and 2 on each side). It is true that these usually offer
the highest sound contribution in the results,  however, this might not always be true,  since there

can be infinite number of paths. For example, even though the contribution of 2nd and 3rd order
diffraction paths is less, these paths exist and contribute to the total outcome of calculations and
measurements.  Furthermore,  for  a  finite  barrier  with  non  symmetrical  source-receiver
configuration, it is possible to have uneven contributions from the barriers’ sides.
 
Thus  if  the  user  allows  for  higher  order  diffractions  and  reflections,  and  still  asks  for  the  top  8
strongest paths, then depending on the model the results could differ from the standard perception
of which paths should be calculated. OTL-Terrain allows users to investigate various possibilities,
therefore  one  needs  to  have  a  good  understanding  of  the  mechanisms  involved  in  sound
propagation to be able to interpret results correctly.

Calculations Tab
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Source Contribution
Indicates whether sources will be calculated coherently or incoherently.
 
Calculate with Spherical or Plane Wave Reflection Coefficient

When the Finite Impedance radio button is selected, the Wave Reflection Coefficient is calculated
based on surfaces' IMPEDANCE.

If the Spherical Wave radio button is selected, the wave is modeled as a spherical wave.

If the Plane Wave radio button is selected, the wave is modeled as a plane wave.

Use Finite size reflector Fresnel Correction
It applies the Fresnel zone correction for reflections from finite in size surfaces. Available in the full
OTL-Suite only.
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Calculate with Atmospheric Absorption
Indicates whether atmospheric absorption will be calculated.
 
Calculate with Atmospheric Turbulence
Indicates whether atmospheric turbulence will be calculated.
 
Spectrum Analysis, Hz
In  this  area  you  can  configure  the  frequency  sampling  used  for  the  high  resolution  frequency
calculations. You can specify a start point, the switch frequency point where the sampling rate will
change,  and  a  stop  frequency  where  the  calculation  will  end.  You  can  also  specify  constant
frequency step or constant percentage frequency step or both. 

There  are  also  preset  buttons  available  to  set  the  spectrum  analysis  to  either  ‘IR  Analysis’  (for
impulse  response  calculations),  ’44.1k  Analysis’  (for  auralisation  calculations)  or  the  ‘Default’
setting for precise calculations.

Advanced Tab 

 
Use Non Parallel Diffractions on Barriers 
Indicates whether diffractions between non parallel edges will be detected. If this option is disabled
then only diffractions between parallel edges will be calculated.

 A typical example when this check box should be ON, is  when dealing with a finite wedge
barrier  which  has  sides  that  form  non  parallel  shapes  (trapezoid  or  triangle,  please  see  below
screenshot with highlighted sound path.)
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Use Non Parallel Diffractions on Walls 
Again, indicates whether diffractions between non parallel edges will be detected. If  this option is
disabled then only diffractions between parallel edges will be calculated. 
 

A  typical  example  when  this  check  box  should  be  ON,  is  when  dealing  with  non-parallel
edges such as triangular roof. Please note that calculation time may take longer in such cases.
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Use parallel diffractions in ISO reflection images
Users can disable diffraction in ISO calculation in order to speed up the calculation time.  
 

 Tips on calculation time duration for:
 
Sound ray paths
In the path finding analysis, calculation times become longer when:
 

High orders of reflections and diffractions are allowed.
The number of Top Strongest Paths is increased.
“Reflected-Diffracted / Diffracted – Reflected paths” check box is ON
“Reflected-Diffracted / Diffracted – Reflected paths Source-Receiver only” check box is ON
“Use non-parallel diffractions” check box is ON.

 
Spectrum Analysis
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In the sound frequency analysis, calculation times become longer with:

An extended frequency range.
High frequency resolution.

Other check boxes
Calculation times become infinitesimally  longer with:

Finite Impedance (Spherical Wave Reflection Coefficient) ON.
Use finite size reflector Fresnel correction ON.
Calculate with atmospheric absorption ON.
Calculate with atmospheric turbulence ON.

14.1.1 Refraction

A new feature of OTL V4.0 is the inclusion of the heuristic model by L’Espérance (A. L’Espérance,
“Heuristic Model for Outdoor Sound Propagation Based on an Extension of the Geometrical Ray
Theory in the Case of a Linear Sound Speed Profile”, 1992) that allows for the modelling of sound
propagation through a non-homogenous atmosphere. The model is valid for stable atmospheric
conditions which can be approximated with either a linear vertical variation of temperature and/or a
logarithmic vertical variation of wind speed.

The speed of sound depends on both the temperature of the air and the wind speed and in cases
of a non-homogenous atmosphere this will create a sound speed gradient. The consequence of a
sound speed gradient is the effect of atmospheric refraction and the straight rays that are normally
predicted in a homogenous atmosphere are replaced with curved rays.

While for small source-receiver separations the effect is mostly insignificant it can become
important in source-receiver separations greater than 200m because the curved paths bounce on
the ground several times leading to multiple rays reaching the receiver. Furthermore the grazing
angle is increased significantly making the angle dependent reflection coefficient less effective.

The screenshot below shows some of the differences the atmosphere has with on the total SPL:
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More information can be found in Meteorological Conditions

Quick Tutorial

Start a new project and insert a source and a receiver. Keep the horizontal distance at least 200m
preferably more. In the ‘Meteo’ side panel select the ‘Set’ radio button in the ‘Sound Speed
Gradient’ section and keep the ‘Sound Speed Gradient’ to 0. This corresponds to a homogenous
atmosphere. Run a ‘Precise’ Calculation. The sound propagation rays will be straight.

Now increase the ‘Sound Speed Gradient’ to 0.00005 (a moderate sound speed gradient) and then
0.05 (a strong sound speed gradient). Run ‘Precise’ calculation for each case. In the moderate
sound speed gradient case the ray becomes a little bit curved depending the on the Source/
Receiver height and their horizontal distance. In the strong sound speed gradient case multiple
curved rays emerge which are repeatedly reflected from the ground.

Now set the sound speed profile to -0.00005 and -0.05 and run ‘Precise’ calculations for each
case. In the case of a moderate negative gradient the sound rays are curved but in the opposite
direction. In the case of a strong negative gradient no paths appear but the ‘Output’ window still
calculates a Level and EA response. This is because in some cases where a strong negative
sound speed profile exists in the atmosphere and where the Source/Receiver horizontal distance
is large the receiver is in the so called ‘shadow zone’ where the curved rays cannot reach the
receiver. Nevertheless there is a path that gets diffracted from the ground and reaches the
receiver (the diffracted path is not shown in the viewport).
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No Gradient

Moderate Positive
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Strong Positive

Moderate Negative
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Strong Negative

Shadow Zone calculations with a general terrain

In OTL you can do refraction calculations with a general terrain. However the residual model
implemented for shadow zone calculations assumes a flat terrain. Therefore in the presence of
multiple grounds, and when receivers are in a shadow zone OTL-Suite will use the x-y plane in the
viewport as the ground in the calculations. In cases where the terrain is far below or above the x-y
plane this will lead to unrealistically high levels in the high frequencies. This is the recommended
procedure for situations like these:

Either:

Replace the entire terrain with an average ground using the CAD Tools>Generate Average
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Ground tool. Please refer to ‘Drawing a Ground’ section on how to do this.

Or

Select the entire model by pressing ‘Ctrl+A’ keys on the keyboard. Make sure all the objects
are selected including sources, receivers and any objects that might be inactive or not
shown in the viewport.

Press the ‘PgUp’ or the ‘PgDn’ keys on the keyboard. Enter the value that you want shift the

model by along the z-axis and press ‘Enter’. This will shift the selected objects up or down

respectively. Shift the model to a point where the rough terrain is on average coplanar with

the x-y plane.

Run a calculation with the receiver in the shadow zone to see whether the results are

realistic (there should be extremely low levels for the high frequencies not extremely high

levels for the high frequencies). 

Since this may take a few trials it is recommended that you set a low frequency resolution

(such as 1/1 Octave resolution) in the ‘Spectrum Analysis’ section of the ‘Calculations

Options’ side panel as this will speed up the calculation times significantly.
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14.2 Room Acoustics Calculations

The room acoustics module of OTL utilizes three approaches to solving room acoustical problems.
The first being Indicative room acoustics calculations, the second is Precise room acoustics
calculations and the third is Impulse Response and Auralisation. 

Indicative Calculation is based on a typical ray tracing algorithm.  It does not include a) image
sources b) sound diffraction b) angle dependent reflection coefficient. It is designed to provide
rough estimates of the results during the design phase before proceeding into a more time
consuming precise calculation.

Precise Calculations run PEMARD’s algorithm based on a hybrid tracing approach and applies to
both room acoustics and open-plan office calculations. See Open-Plan office. Room acoustical
parameters are calculated according to ISO 3382, Parts 1, 2 & 3. 

In brief our algorithm goes as follows a) a ray is emitted from the source and propagated through
space b) as soon as the ray hits a surface, the surface's image source is generated and recorded
c) The ray is reflected from the surface. The image’s sound pressure is calculated and used for the
calculation of the respective room parameters. This implies that if surface impedance is used then
the spherical wave reflection and diffraction coefficients will be utilized in the calculation. If surface
absorption coefficients are used, plane wave propagation is assumed.

Steps b, c are repeated recursively until the ray reaches a termination criterion composed of the
maximum order and the maximum length. The algorithm automatically increases the termination
criteria until a maximum number of images is reached (user defined) or an algorithm saturation
criterion is met. The user can choose between the automatic and used defined termination. On top
of the above 1st order sound diffractions are added to the result.

The PEMARD hybrid ray tracing algorithm is much faster than the pure image source approach in
producing results in room acoustics. The image source is more accurate since it will find all the
valid paths in a room up to a certain reflection order, however the calculations can quickly become
unmanageable, depending on the number of room surfaces and orders of reflections within the
room. The penalty of ray tracing methods in general, is that they might miss out some valid source
images. Therefore it is recommended that the image source method should be used if possible for
rooms with few surfaces.

Recommended Calculations Settings

The user can choose between an automatic termination of the ray tracing process or a manual

setting of the maximum images to be traced. If the automatic termination is chosen, the algorithm

will try to detect when the correct result has been reached. If the automatic termination is disabled,

the algorithm will terminate at the set Maximum Images to Trace, with the principle being the more

images traced, the closest the calculation should be to the actual result.



178 Olive Tree Lab - Suite User Manual

Copyright © 2018  P.E. Mediterranean Acoustics Research & Development Ltd. All Rights Reserved.

Spectrum Analysis

Under ‘Calculations’ tab of the ‘Calc Options’ side panel, users can choose to set the Spectrum
Analysis for Impulse Response if they wish to include it in their calculations. In other words, if the
‘IR Analysis’ preset is selected, it will be calculated when running a calculation at the same time: 
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Real time Ray Tracing Progress Window

Users can see the result of the ongoing calculation and all the other details of the calculation.

Users also have the ability to stop the calculation and get the result of the Ray tracing Progress up
until the point they have stopped.
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Recommended ISO 3382 Parameter Value Range*
Parameter Recommended range

G 10dB > G > 1 dB

Centre Time The higher the better, 70 - 150ms for
music and 60 - 80ms for speech

C50 C50 > 0 dB

C80 +4 dB> C80 > -3 dB

D50 D50 > 0.5

*For the range of appropriate values of ISO 3382 parameters, it is recommended that users refer

to research papers investigating these objective parameters values and the subjective impressions
they yield.
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You may refer for example to the special issue of Acoustical Science and Technology, issued by
the Acoustical Society of Japan, Vol. 26(2005) No. 2, “Special issue on Room Acoustics in honour
of RADS 2004” https://www.jstage.jst.go.jp/browse/ast/26/2/_contents . 

Here are a few of the recommended papers available:
 

John S. Bradley – “Using ISO 3382 measures, and their extensions, to evaluate acoustical
conditions in concert halls”, Acoust. Sci. & Tech. 26, 2 (2005)
Mike Barron - “Using the standard on objective measures for concert auditoria, ISO 3382, to
give reliable results”, Acoust. Sci. & Tech. 26, 2 (2005)
 Takayuki Hidaka – “Supplemental data of dependence of objective room acoustical
parameters on source and receiver positions at field measurement”, Acoust. Sci. & Tech. 26, 2
(2005)

Room Surface & Volume
You can see the room's total area and volume, along with  the Mean Free Path by selecting the
surfaces of the room which you would like to calculate. Clicking the ‘Update Graphs’ button in the
‘Room’ Side Panel found on the left hand side of the ‘Geometry Viewport’ will calculate the
Schroeder Frequency and produce graphs of the Sabine and Eyring RT, the Average Abs.
Coefficient of all the selected surfaces and the Material Abs. Area of all the selected materials (in
1/1 Octave Bands). These graphs can be accessed using the tabs at the bottom of the side panel.
Enabling the ‘Graphs real time update’ option will update the graphs whenever any change is
made in the geometry.
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Running Precise Room Acoustics Calculations

To run a Precise calculation, open the "Calculations Tools" window , and select the "Run

Room Acoustics Calculations" tool . You will be asked to make sure that your room is closed,

you may disable this message if you wish:

Please note that 

1- Geometry should consist of "closed rooms" with no holes.

2- All surfaces forming the room should have their normals  pointing inside the room. If you're

not sure use the "Auto Correct Normals" tool   from the "CAD Tools" window. Surfaces

should also not be double sided. 

3- Avoid covering one surface with another. In case of overlaying surfaces, either use the "Add

Patch" tool   or the "Cut Surface" tool  from the "CAD Tools" window.

4- Any walls or objects which have two sides to them inside the room should be double sided.  An
easy way to do this is to click the "Add back side" button found in the ‘Wall’ side panel, once you
have inserted the object.
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Results will be displayed in the Output Window, under Frequency Domain and Impulse

Response>Room Acoustics, where you can select to see the various parameters in graph or table

format. See also Results>Output Window section.

Running Indicative Room Acoustics Calculations

The ‘Run Indicative Room Acoustics Calculation’ tool runs a room acoustics calculation by tracing
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70000 images and calculates room acoustics parameters in a 1 Octave band frequency resolution.

The maximum images to be traced and the frequency spectrum cannot be changed. No paths will

be calculated for frequency domain calculations.

To run an Indicative calculation  open the ‘Calculation Tools’ window, and select the ‘Run

Indicative Room Acoustics Calculation’ tool . You will be asked to make sure that your room

is closed. You may disable this message if you wish. 

Make sure that all the conditions outlined in the above section Running Precise Room Acoustics

Calculations are met.

Results can be found in the ‘Results Graph’ side panel under the ‘Room Acoustics’ tab of the
‘Indicative’ tab.

A full room acoustics calculation for a typical room will tend to require approximately 500000
images to be traced. Therefore the ‘Run Indicative Room Acoustics Calculation’ tool gives quicker
indicative results based on 70000 paths. If you would like to get even quicker indicative results
simply set the ‘Maximum Images To Trace’ field, in the Calc Options>Path Detection>OPO/Room
Acoustics tab of the Calc Options side panel, to a lower number and run the ‘Run Room Acoustics
Calculation’ tool from the ‘Calculation Tools’ window, as described in section Running Precise
Room Acoustics Calculations.

Indicative results will also be saved in the ‘Output Window’ under ‘Room Acoustics’ tab in the
‘Time Domain’ tab: 
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Running Indicative Room Acoustics Mapping

Users can also run Indicative Mapping calculations. Using the "Mapping tool" , in

the‘Calculation Tools’ window, select ‘Room Acoustics’, ‘Indicative’ and select the area you wish to

map:
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14.2.1 Room Modes

Users can calculate room resonances using the "Precise" calculations in Mapping .

In the "Calculations"  menu, launch the "Mapping" tool. 

In the "Mapping Area Picker" select the "Precise" Mapping:
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Before you select the area you wish to map, check the calculation options first found on the left
hand side panel to specify the order of reflections (3 in this case), diffractions (1 in this case),
10,000 top strongest paths and path length (see screenshot below) etc:
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Select the Area to map:
A Resolution of 1m, offers analysis up to 200Hz. More dense area offers higher frequency
analysis. 
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Select Add and then Plot.

The results will be displayed in the Output Window under Mapping. You can then select to adjust
the interpolation, 3d plot height, toggle Geometry on/off, etc…

You can then select to see each frequency from the Frequency drop down menu.

HINT: When using the Mapping Tool to calculate the modes of a room we need a sufficiently large
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number of receivers to avoid any aliasing effects. In particular we need at least two receivers for
each wavelength. Since the smallest wavelength in OTL Room Modes is approximately 0.72m
(474 Hz), the required receiver resolution for avoiding anti-aliasing effects needs to be about
0.35m. However if the room has absorption materials we can reduce the number of steps needed
by setting the resolution to two receivers for the wavelength of the Schroeder Frequency. After the
Schroeder frequency the field becomes diffuse therefore there is no need to take any more steps
to avoid aliasing effects.

Here is the procedure for determining the number of steps needed in a mapping area:

1. Determine the Schroeder Frequency. Select all the surfaces in the room. Make sure the
normals are all correct and pointing inside the room. Go the ‘Room’ side panel and click
the ‘Update Graphs’ button. The Schroeder Frequency will be calculated in the ‘Room’
side panel.

2. Find the Schroeder Wavelength. Convert the Schroeder frequency to the wavelength
using the formula:

A typical speed of sound in a room is 345 m/s.

3. Divide λSchroeder by 2. This value will be the maximum step needed between two

receivers.
4. Once a mapping area has been created in a room take the length of one edge of the

mapping area (the 'Distance between P1/P2 and P2/P3' fields in the ‘Select Mapping
Area’ window) and divide it by the step that you calculated in Step 3. Round the number
to the highest integer and enter the value in the relevant ‘Steps between P1/P2 and P2/
P3’ field of the ‘Select Mapping Area’ window.
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14.3 Open-Plan Office Calculations

In  open  plan  offices,  the  occupants  are  affected  by  activities  surrounding  them.  Insufficient
acoustic conditions lead to distraction and a lack of speech privacy. Distraction weakens the ability
to  concentrate  and  reduces  productivity,  especially  in  tasks  requiring  cognitive  resources.  Low
speech privacy prevents confidential or partly confidential conversations. Speech can be intrusive
for the listener, whereas for the speaker, it can be desirable to avoid involuntary spread of speech
of a private nature. ISO 3382-3 specifies a measurement method which results in single number
quantities indicating the general acoustical performance of open plan offices. The principal aim is
good speech privacy between workstations. 

spatial decay rate of speech
D2,S, rate of spatial decay of A-weighted sound pressure level of speech per distance doubling

A-weighted sound pressure level of speech at a distance of 4 m
Lp,A,S,4 m, nominal A-weighted sound pressure level of normal speech at a distance of 4,0 m from
the sound source
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speech transmission index
STI, physical quantity representing the transmission quality of speech with respect to intelligibility
[IEC 60268-16:2011]

spatial sound distribution of the speech transmission index curve which shows how the
speech transmission index decreases from a reference sound source when, distance increases

distraction distance
rD, distance in meters from speaker where the speech transmission index falls below 0,50. Above
the distraction distance, concentration and privacy start to improve rapidly

privacy distance
rP, distance in metres from speaker where the speech transmission index falls below 0,20 Above
the privacy distance, concentration and privacy are experienced very much the same as between
separate office rooms. STI values less than 0,20 are difficult to achieve in offices with poor speech
privacy or small volume.

background noise level
Lp,B, sound pressure level in octave bands present at the workstation during working hours with
people absent, Background noise here means all such continuous sounds, which are not caused
by people, e.g. heating, ventilation and air conditioning (HVAC) devices, environmental traffic
noise, office equipment or a sound-masking system. Background noise level, Lp,B, is measured at
each measurement position in octave bands. The A-weighted sound pressure level, Lp,A,B, is
determined accordingly. The average background noise level of all the measurement positions is
determined.

Typical single number values in offices with:
Poor acoustic conditions have D2,S < 5 dB, Lp,A,S,4 m > 50 dB, and rD > 10 m.
Good acoustic conditions are rare, but an example of target values could be D2,S 

Lp,A,S,4 m rD 

Recommended Calculations Settings
For the maximum images to be traced, the recommended images to be used should be at least

1000. The maximum path length could vary between 100m (about 300 milliseconds) and 500m

(about 1500 milliseconds) – please note that path length in milliseconds is not to be

confused with the RT in milliseconds given above for the number of images per

millisecond.  Path length and images to be traced vary with room size. 

Diffraction order should be at least 1. Higher orders are recommended when source and receiver

are screened by more than one partition, preferably according to the number of in-between

partitions.  Please note: Higher order diffractions take longer to calculate. Reflections

between diffractions are also recommended for OTL-Suite users. 

The number of Top Strongest Paths to be calculated should be at least 20. However, all

recommended are subject to user’s judgement according to your project.
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If during calculations the progress bar indicates that the number of images detected slows down

compared to the number of Rays Shot, this is an indication that the calculation time might be

longer, furthermore, if the rate by which images detected become very sparse, the PEMARD

algorithm will interrupt the tracing procedure automatically and proceed to the calculation of the

results.

Note: Please note that this rule applies mostly to cube shaped rooms and that for each project one

has to experiment with reaching the number of images and maximum path length to be used. The

tendency is that the higher number of images to be detected the better the results are expected.

However, the penalty is longer calculation times, therefore the strategy is to start with a small

number of images and path lengths and to get a feel of the results. 

Impulse response and/or auralisation calculation buttons carry out calculations based on the image

source method and depend on the reflections and diffraction orders to be calculated. For outdoor

sound propagation such an approach is manageable in terms of calculation time. However, in

closed spaces where the possible number of source images can reach vast numbers, this method

is recommended to be used with 6-10 orders of reflections and 1 or 2 orders of diffraction.

Open-Plan Office parameters are not calculated using these buttons, however results can be

exported to be post processed by third party applications. 

Recommended STI Levels
Intelligibility

quality
STI value

poor 0 - 0.30

satisfactory 0.30 - 0.45

good 0.45 - 0.60

very good 0.60 - 0.75

excellent 0.75 - 1.00

Room Surface & Volume
You can see the room's total area and volume by selecting your room or walls which you would like
to calculate, and open the Room Parameters panel found on the left hand side of the Geometry
Viewport:
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Running Precise Open Plan Office Calculations

To run a calculation, open the Calculations Tools , and select the Run Open Plan Office

Calculations tool . You will be asked to make sure that your room is closed, you may disable

this message if you wish:

Please note that 
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1- Geometry should consist of "closed rooms" with no holes.

2- All surfaces forming the room should have their normals  pointing inside the room. If you're

not sure use the Auto Correct Normals tool   . Also surfaces should not be double sided. 

3- Avoid covering one surface with another. In case of overlaying surfaces, either use the Add

Patch tool   or the Cut Surface tool .

4- All walls or objects inside the room should be double sided.  An easy way to do this, is once you
insert an object, click once "Add back side" option found in the Wall side panel.

Set your calculation parameters in the Calculations Options , and then Run Open Plan Office

Acoustics Calculations  found in the Calculations tools. In Open Plan Office calculations, the

most important factors you need to specify are the number of rays to trace per receiver (Hybrid

Tracing), the top strongest paths per receiver (Top Paths) and the path length [Maximum Path

Length (in ms or m)].

Results will be displayed in the Output Window under Open Plan Office tab:
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Running Indicative Open Plan Office Calculations

With Indicative Calculations , results are displayed in the OPO (Open Plan Office) tab, under

Results  panel   found  on  the  right  hand  side  of  the  Geometry  Viewport.  Results  are  an
estimation and can not be saved.
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14.4 Mapping

Mapping allows the user to plot the level distribution over an area and view mapping in 2D or 3D.
Mapping  is  calculated  with  a  resolution  of  1/12  octave  band  centre  frequencies  and  shows
calculation  results  in  1/3  octave  bands  between  25  and  10000Hz  over  an  area  of  number  of
receivers at a density specified by the user. For outdoors , results show IL, EA Before and After,
LpBefore,  LpAfter,  LpAfterISO  broadband  or  in  1/3  octave  band  resolution.  For  room  Acoustics
results show Reverberation time
and T30 and Open Plan Office results show STI.
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Please  note  that  OTL  requires  a  reasonably  good  graphics  card,  especially  in  relation  to
Mapping in order to achieve excellent 3D rendering. 
OTL users who only have an on-board graphics card, may sometimes experience rendering
issues while viewing Mapping plots.

Outdoor Sound Propagation Noise Mapping

In order to plot an area, click the Mapping icon  located in the Calculations Menu . You
will see a pop up window of the Mapping Area Picker in order to select the area you wish to map.
Users  can  select  between  Precise  Calculation  methods,  ISO  9613-2  Calculation  methods  (in
octave-band midband frequencies from 63 Hz to 8kHz) or both.
 
 

Mapping Area Picker

 

Click  Add  to  open  the  3D  Select  Mapping  Area.   Specify  the  area  you  wish  to  plot  using  either
Select Area and click on desired surface such as the ground or barrier, or a facade. Alternatively
you can also Draw Rectangle by selecting two points  and dragging your  rectangle to specify the
area.

You can increase or decrease the density of the receivers in the area by changing distances and
steps between P1 & P2, and P2 & P3.

Hint: Avoid having the coordinates of the receivers in the mapping area coincide with any
surfaces. This is possible when defining a  mapping area with ‘Select Area (Click on a surface)’
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option of the ‘Select Mapping Area’ window. If you are using this option it is best to offset the
mapping area from the surface a little bit (such as by 0.001m) using the ‘Move Area’ tool in the
‘Select Mapping Area’ window. If the mapping area is within a room and the ‘Select Area (Click on
a surface)’ tool was used, it is also a good idea to shrink the area a little so that the receivers on
the edge of the mapping area do not coincide with any walls (shrink the mapping area using the
‘Distance between P1/P2 and P2/P3’ fields in the ‘Select Mapping Area’ window and then move
the area around so that no receivers coincide on any walls).

 

You can rotate you area by specifying the points and angle of rotation you wish to rotate on.
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Select ADD, to return to the Mapping Area Picker, whereby you can add more areas to plot. Select
the  area  you  wish  to  plot  and  click  Plot.  Your  results  will  be  displayed  in  the  Output  window,
Mapping tab. The user can toggle the geometry and Mapping on and off by clicking the geometry

button or the Mapping button  to see the results more clearly, and has the option to view

the results in  and . 

In the Mapping Output Window, the user  can see parameters  such as the Insertion Loss values
and coordinates of each receiver by left clicking the mouse. In order to keep values visible, double
click the left button on the mouse. In order to clear all labels,  click on the eraser button on top right
side of the tool bar. In order to send screenshots to Report, right click and select Send Screenshot
to Report. The user may also delete unwanted plots, by selecting the mapping they wish to delete
from the left side under Plots, and right click  to delete.
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Overview of Mapping Output Window
 

A useful tip to bear in mind, in case the mapping area that you have selected did not have its
normal  facing to the desirable  direction  and you didn't  notice,  you don't  have to  recalculate  your
Mapping, just by selecting a negative value for  '3D Plot Height'  will  turn the mapping area facing
backwards. Thus saving you a lot of time.

Mapping Results

To see the contribution of each Receiver, click on the Mapping area to reveal the levels. You can

alter the font size using the Label size. To remove all labels, use the Clear all Labels tool .
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Mapping in Room Acoustics and Open Plan Office

For Room Acoustics, select the Room Acoustics Mapping option, and for Open Plan Office, select
the  Open  Plan  Office  Mapping  option.Selecting  a  mapping  area  for  Room  Acoustics  and  Open
Plan Office is the same procedure as for outdoor sound propagation, as above. 

Results are displayed in the Output Window under Mapping tab and show Reverberation time and
T30 for Room Acoustics, and STI for Open Plan Office.
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14.5 Polar Plots

Only Available in OTL-Suite.

Create a Polar plots on an axis using either an edge or 2 points. Reflectors in auditoriums, are of
paramount importance. Their size and inclinations can now be fine tuned by calculating their
performance using the Polar Plot tool. Choose an edge on the reflector as your axis and assign the
radius where you want your microphone to move. Polar Plots, can also be used to calculate sound
distribution and scattering and in the future other coefficients such as sound diffusion and
scattering coefficients.

1. To create a polar plot, select the Polar Plot tool  found in CAD Tools . 
2. The Polar Plot Picker window will open. 
3. Click Add to open the Polar Axis Picker window.
4. Select the axis by Edge, Point(s), or coordinates.
5. Select the radius and rotation plane.
6. Select the Start and End angle you wish to plot and the frequency band.
7. Click Add.
8. In the Polar Pick window, click Plot.

Results will be displayed in the Output Window under Polar Plot Tab.

Diffusion Coefficient

The directional diffusion coefficient is obtained according to ISO 17497-2.
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14.6 Impulse Response

Any Linear Time Invariant system can be characterized by its Impulse Response. Impulse
Response is the response of a system when an impulse is applied to its input and allows the
computation of the output of the same system to the input of any signal.

In order to calculate Impulse Response, Run Impulse Response Calculations . Results are
shown in the Output Window, under the Time Domain tab.
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You must Set the Scale to default in order to properly view the curve. To do so, right click on the
graph area, right click and select "Set Scale to Default".

Results can also be viewed in dB.

Transforming a Calculated Transfer Function to Impulse Response

It is also possible to transform the calculated Transfer Function to Impulse Response. After

running Precise calculations , in the Output Window, right click on the calculation and
Transfer Function Before or After to Impulse Response. You can also Export the Transfer Function
to clipboard or CSV.

IMPORTANT: If transforming a calculated Transfer Function to Impulse Response
from Precise calculations, the samples must have equal frequency distances. In case they
are not, the following error message will pop up:
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In order to set the frequency steps, go to the Calculations Options panel found on the left hand
side of the Geometry Viewport, and ensure that the frequency steps are equal and Constant.

14.7 Auralisation

Auralisation allows the user to take a calculated impulse response and use it to convolute either

one of the built-in default sounds in OTL or an imported .wav file (provided the .wav file has a 44.1

kHz sampling rate and a 16 bit depth).

OTL also implements the Head Related Transfer Function (HRTF). This response will characterize

how the human ear itself receives the sound from a point source. An impulse response for both left

and right is calculated enabling binaural auralisation when the final stereo signal is heard through

headphones.

There are three ways to run an Auralisation calculation:

1. Once a model has been set up simply click the ‘Run Auralisation Calculation’ tools from the

‘Calculation Tools’ window . Once the calculations are complete the results will be shown

in the ‘Output Window’ under the ‘Auralisation’ tab of the ‘Time Domain’ tab:
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The user can then either convolve a built-in default sound by selecting the ‘Sound Collection’ radio
button and choosing a sound from the drop down menu, or the user may import a .wav file by
selecting the ‘From File’ radio button which will prompt the user to find the .wav file.
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The user must then select the impulse responses that are to be convolved. These are selected
from the ‘Before’ and ‘After’ dropdown menus of the ‘IR to convolve’ section. All the ‘Before’ IR
curves (where remedial surfaces are excluded from calculations) are found in the ‘Before’
dropdown menu while all the ‘After’ IR curves (where remedial surfaces are included in the
calculations) are found in the ‘After’ dropdown menu. Finally below each dropdown menu there are
buttons that will Play, Stop or allow the user to ‘Save’ the final .wav file.
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2. A second method is to select the ‘Run Impulse Response Calculation’ tool from the ‘Calculation
Tools’ window. This will run a calculation which has the same resolution as the ‘Run Auralisation
Calculation’ but at half the sampling rate. Therefore the calculation will take less time to
complete than the aualisation calculation, but the final impulse response will need to be
upsampled in order to be auralised. Once the IR calculation has been completed the results will
be presented in the ‘Output Window’ under the ‘Impulse Response’ tab of the ‘Time Domain’
tab. The user can then rightclick any of the IR curves from the left hand side panel and select
‘Auralise’. The ‘Auralisation’ window will pop up presenting the user the same options of the
‘Auralisation’ tab. The user can select either a default built-in sound or import a .wav file and
then either Play, Stop or Save the final .wav file. An message will appear when playing the .wav
file informing the user that the IR curve will need to be up sampled.

Auralise Menu
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Auralise Window

Sampling Rate message

3. Finally the user can select either the ‘IR Analysis’ or the ’44.1k Analysis’ preset spectrum
analysis buttons from the ‘Calculations’ tab of the ‘Calc Options’ side panel. The user can then
select the ‘Precise Calculation’ tool from the ‘Calculation Tools’ window. Both preset options will
calculate IR curves that can be auralised using either of the procedures described above.
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14.8 Precise Calculations

Precise Calculations 

 
Precise  Calculations  presents  the  results  in  the  Output  Window  with  high  frequency  resolution
calculations under Frequency Domain in the Output Window. See also Output Window.

The  output  in  1/1  octave  band  is  also  shown  in  the  Precise  Graph  (Results  Tab   )  in  the
Geometry Viewport, including A-weighted and Linear.

Results can be exported to the clipboard, in .txt or .csv file formats.
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Curves in Precise Results Graph
The following result curves are given in the Precise Results graph:
 

NR: Noise Criteria applied at the receiver
Level Before: the noise source level at the receiver before the implementation of a barrier.
Level After: the noise source level at the receiver after the implementation of a barrier.
IL:  Insertion  Loss  (Level  After  -  Level  Before).  This  is  the  effect  felt  at  the  receiver  by  the
implementation of a barrier. By definition this is a negative value and that is how it is shown in
the  Output  Window,  however,  in  the  Precise  and Indicative  Results,  IL  is  shown  as  a  positive
quantity.
Excess Noise Levels: The levels exceeding the Noise Criteria.

          
See Terminology.
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14.9 Indicative Calculations

Indicative Calculations 

 
Runs calculations in 1/3 octave centre frequencies only, displaying Lp results in octave bands in

the  Indicative  Graph  (located  in  Results  Panel  on  the  right  of  the  Geometry  Viewport)  after
being appropriately processed. It checks whether solutions meet noise criteria. 

The  Indicative  calculations  in  Outdoor  Sound  Propagation  take  into  account  only  the  (a)  Noise
Source/s,  (b)  Receiver,  (c)  Barrier  and  (d)  Ground/s  and  disregards  everything  else  in  the  3D
model. 
 

 

Toggle Indicative Button ON/OFF:  
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While  activated  indicative  results  are  given  in  real  time  whenever  any  parameter  is  changed  or
object is moved (source, receiver, barrier, and ground).
 
Note: Activating the indicative button ON, could make calculations slower depending on the
complexity of the project. Therefore it is best to switch it OFF unless it is needed. 
 
Curves in Indicative Results Graph
The following result curves are given in the Indicative Results graph:
 
NR: Noise Criteria applied at the receiver
Level Before: the noise source level at the receiver before the implementation of a barrier.
Level After: the noise source level at the receiver after the implementation of a barrier.
IL:  Insertion  Loss  (Level  After  -  Level  Before).  This  is  the  effect  felt  at  the  receiver  by  the

implementation of a barrier. By definition this is a negative value and that is how it is shown in the
Output Window, however, in the Precise and Indicative Results, IL is shown as a positive quantity.
Excess Noise Levels: The levels exceeding the Noise Criteria.

See Terminology
Indicative Room Acoustics Calculations
Indicative Open Plan Office Calculations



Part
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15 Calculations Results

15.1 Results Graph - Side Panel

Includes Precise, Indicative and ISO 9613-2 results. Each tab has subtabs according to these
categories.

When running any indicative calculations (outdoor, room or open-plan office), the results can be
seen in the Results Graph panel. Please note that Indicative calculation results can not be saved,
however, bu right clicking you can save or send the screenshot to report.

Precise Graph
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Indicative Graph
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ISO Graph

ISO 9613-2 results can also be seen in the Output Window.

15.2 Output Window

After running Precise, Room Acoustics and Open Plan Office Calculations, results are displayed in

the Output Window .  The Output Window consists of five tabs:

Frequency Domain; displays Lp results in the frequency domain.

Time Domain; displays results for Impulse Response, Room Acoustics and Auralisation

Open Plan Office; STI vs Distance and Level vs Distance results (See Open Plan Office
Calculations section).



219Calculations Results

Copyright © 2018  P.E. Mediterranean Acoustics Research & Development Ltd. All Rights Reserved.

Mapping

Polar Plots, shows the Level distribution vs Angle 

The User can Import/Export curves from/to clipboard or .txt or .csv (comma separated values) file
format from/to 3rd party software or to be imported at a later stage into OTL. Results can also be
viewed in a Table format. It is also possible to Export Curve to clipboard, and then import it  from
the  clipboard  in  another  configuration  in  order  to  compare  the  two.  See  How  to  Import/Export
section.
 
For  several  configurations,  each  configuration  will  be  listed  in  a  separate  tab.  In  order  to  switch
between each configuration, select the drop down arrow and select the appropriate configuration.
 

 You may also resize the windows in the Output Window to allow more configuration tabs to
show or hide. If you are unable to see the Output Window, make sure it's enabled from the View
menu in the main Geometry Viewport.

Frequency Domain

The following result curves are given in the Output Window, Frequency Domain tab:

Insertion Loss
Excess Attenuation Before
Excess Attenuation After
Level Before
Level After
Level Free Field

See Terminology section
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You can Autoscale the graphs and view frequency results either in Logarithmic or Linear scale. To
view them in Linear, deselect the Log x Axis check box.

You can also view the Linear as well as the A Weighted Total Sound Pressure Level by selecting

the ‘Total SPL’ tab next to the ‘High Resolution Graph’ tab.

Time Domain
Room Acoustics calculation results in the output window are given in the following categories
under Time Domain:

1. Decay (sound) parameters which are all in units of time.
EDT, Early decay time calculated between t0=0dB and t=-10dB multiplied by 6 to
correspond to the classical definition of Reverberation Time (See Terminology) using the
Schroeder Inverse Integration Method (See Reference List)
T20 RT calculated between t0=0dB and t=-20dB multiplied by 3 to correspond to the
classical definition of Reverberation Time (See Terminology)), using the Schroeder Inverse
Integration Method
T30 RT calculated between t0=0dB and t=-30dB multiplied by 2 to correspond to the
classical definition of Reverberation Time (See Terminology), using the Schroeder Inverse
Integration Method
T60 RT calculated between t0=0dB and t=-60dB multiplied (See Terminology), using the
Schroeder Inverse Integration Method 
Sabine RT, calculated using Sabine’s method (See Terminology)
Eyring RT calculated using Eyring’s method (see Terminology)
Centre Time, the time of first moment of impulse response or gravity time

2. Clarity and Strength (sound) in units of dB.
C50 (See Terminology)
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C80 (See Terminology))
G (See Terminology)

3. Definition (ratio, no units).
D50 (See Terminology)

4. Speech Transmission Index (no units) (See Terminology)
5. Room Parameters.

Room Volume in m3
Room internal surface area including objects, in m2
Mean Free Path in m and ms
Schroeder frequency in Hz, the frequency above which the room may be assumed to have a
diffused sound field.

Open Plan Office; STI vs Distance and Level vs Distance

(See Open Plan Office Calculations section).



Part

XVI



223Database

Copyright © 2018  P.E. Mediterranean Acoustics Research & Development Ltd. All Rights Reserved.

16 Database
The Database comprises of two databases, Local Data and Project Data. When creating a new
project, the local database will be copied to the Project Database as well as any new added
database used in that particular project. Database will be saved in the Project Data file in order to
allow users to exchange projects which includes the relevant database required for that particular
project. Users can delete unnecessary data when sending a project in order to reduce file size.

We have also introduced a Merging Tool, allowing Users to merge their entities from their local
database to their project database and vice versa. The Local Database acts as the main central
Database.

When saving a project, a new folder is created in the project directory which contains the full
database as well as any newly added database. It is advised to delete non-required database in
order to reduce the project size. Users can then merge the new database to their Local Data.

Merging Tool

The Merging Tool is located in the top menu under Database>Merging Tool.

When you launch the Merging Tool, a new window will open displaying two windows with the Local
Database and Project Database.

Select the Expand tool to expand all the database available . The full Database is now
displayed on both sides.

 

At the bottom, you can see how many are identical, missing, different and any newly added
database. The relevant categories will be also be highlighted next to the particular database
corresponding to the same colour as the legend.
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You can see that there is 1 Source missing from the Local Database and is highlighted in Pink

To merge the missing entity from Project Data to Local Data, select the missing entity or select all
if you wish to merge everything, and click the Copy from Project Data to Local Data Tool :

A pop up window will ask you "You are about to merge databases from right to left. Are you sure?"
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Click Yes to confirm. 

You will receive a Merge confirmation and will be able to see the new entity on both Local and
Project Databases:

Migrating Tool

We have introduced a Migrating tool for users to be able to migrate their databases from Olive
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Tree Lab - Terrain 2.0 to OTL in order not to lose any custom databases. The Migrating Tool is
located under Database>Local Data>Migrating Tool.

When you launch the Migrating Tool, a pop up window will ask you to select the database you wish
to migrate. The database is located in

C:\Users\user\AppData\Roaming\OliveTreeLab2

Select the OliveTreeLab.mdb.

And select Transfer Data:

You will then be asked whether you wish to clear the existing data or not. If you clear the existing
data, your selected data from OTL-Terrain 2.0 will replace the database of OTL-3.0. If you keep
them, then you will be able to have both databases in OTL-3.0. Please note that the transfer
process may take a while.
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Select No to keep both databases, since OTL-3.0 has a new enriched database.

Once the transfer process is complete, a "New Category" will be created in the database and any
duplicates will be renamed with the same name but with "2" to distinguish them:

16.1 Sources

Noise Source Database includes Noise Database for Prediction of Noise on Construction
and Open Sites by DEFRA . Please note that the Information is licensed ‘as is’ and the
Information Provider excludes all representations, warranties, obligations and liabilities in
relation to the Information to the maximum extent permitted by law. The Information
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Provider is not liable for any errors or omissions in the Information and shall not be liable
for any loss, injury or damage of any kind caused by its use. The Information Provider does
not guarantee the continued supply of the Information.
 

Selecting a Noise Source
The Noise Sources contain various noise source spectra that can be used for each of the sources

in your environment. In order to select a noise source spectrum, you need to double click on the

source, select the Source Category, and then the Source Name. In order to View/Edit the Source,

click on the ‘View/Edit  the Selected Noise Source’ button displayed next to the Source. In

order to create a New Source click on the ‘Add New Noise Source’ button next to the Source  .

The selected source’s spectrum is also displayed in the source Panel.

Adding a Noise Source

In order to add a new noise source, click on the ‘Add New Noise Source’ button   next to the
Source or open the Database window and select Local or Project Data>Sources. Use the Project
Data directory if you wish to share your project on another PC, this will avoid having to transfer the
whole Database from PC to PC. You can always merge the two together at any time, See Merging
Tool.

A new window will open displaying the Sources database, sorted in categories and sub categories.
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you can create a new category or add to an existing category if you wish.

To create a new category, select the Add tool , and name your new category. the Created By
and Date will automatically be entered using the User's PC id and date and time the category was
created.

Under Sources, select the Add tool to add your Noise Sources .

A new window will open where you can enter your Noise Source spectrum. You may enter either a
sound power level spectrum or a sound pressure level spectrum.
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If the spectrum is power, select the Power radio button to transform the spectrum into a free field

sound pressure level at 1m distance.

If  the spectrum is in free field sound pressure level  and was measured or calculated without
the effect of the ground (for example in an anechoic chamber), check the Pressure check box and
enter  the  distance for  which  the  level  corresponds  to.   The spectrum  would  then be  adjusted  to
correspond to a free field sound pressure level at 1m distance.

If the measurement was taken in the field and no substantial in size objects were close to the
measuring  microphone  (if  not  sure  what  is  considered  substantial  in  size  object,  please  consult
appropriate acoustical  standards),  then enter  the distance between source  and measuring  point,
the height of source and height of measuring microphone above ground. You may assign ground
flow  resistivity  by  selecting  the  type  of  ground  from  the  Material  Name  drop  down  menu  or  by
entering  manually  the  flow  resistivity  value  you  would  like  to  apply  to  the  measurement.  If
atmospheric  conditions  data  are  also  available,  they  may  be  entered  in  the  appropriate  boxes.
Again, the spectrum would be adjusted to correspond to a free field sound pressure level  at  1m
distance.

Enter the name for the source as it will be appear in the database.

You may also use the + or – buttons to increase all the frequency levels by the amount specified in

the ‘Gain’ field:

Note: In effect, the Add Noise Source/Edit Noise Source provides calculation tools which remove
the ground effect from sound measurements. The user however has to be prepared in advance to
take measurements under controlled conditions (establish source acoustic  centre,  be sure about
ground  type  where  ground  reflections  are  likely  to  take  place,  record  atmospheric  conditions
accurately) in order to transform site measurements into free field measurements.

Importing from File and Clipboard

You can import your source spectrum directly from a CSV file or copy and import from clipboard.

Make sure that in both cases, the cells are in two columns, the first displaying the frequency band
values, and the second the level values.
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 If the measured spectrum is available in a spreadsheet form which includes the 1/3rd octave

band values from 25 to 10 kHz, the user may copy on clipboard the relevant range, and paste it

directly using the Import from Clipboard button. Make sure that the clipboard contains 2 x 27 cells

and  that  the  first  column contains  1/3rd  octave  band  centre  frequency values,  while  the  second
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contains level values.

Users also have the option to set a default noise source by enabling the "Set as Default" option.

Click Save. The new source is now added in the database:

 
The newly added source will also appear under the created category in the Source Panel. To
select the new source, double click on the source in your Geometry Viewport and select the
relevant category and source:
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Please note, that selecting the 3D representation of a source are for visual purposes only, a
source spectrum still needs to be selected.

Importing a CLF file

OTL can now import CLF files that represent the directivity of the source. In order to import a CLF
file first select the ‘CLF File’ radio button in the ‘Type of input value’ section. Click on the ‘Select
Directivity File’ and find the desired CLF file. You may also open ‘CLF Viewer’ by clicking on the

‘View Directivity File’ button.   and find the desired .clf file. You may also open ‘CLF Viewer’

by clicking on the ‘View Directivity File’ button . 

In order to view the .clf file you need to have CLF Viewer installed. You can download the free
viewer from http://www.clfgroup.org/clfdocuments.htm

http://www.clfgroup.org/clfdocuments.htm


234 Olive Tree Lab - Suite User Manual

Copyright © 2018  P.E. Mediterranean Acoustics Research & Development Ltd. All Rights Reserved.

The ‘Axial Spectrum’ of the source will be imported to the source spectrum and the directivity of
the source will now also be taken into account. The axial spectrum is the source spectrum at the
front of the source (the red axis of the source). The front axis of the source is also illustrated in the
‘Direction’ section of the ‘Source’ side panel. 
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The Directivity Index is not used in the calculations but is presented for illustrative purposes only (0
corresponds to an omnidirectional source).

The user can freely edit import/export the axial spectrum. To reset the source spectrum to the one
in the original CLF file click the ‘Reset Spectrum’ button.

Note: A CLF file might contain more frequencies than those shown in the CLF Viewer. In those
case OTL will import those extra frequencies even if they are not shown in the CLF viewer. We
highly recommend that you delete any extra frequencies in the source database table that are not
shown in the CLF viewer as we cannot guarantee whether those values are correct since this is a
third party product.

Changing the Source Direction

To change a source’s direction first select the source or sources and click on the ‘Show Directions’

icon  to show the sources’ directions. Then click on the ‘Move/Rotate Selection’ icon . In
the ‘Move/Rotate Selection’ window go to the ‘Rotate’ tab. Set the desired angle of rotation in the
‘Rotation Angle’ field and then select the ‘Rotate On Point’ radio button. The colours of the
clockwise and anticlockwise buttons correspond to the color of the rotation axis as seen in
viewport.

Changing the Receivers Direction

To change a receiver’s direction first select the receiver or receivers and click on the ‘Show

Directions’ icon  to show the receivers’ directions. Then click on the ‘Move/Rotate Selection’
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icon . In the ‘Move/Rotate Selection’ window go to the ‘Rotate’ tab. Set the desired angle of
rotation in the ‘Rotation Angle’ field and then select the ‘Rotate On Point’ radio button. The colours
of the clockwise and anticlockwise buttons correspond to the color of the rotation axis as seen in
viewport.

Editing a Noise Source
In order to edit an existing  noise source, select the Edit mode for either Source Category or

Sources . 
Enter the values, and click Save to update the Noise Source spectrum.
 

16.1.1 Directivity

Link: Please refer to section How to import a .clf file

16.2 Receiver Criteria

In order to insert new Receiver Criteria, the same process applies as with Sources.

Selecting a Receiver Criteria
The Receiver Criteria contain various receiver criteria that can be used for each of the receivers in
your environment. In order to select a receiver criteria, you need to double click on the receiver,
select the Noise Criteria Type, and then the criteria under "Name" tab. In order to View/Edit the
Receiver, click on the ‘View/Edit the Selected Noise Criteria’ button displayed next to the Receiver 

. In order to create a New Receiver click on the ‘Add New Noise Criteria’ button next to the
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Receiver. 

Adding a Receiver Criteria
In order to add a new Receiver Criteria, either click on "Add" from the Receiver side panel found
on the right hand side of the Geometry viewer,  or open the Database window and select Local or
Project Data>Criteria. Use the Project Data directory if you wish to share your project on another
PC, this will avoid having to transfer the whole Database from PC to PC. You can always merge
the two together at any time, See Merging Tool.
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A new window will open displaying the Criteria database, sorted in categories and sub categories.

you can create a new category or add to an existing category if you wish.

To create a new category, select the Add tool , and name your new category. the Created By
and Date will automatically be entered using the User's PC id and date and time the category was
created.
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Under Criteria, select the Add tool to add your Receiver Criteria .

A new window will open where you can enter your criteria. 

Importing from File and Clipboard

You can import your source spectrum directly from a CSV file or copy and import from clipboard. 
make sure that the file contains 2  x 9 cells and that the first column contains 1/1 octave band
centre frequencies values, while the second contains level values.
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Users also have the option to set a default noise source by enabling the "Set as Default" option.

Click Save. The new receiver criteria is now added in the database:
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The newly added receiver criteria will also appear under the created Criteria Types in the Receiver
Panel. To select the new criteria, double click on the receiver in your Geometry Viewport and
select the relevant type and criteria:
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Editing a Criteria

In order to edit an existing  criteria, select the Edit mode for either Criteria Types or Criteria . 

Enter the values, and click Save to update.
 

16.2.1 HRTF

Please refer to section Auralisation>HRTF

16.3 Materials

Users can add materials based on their properties using either Delaney & Bazley's one parameter
model, or Allard and Johnson's six Parameter model (when applying material properties, materials
are assumed to be semi-infinite extent). 

If only the flow resistivity is used, then the Delaney & Bazley model is used. If the Porosity,
Tortuosity etc  parameters are used, then the Allard & Johnson model is used. 
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You may add a custom material either from the right hand side panels when clicking on an entity
and selecting Custom, 

Alternatively, using the Database menu found in the top menu, select Local or Project
Data>Materials Properties. See Merging Tool section for explanation on difference between Local
and Project Data.

There is a conversion tool that allows users to convert Flow Resistivity to Absorption Coefficients
found in the Materials panel in the Geometry Viewport.

The User can choose to select the material to include in the calculations either based on Material
Properties, Layered Structures or Material Absorption Coefficients. To select the material, double
click on the Wall or Surface (use the Select by Surface tool if you wish to select only one surface 

) navigate to the desired tab, and ensure that the Selected check box is enabled:
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16.4 Multilayered Structures

This tool incorporated in Olive Tree Lab - Suite allows for the calculation of the surface impedance,
absorption coefficient and SRI of semi-infinite materials and multilayered structures, based on the
Transfer Matrix Method (TMM). TMM considers layers of Air and Porous materials to be as layers
of fluids with different properties. 

Based on surface impedance, the sound absorption coefficient and sound transmission of
materials or structures may be calculated and shown within this module. Results may be exported
in various formats for post processing. Furthermore, created structures can be saved and used as
structures in the Olive Tree Lab -Suite environment, either for room acoustics or outdoor sound
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propagation. Surface impedances are calculated in both directions, front to back and back to front,
(according to the order the multilayered structure was build), depending on which side of the
structure is exposed to sound within the 3 dimensional OTL model. 

Air  termination  applies  for  a  structure  which  contains  at  least  one  plate,  or  perforated  materials
only. The following table shows when Air or Solid Termination applies:

 Combinations AIR Termination SOLID
Termination

Porous  

Perforated  

Plate  

Porous + Perforated  

Porous + Plate  

Porous + Air  

Perforated + Air  

Perforated + Plate  

Plate + Air  

Perforated + Porous + Plate

Creating a Multilayered Structure

The principle by which one builds a multilayered structure in a project or your local database is as
follows:

From the Database menu go to Multilayered Structures, found in the top menu under
Database>Project or Local Data>Multilayered Structure.
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Adding a Structure
To add a new structure, either create a "Category" under which you would like the new structure to
be included or directly add the structure to an existing category.

To create a new category, select the "Add" button , under Layered Structures Categories, and
name your new category. The "Created By" and "Date" fields will automatically be entered using
the User's PC id and date and time the category was created.

Click on the "Add" button   under Layered Structure to add your structure.

A window will open where you can select to add an existing material from the existing database or

create a new one by clicking the "Add New Material" button 
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There are four types of materials you may use to build a structure. These are:

1. Porous Materials which are subdivided into two categories, the 1 parameter materials and the 6-
parameter porous materials. For the 1 parameter materials, their surface impedance is
calculated using the Delany-Bazley [M. E. Delany & E. N. Bazley, 1970 Applied Acoustics (3) ,
"Acoustical Properties of Fibrous Absorbent Materials" ] model while for the 6 parameter
materials the Allard – Johnson " Allard, J.F. (2009). Propagation of Sound in Porous Media:
Modelling Sound Absorbing Materials" model is used.
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2. Perforated plates, which are being calculated using Vigran’s paper [T.E. Vigran, 2012 Applied
Acoustics, 73, 454-459, "Normal incidence sound transmission loss in impedance tube -
Measurement and prediction methods using perforated plates].
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3. Thin elastic plates which are being calculated based on the classical thin plate theories [Allard,
J.F. (2009). Propagation of Sound in Porous Media: Modelling Sound Absorbing Materials" model].
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4. Air and Porous material layers are being considered by TMM to be as layers of fluids with
different properties. You can insert an Air Layer in a structure by clicking the ‘Add Air Layer’
button. 

From the ‘Material Type’ dropdown menu you may select the type of materials that will be added to
the ‘Layered Structure Editor’. Once the material type has been chosen the user can view the
material’s properties and select the material from the ‘Materials’ list and add it to the ‘Layered
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Structure Editor’ either by double clicking it from the list or by clicking the ‘Add Material Layer’
button. 

You may designate material thickness and colour by double clicking on a material in the ‘Layered
Structure Editor’ (in this case mineral wool).
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You can also assign bridges to perforated or porous materials and assign the distance between
bridges:
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You may rearrange the materials in the correct order by dragging and dropping the material icon in
the ‘Layered Structure Editor’. Below the ‘Layered Structure Editor’, one can see the overall
thickness of the structure. The user may also assign different colours for the materials in the ‘Layer
Details’ window for clarity purposes.

By default all inserted materials in the structure are taken into account in the calculations. You may
either enable or disable any of the collected materials to see their contribution in the calculations
by selecting/deselecting the green tick under each material. Alternatively you may delete materials
from the ‘Layered Structure Editor’ by clicking on the red cross under the materials.

The following parameters are calculated by the Multilayer Structure Builder:
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Surface Impedance

1. Surface impedance, Front to Back and Back to Front.

Sound Absorption Coefficients

Sound Absorption Coefficient at normal incidence and integrated over 90 degrees (statistical abs.
coeff.), Front to Back and Back to Front.
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Rating of Sound Absorption

The sound absorption class of each layered structure and the weighted sound absorption

coefficient Aw are calculated according to ISO 11654. The Noise Reduction Coefficient (NRC) is

also presented. 
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Sound Reduction Index 

Sound Reduction index based on ISO 717-1:2013 Rating of sound insulation in buildings and of
building elements -- Part 1: Airborne sound insulation and in High Resolution:
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The Weighted Apparent Sound Reduction Index Rw of any structure is presented. The Rw values

and the corresponding  spectrum adaptation terms C and Ctr are calculated according ISO 717-1.

The results are presented in narrow band resolution as well as in 1/3 octave bands according the

mentioned standard.

Sound Bridges

The Sound Reduction Index provided by the sound bridges between plates is calculated using

Sharp’s methodology [Sharp B., 1978, Prediction methods for the Sound Transmission of Building

Elements] as implemented by J. Legault and N. Atalla (See References section).
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Note: The effect of bridges on porous material and air are only calculated when they are adjacent

to two plates, otherwise the bridges will be disregarded and you will receive a warning message:
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Porous material adjacent to two plates

Porous material not adjacent to two plates with warning message that bridges are not calculated

 

Critical frequency

The critical frequency of any plate is calculated and presented :
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Results can also be seen in table formats in Frequency Spectra and Single Value Parameters
Front to Back and Back to Front:
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The Statistical Absorption Coefficient and the Statistical SRI columns present the integrated
average of these parameters up to a maximum angle of incidence of 78 degrees. The Absorption
Coefficient 90 parameter calculates the absorption coefficient of the structure at normal incidence
while the SRI 60 parameter calculates the SRI at an angle of incidence of 60 degrees.

Saving a Structure

You may save the structure by giving it a name.

The structure will then appear in the Layered Structures database with calculation results showing
in graphs and tables.

Exporting Results

You may export the data points of the individual curves to the clipboard by clicking the ‘Export To
Clipboard’ button:
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The results can then be pasted in a third-party program. The curves that are exported are the real
and imaginary parts of the Impedance, the Statistical Absorption Coefficient (maximum integration
angle 78 degrees), the Absorption Coefficient at a normal angle of incidence and both the ISO 717
and high resolution Statistical SRI (maximum integration angle 78 degrees).
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17 Reports

The Report   function currently only works with Office 2007, 2010, 2013.
 
Screenshots from OTL can be used in the report by right clicking on the desired screenshot, and
selecting the Send Screenshot to Report option. Screenshots may also be sent to clipboard or
saved as image files.
 
You may send as many screenshots as you wish and select the ones you would like to include in
your report using the Report Wizard.
 

Once you have completed your calculations and screenshots, click the Print Report button .
A Report Wizard window will open.
 

 
You may select all or part of the screenshots and calculation results by selecting the ones needed.
Once you are satisfied with your selection, click Export. You will then be asked to save your report,
which will then open in a Word Template.
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To replace the logo, click on the Browse for Image  , and select desired image.

 
Note: Depending on the number of parameters included in a project, the report may need editing 
(formatting of paragraphs etc).
 

 Since the report is in a word document, the user may alter it according to their preference.
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18 Definitions and Terminology

Atmospheric Absorption
          The process whereby some or all  of  the energy of  sound waves is transferred into the
atmosphere.

A-Weighting
A frequency weighting that relates to the response of the human ear.

Aw
Weighted sound absorption coefficient, calculated according ISO 11654.

Background Noise Level

Any sound level or pressure level at a reference or receiver’s position, without the source

sound of interest being monitored.

C, Ctr
Spectrum adaptation terms when using A-weighted pink noise and A-weighted traffic
noise, respectively. These values are calculated according to ISO 717-1.

Centre time, Ts
Is the time of the centre of gravity of the squared impulse response, can be measured in
seconds. Ts, avoids the discrete division of the impulse response into early and late

periods.

Configuration
A set up of noise sources, receivers, barriers, ground and walls.

 
Critical Frequency

The frequency in which a plate starts radiating sound efficiently.  In a transmission loss
curve is represented as a damping controlled dip in mid high frequencies. 

CSV
Comma Separated Values, a file format used to store data in which numbers and text
are stored in plain textual form that can be read in a text editor.

C50 & C80
Balance between early and late arriving energy, C50 & C80: While there are several
parameters that can be used in this group, one of the simplest is an early-to-late arriving
sound energy ratio. This can be calculated for either a 50 ms or a 80 ms early time limit
depending on whether the results are intended to relate to conditions for speech or
music respectively. 

D50
It is also possible to measure an early to total sound energy ratio. For example, D50
(“Definition” or “Deutlichkeit”) is sometimes used for speech conditions. This is exactly
related to C50, by the following relationship:
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Decay curve 
Decay of sound pressure level as a function of time at one point of the room after the
source of sound has ceased. Sound decay may be calculated after the actual cut-off,
from the reverse-time integrated squared impulse response of the room.

Diffusion Coefficient

A uniformity measure of the diffusion by a static source, calculated according to

17497-2. In the mentioned standard is referred as directional diffusion coefficient

EDT (s)
Both the early decay time, EDT, and the conventional reverberation time, T, should be
measured from the slope of the octave band integrated impulse response curves. The
slope of the decay curve should be determined from the slope of the best fit linear
regression line to the appropriate portion of the decay curve. The EDT should be
obtained from the initial 10 dB of the decay and T is normally obtained from the portion
of the decay curve between -5 dB and -35 dB below the maximum initial level (or -5 dB
and -25 dB). The decay times are to be calculated from these slopes as the time
required to decay 60 dB. Both the EDT and T should be calculated. EDT is
subjectively more important and related to perceived reverberance, while T is related
to the physical properties of the auditorium.(See also Reverberation Time)

Eyring Equation

dB (A)
The A-weighted sound pressure level.

Diffraction
The  process  whereby  an  acoustic  wave  is  disturbed  and  its  energy  redistributed  in
space as a result of an obstacle in its path.

Direct Sound
Sound that reaches a given location by direct, straight-line propagation from the sound
source.

EA, Excess Attenuation
Reflections  and  diffractions  from  terrain  (ground  and  objects)  have  great  influence  on
the  frequency  spectrum  of  the  transfer  function  from  source  to  receiver.  The
interference between direct transmission and terrain reflections and diffractions causes
the frequency spectrum to change strongly with the finite impedance of terrain surfaces
as well as the geometry between source and receiver.
Therefore, EA is the propagation effect of terrain (ground and walls) WITHOUT Barrier
compared to the propagation of sound in free field (direct sound only).
It is given by

EA = 10 log [abs(ptotal without barrier/pdirect)
2]

Excess Noise Level
The level exceeding Noise Criteria. 

Free Field Conditions
An environment where there is only direct sound.
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Ground Impedance
At a specified frequency, complex quotient of sound pressure by the normal component
of  particle  velocity directed  into  the  surface of  the  ground.  Unit,  pascal  per  (meter  per
second) [Pa/(m/s)].

IL, Insertion Loss
This is the effect of a sound barrier between source and receiver including the effect of
its environment, the terrain, compared to the propagation of sound over the same terrain
without the barrier.
IL is the propagation effect of the Barrier compared to the propagation of sound over the
terrain without barrier.
It is given by

IL = 10 log [abs(ptotal with barrier/ptotal without barrier)
2]

or simply put, the acoustical level difference before and after the installation of a barrier
provided that sound source, terrain and atmospheric conditions are the same.

Integrated impulse response method
Method of obtaining decay curves by reverse-time integration of the squared impulse
responses. This the so called Schroeder method after Manfred Schroeder who first
described it.

Impulse response
Plot as a function of time of the sound pressure received in a room as a result of
excitation of the room by a Dirac delta function.

Level After
Conditions  or  measurements  at  a  site  of  interest  where  an  outdoor  noise  barrier  is  in
place.

Level Before
Conditions,  measurements,  or  predictions  at  a  site  before  installation  of  an  outdoor
noise barrier.

NRC
The Noise Reduction Coefficient (NRC) is the amount of absorbed sound energy of a

surface. A NRC represents total reflection and a NRC of 1 represents total absorption. 

Octave
The range between two frequencies whose ratio is 2:1.

Outdoor Noise Barrier
Structure, or structures together with other material, that potentially alter  the acoustical
level at a site from a BEFORE condition to an AFTER condition.

Reflection
Redirection of sound waves.

Refraction
Change in direction of sound waves caused by changes in the sound wave velocity.

Reverberation Time
Reverberation Time, T: Time, expressed in seconds, that would be required for the
sound pressure level to decrease by 60 dB, at a rate of decay given by the linear least-
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squares regression of the measured decay curve from a level 5 dB below the initial level
to 35 dB below.
NOTE 4 Where a decay curve is not monotonic the range to be evaluated is defined by
the times at which the decay curve first reaches 5 dB and 35 dB below the initial level
respectively. A value for T based on the decay rate over a smaller dynamic range (down
to a minimum of 20 dB extending from 5 dB down to 25 dB down) is also allowable
provided the results are appropriately labelled. In the case of ambiguity the measure for
T using the decay between 5 dB and 35 dB should be called T30. Using 5 dB and 25

dB, the result should be labelled T20 and similarly for other evaluation ranges.

EDT (Early Decay Time)
Decay from 0 to – 10 dB. The EDT is a reverberation time derived from the initial 10 dB of
decay.  It  is  the  length  of  time  that  it  takes  for  the  sound  to  decay  10  dB  after  the  sound
source has been switched off. 

T20 (s)
Decay from -5 to -25 dB

T30 (s)
Decay from -5 to -35 dB

T60 (s)
Decay over 60 dB

Rw
Weighted sound reduction index, calculated according ISO 717-1

Sabine Equation
RT = 0.16 V / A 

Sound Power Level, Lw
Sound power measured on a decibel scale.

Sound Pressure Level, Lp
Sound pressure measured on a decibel scale.

Sound strength G
The  sound  strength  G  can  be  measured  using  a  calibrated  omni-directional  sound
source, as the logarithmic ratio of the sound pressure exposure (squared and integrated
sound pressure) of the measured impulse response to that of the response measured at
a distance of 10 m from the same sound source in a free field.

Source Sound Level
Sound level, sound exposure level, or sound pressure level determined at a reference or
receiver position with the sound source operating. Unit, decibel (dB).

Spectrum
A  quantity  expressed  as  a  function  of  frequency,  such  as  sound  pressure  versus
frequency.

Speech Transmission Index (STI)
Speech  Transmission  Index  (STI)  is  a  measure  of  speech  transmission  quality.  This

quantity  is  measured  by  using  special  modulated  noise  signals  which  are  not  covered  by  the  impulse
response methods.
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Stud
Structural connection element between two layers, used for support. 
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19 Keyboard Shortcut Keys

SHORT CUT FUNCTION
  

G Move Editing Plane to Planar Surface

N Show/Hide Normals

Mouse scroll Zoom in / Zoom out

CTRL +

Selects Multiple Entities

A Select All

N Opens New Blank Project

I Import Curve

P Print Report

S Save

D Directivity

Alt + Del End Task

F Zoom Fit (in Geometry Viewport)

O Open Project

Z Undo

Y Redo

Mouse scroll pressed down continuously Pan

Arrow Keys Pan

+/- Zoom in / Zoom out

CTRL + SHIFT +

I Import image

X Close

CTRL + ALT + - for Box Selection Tool 
V Selects only Visible Entities

A Selects All Entities

E Selects All Enclosed Entities

SHIFT + 
Mouse scroll Zoom in / Zoom out

Shift whilst moving, creating, resizing
objects

Moves, draws, resizes along the axis in a
straight line.
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Function Keys

F1 Help

F2 Front/Rear View

F3 Right/Left View

F4 Top/Bottom View

F5 Isometric View

F9 Run Precise Calculations

F10 Run Indicative Calculations

Esc Cancel

Left, Right, Up & Down Arrows Moves the selected entity i.e. barrier, or
receiver, or Noise source in relevant direction

Page Up Move selected entities to the positive Z
direction

Page Down Move the selected entities to the negative Z
direction

Del Delete selected entity

Insert Inserts additional Noise Source

X Changes the editing plane to XY

Y Changes the editing plane to YZ

Z Changes the editing plane to ZX

M Move selected entity

+/- Moves Grid up and down
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20 FAQ
In order to get a better understanding on how to use Olive Tree Lab, we recommend reading the
Help Files. Below are some questions we have been asked and which we have shared with you. If
you have a question which is not answered, please do send us an email and we will be glad to
assist.

20.1 Installation and activation

Installing Olive Tree Lab-Suite (OTL-Suite)

For the trial version (valid for 14 days), download Olive Tree Lab-Suite and run the setup

file. In order to access the OTL-Suite trial, you will need an internet connection. You will

then need to contact us to request a trial key to activate your trial.

For purchased licenses, once payment is made, you will automatically receive you

activation key to activate your license.

Can I transfer my license from PC to PC?

Your license can be transferred to another PC by clearing your license from one PC and

activating the same license on another. To clear your license, please go to Help>clear

license.

What happens if I lose my license key?

For electronic activation, contact us to re-send you license key or to deactivate it in the

case your PC is lost or stolen and issue you with a new one.

My license key doesn’t activate.

Try  launching  OTL-Suite  as  an  administrator  (Right-click  and  select  ‘Run  as

administrator’).

OTL-Suite text and windows are too small on my display.

Some high resolution displays don't show OTL-Suite windows due to Windows updates.

We have resolved this issue, however, if you are still faced with this problem, you can

either set the font to 100% in the screen configuration, or if you are advanced in some

https://www.mediterraneanacoustics.com/downloads.html
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coding yourself, you can try changing the manifest file as one of our clients did, and for

which he has been kind enough to share with us. Download OTL manifest file.

There  is  a  note  at  the  top  that  says  your  graphics  card

does  not  support  customizable  legends.   Is  there  a  way

to change settings to allow this?

Unfortunately there is nothing that can be done, this feature depends on the graphics card

on your PC, a Graphics Card with Direct X 10 and above is recommended.

I can’t find installation files for previous versions of OTL-

Suite

Setup files are available on our website for the latest version of OTL-Suite. If you need to

re-install a previous version, please contact us and we'll send you the relevant setup files

directly.

What happened to the 12-month PhD/Masters free

license offer?

Unfortunately, it has come to our attention that on many occasions the license was used

for commercial use, and we have had to withdraw this offer.

20.2 Updates

Automatic updates

When an update is released, OTL-Suite will automatically update when the ‘Automatically

Check For Updates’ option from the ‘Updates’ menu in OTL-Suite is enabled.

https://www.mediterraneanacoustics.com/uploads/7/3/3/2/73322645/otl.exe.manifest
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Updating issues for OTL-Suite version 3.x

Some users using OTL-Suite version 3.0 may face an issue with a recent update of

version 4.0. OTL-Suite may try to update itself even though no update has been released

for version 3.0. This can cause the software to crash and then unable to re-launch. We

highly recommend that you please disable the ‘Automatically Check For Updates’ option

from the ‘Updates’ menu in OTL-Suite.

If your software tried to update and you are faced with issues running OTL-Suite, uninstall

and reinstall OTL-Suite v3. If you do not have the setup file for the last version (3.5.1)

available please contact us in order to send it to you.

20.3 Modeling

How do I create a model in Olive Tree Lab-Suite?

OTL-Suite provides some CAD tools to assist you in modeling. The tools are found in the

‘CAD Tools’ window. Alternatively you can also import a DXF/DWG file directly into OTL-

Suite making sure your model is exploded first before importing.
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How do I import a 3D CAD model?

To import a 3D CAD model use one of these methods:

File >Import> import DXF/DWG

Dxf button from the tool bar found on the left hand side of the geometry viewer.
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If the .dxf file also includes surfaces it is best select the ‘Optimised’ option in the ‘DXF

Import Settings’ window. If the original file has too many surfaces it is best to import the

lines only and create the surfaces in OTL-Suite. You will also need to ensure that you are

selecting the correct units that correspond to the units of your original CAD model.

Make sure that your all surfaces have been exploded in your original DXF/DWG file. 

When importing a .dxf file is it better to import the faces
or the lines? Why is it that when I import faces the
surfaces are split?

A: When you import a DXF/DWG model with surfaces, it’s best to choose Optimised, this
will reduce the number of triangulations in OTL-Suite. For surfaces which are still too
many, then it’s best to create the Walls in OTL-Suite directly. Also please make sure that if
the model you are importing is in mm for example, to select mm when importing in order
to maintain the scale:
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Simple Method
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Optimised method

Is there a limit to the number of surfaces OTL-Suite can
handle?

OTL-Suite deliberately has a limit to the number of entities imported, being 30,000 in order

to minimise calculation time.

There are some cases where models have over 30,000 entities, and fail to import. In order

to reduce the number of surfaces, the first step is to export the model (say from sketch up)

without lines, I.e. Only faces.

Due to the precise nature of the calculations, in practice any model in OTL-Suite should be

much smaller  in  order  to  calculate  efficiently.  An effort  should  be  made  to  constrain  the

size to a maximum of 300-500 surfaces. Here is a list of methods that can be done to limit

the size of a model:

Make any surfaces that are not acoustically significant inactive. The surface that is

inactive  will  still  be  present  in  the  viewport  for  illustrative  purposes  but  will  not  be
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taken into account in the calculations.

Make sure that non-rectangular surfaces are optimized. If the two coplanar surfaces

were  created  separately  it  is  best  to  redo  them  again  as  one  surface  using  the

‘create surface on existing points’ tool from the ‘CAD Tools’ window.

I imported a model based on GIS coordinates and I get

an error when running calculations. What could be

causing the error?

IF importing a model from GIS coordinates the coordinate values could be extremely high.

Therefore, the model should be sent close to the origin by right clicking any selected

object and clicking the ‘send to origin’ option. This will shift the entire model to the origin.

How do I ensure that my room normals are pointing the

correct way?

In order to see the normals of a surface, select the "show/hide normals" tool from the "cad

tools" window or press n on your keyboard for shortcut, where the reflected sides will be

displayed as opaque and the non-reflective sides will be displayed as transparent. Double

sided surfaces are shown as opaque.

?The normals are also indicated as cones. For room acoustics and open-plan office

calculations, use the "auto correct normals"  from the "cad tools" window and ensure that

the normals are pointing inside the room prior to calculations.
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Show/Hide Normals displays which side of the surface is active

"Auto Correct Normals" attempts to correct the direction of the normals of all surfaces



287FAQ

Copyright © 2018  P.E. Mediterranean Acoustics Research & Development Ltd. All Rights Reserved.

"Make all Walls Double sided" makes both sides of all surfaces active

For outdoor calculations, users can calculate without using the normals. Should you wish

to calculate using the surface normals, ensure you select the use surface normals in the

‘Calc Options’ side panel
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Can I import images in OTL-Suite?

Yes, users can import google earth images or any other 2d image in order to assist in the

modelling of the project.

If importing from google earth, in order to ensure that the scale is the same, measure the

distance between source and receiver using google earth’s ruler tool. Then measure the

distance of the area horizontally and vertically and import the image using the same

dimensions.

Is OTL-Suite capable of adding line sources?

Yes, OTL can draw line sources. To draw a line source, click on line source icon, click on

point where you would like your line source to start from, draw a line and click on the point

where you would like your line source to end. You will be asked to enter a separation

distance between sources or angle between 2 consecutive sources and a receiver (in

case you have already placed a receiver) and specify the line-source heights (beginning

and end). See section Inserting Noise Sources.

Line sources are grouped and are edited collectively. To split your line source into

individual sources, select the line source, right click with your mouse and select the

‘Convert Line Source to Individual Sources’ option from the right-click menu. Please note

that once converted, you can not change the individual sources into a line source, you

would need to redraw it.

Is OTL-Suite capable of adding line receivers?

Yes, ?inserting a line of receivers  works the same way as line source, with the exception

that receivers are not grouped as one entity. To select multiple receivers, you still need to

select them all either from the object tree or from the viewport using Ctrl/Shift and click

with your mouse. You can then change their properties collectively. See section Insert

Receivers

Is it possible to insert a planar noise source?
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It is not possible to insert a planar noise source in OTL-Suite, however if you place

multiple line sources at a fixed distance from each other and set the 'source contribution'

option to 'coherent' in the ‘Calc Options’>’Calculations’ side panel then the sources will act

as a planar noise source. The source spectrum of the individual line sources will also need

to be reduced so that when combined they are equivalent to the level of the planar noise

source.

What’s the difference between walls and barriers?

Barriers have different calculation results, in that they take into effect calculations before

and after the insertion of a barrier. Whereas if you wanted to see result before and after a

remedial wall, you would need to specify that wall as remedial in the walls property panel

found in the right hand side of the geometry viewer.

Walls are disregarded in indicative (estimated) calculations to give faster results. Indicative

calculations take into account sources, receivers, grounds and barriers and disregard all

other entities.

Barriers can also take certain predefined shapes, whose parameters can be controlled in

the ‘Barrier’>’Shape’ side panel, making it easier to perform parametric studies.

What are patches and how do they work?

Patches are used in OTL-Suite to investigate the effect of a remedial surface that will be

added on the walls of a room (such as sound absorbing panels). The way they work is that

when creating a patch on a wall, a hole is created in the wall and the hole is replaced by

two surfaces:

The patch, which can have different acoustical properties and is remedial (therefore

is only taken into account in the ‘After’ calculations)

The wall behind the patch, which has the same acoustical properties as the original

wall, but is only taken into account in the ‘Before’ calculations.

Therefore  you  can  easily  see  the  effect  of  the  absorption  panel  by  comparing  the  EA

before  (which  is  the  calculation  corresponding to  the  wall  behind  the  patch)  with  the  EA

after (which corresponds to the patch being included).
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Should I model absorption panels with a wall or a patch?

Either can be used as OTL-Suite considers patches to be walls. Determining which ones

should  be  used  will  depend  on  the  way the  absorption  panels  are  to  be  installed  in  the

space under study”

If  the  absorption  panels  are  to  be  installed  on  a  wall  of  the  room,  then  it  is

recommended that patches are used to model them. This is because when a patch is

created  on  a  wall  an  additional  surface  behind  the  patch  is  created  (with  the  same

acoustical properties as the original wall) which will not be included in the calculations

that  involve  remedial  surfaces.  Start  by  modelling  your  room  using  walls  and  then

draw your absorption panels on the wall using the “Create Patch” tool from the “CAD

Tools” window.
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Make  sure  you  have  the  “Snap  to  Surface”  option  enabled  or  the  “Snap  to  Grid”  option

from the top toolbar:

If the absorption panel is free standing, then it is best to use a wall to model. You will need

to make the wall a remedial surface by selecting the wall and setting it to be remedial from

the  wall  side  panel.  When  setting  the  free  standing  absorption  panel  to  remedial  OTL-

SUITE  will  again  run  two  calculations  one  excluding  the  remedial  surface  and  one

including it. You will also need to make the wall double sided so that both sides of the wall

are taken into account in the calculations.
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I moved a patch to the wall surface rather that creating
the patch directly on the wall using the ‘Create Patch’
tool and it doesn’t show any attenuation even though the
patch material is more absorptive.

The way patches work  is  that  when you draw a patch on a surface a hole is  created on

that surface which is replaced with the patch (which is  remedial)  and the wall  behind the

patch. 

Thus if you make the patch and the wall behind the patch transparent you will see a hole in

the original surface.
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When  the  remedial  patch  is  accounted  for  in  the  after  calculations  OTL-Suite  knows  to

ignore the wall behind the patch thus avoiding any possible errors due to ambiguity of two

surfaces being on the same plane.

Therefore try drawing the patches on the original wall surfaces again to ensure that a hole

is created on the wall just to make sure that this wasn't causing any problems. Otherwise,

in the remedial calculation the previous reflective wall is also taken into account.

How do I ensure that both sides of the free standing
panel are taken into account for the calculations?

If  both sides of  a surface are exposed to the room, select that surface, right click  and select the

“Make  selected  surface(s)  double  sided”  option.  This  will  create  normal  on  both  sides  of  the

surface.

I have absorption data that has absorption coefficients
greater than 1 due to the back side of the panel being
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exposed to the room as well.

Even when the absorption data for  materials  is  above 1 in  OTL-Suite you should always

set your absorption coefficients to be less than 1.

Is it possible to model diffusers when I begin working on
higher frequencies that need the scattering coefficients
included?

OTL-Suite does not currently calculate the scattering coefficient  but  it  does calculate the

diffusion coefficient  using  the  “Polar  Plotter”  calculation  tool  from  the  “Calculation  Tools”

window. Model your diffuser using the CAD Tools and then follow the instructions on how

to use the Polar Plotter from the “Polar Plots" [link to section here] section of the Help files.
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If I model a panel that is exposed on both sides and
would like to see the absorption of both sides, is there a
minimum distance that I need to space the panel off the
wall to ensure that rays make it to the other side on its
way to the receiver(s)?  Or is there a way I can tell if rays
have reached to the back of the panel?

Regarding a minimum distance of the side panels off  the walls that will  depend on many

factors  including the positions of  the source and receiver.  Most  importantly however  you

would also need a high number of reflection orders (or maximum images to trace for room

acoustics  calculations)  which  will  significantly  slow down  the  calculation  (the  smaller  the

gap between the absorption panel and the wall the higher the orders of reflection needed).

If  you  include  diffraction  in  your  model  and  enable  the  ‘Reflections  Between  Diffraction

Points’  option  from  the  ‘Calc  Options’  side  panel  it  should  be  easier  to  get  paths  to  go

behind the absorption panel.

You  can  tell  if  rays  reached  the  back  of  an  absorption  panel  using  the  ‘Show all  Paths’

calculation  tool  but  this  only  works  for  the  precise  calculation.  However  for  Room

Acoustics  calculations  (using  the  ‘Run  Room  Acoustics  Calculation  Tool’)  the  hybrid  ray

tracing  method  is  partly  stochastic  so  you  can  only see  some  of  the  paths  after  the  full

calculation  is  finished.  Make  sure  you  set  the  ‘Number  of  Top  Strongest  Paths  Per

Receiver’ in the ‘Calc Options’>’Path Detection’>OPO/’Room Acoustics’ side panel:
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Once  the  RA  calculation  is  completed  the  top  strongest  paths  will  be  shown  in  the

viewport. 

Is it possible to change a double sided wall/ surface back
to single sided?

You  cannot  change  a  surface  from  double  sided  to  single.  The  surface  will  have  to  be

remodeled.

How do I select an entity?

There are several ways to select an entity (source, receiver, ground, barrier etc). You can

either click with your left mouse button on an entity once in the viewport to select it, double

click on it to enable the corresponding panel to change its properties, or select it from the

‘Object Tree’ side panel.
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I want to insert a noise barrier as a mitigation measure.
Should I use a typical wall or a barrier?

A  barrier  is  recommended  as  this  will  give  you  the  performance  with  and  without  the

barrier, I.e. The effect of having a barrier, or not. Also changing the properties and shapes

of barriers are easier. If  you need a barrier  which is  irregular shaped, then create it  as a

wall, and select "is remedial" from the wall panel to get before and after.

When running Indicative Calculations you must use a barrier as walls are not included in

Indicative calculations.

How can I delete an entity from the object tree?

Select the object you wish to delete from the object tree, then click on the grey bar at the

top of the geometry viewer to activate that window, and press delete:

How do I deactivate an object, such as a wall, barrier,
ground, source or receiver?

To deactivate an object, you need to make sure the inactive check box is unchecked in the

relevant object’s side panel. Disabling it from the object tree only removes it’s visual

representation from the model, but does not make it inactive:
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When I measure the distance from a receiver to a
surface, with snap to surface off and grid off options,
how can I ensure that the initial point is the receiver and
not on the other point in the atmosphere or elsewhere?

It will snap at the point you click to start from, so if it sees the receiver, it will snap to the

receiver. You will also see the red line which shows clearly where the measurement starts

from. It's best not to have the snap to grid and surface on, as then it will look for a point

either on the grid or surface.

How do I organise my model?

OTL-Suite provides an ‘Object Tree’ side panel. The object tree outlines all the entities

available in your configuration. Once you click on an entity in the object tree the

corresponding entity will be highlighted in the geometry viewport for easy identification.

You can choose to view entities by various categories:

Group; grouped entities, i.e. If you have grouped some entities such as walls, or

sources, or receivers, etc.
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?entity; displays all the entities according to their selections, i.e. Sources, receivers,

grounds, walls

Type; displays the type of material assigned for grounds, walls and barriers and

source spectrum and receiver criteria for sources and receivers

State; displays whether the entity is active or inactive in the calculations

Remedial; displays whether walls and barriers are remedial or non-remedial

Colour; displays the entities according to the colours assigned to them

Transparency; displays whether an entity is transparent or not.

Is OTL-Suite-Suite able to model the directivity of
sources for loudspeakers?

OTL-Suite is able to import .cf2 files of loudspeakers and includes the directivity data in the

calculations. To import a .clf file create a new source in the source database (either the

local or project) and select the ‘CLF File’ option in the ‘New Source’ window. Then click the

‘Select Directivity File’ button to find the desired .clf file in the directory. Loudspeaker

directivities are also available at www.clfgroup.org. Please note we do not offer support

for third party software.

An example of a source with directivity (.clf file) is shown below:

http://www.clfgroup.org/
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Any other source that is not imported as a .clf file is assumed to be omnidirectional.

How can I create our own .clf directivity files?

We suggest contacting the CLF group on how to author your own .clf  files as we are not

involved in authoring .clf files. Below is the relevant link of their website:

http://www.clfgroup.org/author.htm

How do I include the background noise levels in my

http://www.clfgroup.org/author.htm
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calculations? Can I import a measured background noise
level?

The background noise level of your model can be set in the receiver criteria. You can

either specify an NR rating available in the database, or you can import a custom spectrum

by creating a new criteria in the database (either the local or project database) and clicking

either ‘Import From File’ to import a .csv file with the background noise levels or ‘Import

From Clipboard’ to import them from the clipboard. 

Note that the table being imported needs to consist of two columns, the first with the

frequencies and the second with the background noise levels.
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When I want to move an object, the grabbing point is
always the center point of gravity. Is it possible to
change this?

Unfortunately, there is no way to change the grabbing point when moving an object using

the 'Move Selected Objects'  tool  from  the  'CAD Tools'  window or  the  'M'  key shortcut.  If

you would like a more precise way of moving objects you can use the arrow key shortcuts

which  allow you to  directly type in  the  distance you want  to  move  the  object  along  each

axis:

1. Select the object or objects you want to move.

2.  Press  the  either  the  'Up'/'Down'  key to  move  in  the  positive/negative  y-axis  direction,

'Right'/'Left'  key to move in  the  positive/negative  x-axis  direction  or  the  'PgUp'/'PgDn'

key to move in the positive/negative z-axis direction.

3. Type in the distance (in m) you want to move your object in the selected axis and press

'Enter'.

Alternatively,  you  could  also  use  the  controls  in  the  'Move'  tab  of  the  'Move/Rotate

Selection' tool in the 'CAD Tools' window.
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How do I model trees in OTL-Suite?

The best way to model  trees is simply as vertical columns (where only the main trunk is modeled)

created with the ‘Create Cylinder’ tool from the ‘Cad Tools’ window. The columns should be at

least six sided.
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If the hexagonal column created with the ‘Create Cylinder’ tool is too wide then follow this

procedure to make them thinner:

1. First delete all the surfaces except for the base of the column. You will need to separate

the surfaces of the column to multiple objects before deleting them by selecting the

column, right-clicking and selecting the ‘Separate Wall to Multiple Objects’ option from the

right-click menu.

2. Select the base (if it has been split into multiple surfaces after separating the column in

Step 1, you will need to merge the different pieces again by selecting them all, right

clicking in the viewport and selecting the ‘Merge Walls to One Objects’ optiom) and scale it

down to the desired width using the ‘Scale Object’ tool from the ‘CAD Tools’ window. You

can find more information on how the ‘Scale Object’ tool works in the ‘Using CAD Tools’

section of the help files.
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3. Once the base of the column has been scaled down to the desired width, extrude it to the

desired height using the ‘Extrude’ tool from the ‘CAD Tools’ window.
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Alternatively, it might be easier to create the columns in a CAD program like SketchUp and

import them as a DWG/DXF file.

I am using a line source in my model to represent traffic
noise. What should the spacing between the individual
sources be?

When using a line source to represent traffic, the spacing between the individual sources

should depend on the how busy the road is. The busier the road, the shorter the spacing

between the individual sources should be and vice-versa.
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One good way to do this is to base the source separation on the representative distance

between cars in the google maps satellite image of the location you are modelling. Please

bear in mind that too many sources will also have an effect on calculation time.

What is the difference between walls and grounds?

The difference between walls and ground is that grounds do not diffract sound paths from

their edges whereas walls do. Also grounds cannot be made remedial, while walls are not

included in indicative calculations.

20.4 Database

What is the difference between the ‘local’ and ‘project’
database?

Entries created in a local database are available to all projects in OTL-Suite, while entries

created in a project database are only available in the project they were created in. To

merge them, please refer to Section Database

20.5 Calculations

What is OTL-Suite’s general approach in calculating
sound propagation?

Olive tree lab-suite is based on PEMARD’s methodology for calculating sound

propagation. PEMARD’s methodology of calculating sound propagation is focused on

preserving the wave based nature of sound and uses simplifications only wherever there is

no practical alternative. For this reason, we always aim to use the latest and most accurate
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calculation models for our calculations, based on peer reviewed scientific publications.

Extended material regarding the accuracy on our calculations can be found in

our published papers.

How does OTL-Suite calculate path detection?

Image source algorithm

OTL-Suite uses an optimized image source algorithm for the detection of valid sound

paths based on Mechel’s improvements (Room Acoustical Fields, Mechel, 2013) together

with some in-house optimizations that result to a very fast and accurate detection of sound

reflection paths.

Hybrid tracing algorithm

For the purpose of calculating room acoustics parameters, we use a hybrid ray tracing

algorithm, similar to the one proposed by Vorlander (Simulation of the transient and

steady-state sound propagation in rooms using a new combined ray-tracing/image-source

algorithm, Vorlander,1989) together with some in-house optimisations.

What is OTL-Suite’s diffraction detection algorithm?
We use an in-house developed algorithm for the detection of sound diffractions between
any edge combination using the Broyden–Fletcher–Goldfarb–Shanno (BFGS) optimization
algorithm, based on the work of Min and Qiu, and Hadden and Pierce

 http://scitation.aip.org/content/asa/journal/jasa/126/1/10.1121/1.3147491

 http://scitation.aip.org/content/asa/journal/jasa/69/5/10.1121/1.385809

 and Erik Salomons:

 http://www.ingentaconnect.com/contentone/dav/aaua/1997/00000083/00000003/art00008

Sound diffraction detection is based on a proprietary algorithm that detects the path with
the shortest time of flight between a source and receiver.

What are reflected diffracted paths/reflections between
diffractions points?

OTL-Suite detects, additionally to sound reflections and sound diffractions, paths that

include both diffractions and reflections. These sound paths are important contributions to

the sound field, especially in cases where a small number of wave fronts arrive at the

https://www.mediterraneanacoustics.com/papers--presentations.html
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receiver, like in outdoor sound barrier cases.

How does OTL-Suite calculate sound paths?

For the calculation of the sound paths and the final frequency response estimation, OTL-

Suite uses a number of calculation methods to calculate the different effects on sound.

You can read more in Section Theoretical Background

How is sound attenuation taken into account in OTL-
Suite?

Currently all sound sources in OTL-Suite are considered to be point sources which emit

spherical sound waves. Even OTL-Suite’s line sources are composed by a number of

point sources. Theoretically, all other types of sound sources can be reproduced by using

point sources. Therefore, sound pressure attenuation is based on the spherical wave

attenuation.

How does OTL-Suite calculate sound reflections from
surfaces?

There are two ways to calculate the effect of a sound reflection on a sound wave in OTL-

Suite. These are a) by calculating a material’s impedance and using it for the calculation of

the material’s reflection coefficient and b) by using measured data like absorption

coefficients. OTL-Suite supports both ways of calculation.

Sound reflections based on materials impedance

Calculating the reflection coefficient based on the material’s parameters is the most close

to reality method for calculating the effect of sound reflections. The main reason for this is

that the angle of incidence is taken into account. OTL-Suite includes calculations of

material impedance for both semi-infinite materials as well as multi-layered structures.

Impedance from multilayered structures is calculated using Vigran’s model. OTL-Suite

also supports two models of sound impedance calculations 1) Delany-Bazley’s 1-

parameter model (Acoustical properties of fibrous absorbent materials, Delany and Bazley,

1970) 2) Allard’s 6-parameter model.
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Sound reflections based on absorption coefficients

Despite the fact that calculating the sound reflection coefficient from the impedance

material is the most accurate way to calculate the effects of sound reflections,

unfortunately material parameters are not widely available. On the other hand, measured

absorption coefficients for different materials are much easier to find.

I want to define the absorption coefficient of a surface. I
know the normal-incidence absorption coefficient, is this
the correct input needed for OTL-Suite?

Regarding  using  absorption  coefficients  in  OTL-Suite,  only  statistical  absorption

coefficients  can  be  assigned  to  a  surface.  Therefore  if  only  the  normal-incidence

absorption coefficients are available they will need to be converted to statistical absorption

coefficients  as  OTL-Suite  does  not  have  the  means  to  calculate  statistical  absorption

coefficients  from  normal-incidence  absorption  coefficients.  However  there  are  various

methods  for  deriving  the  statistical  absorption  coefficients  from  a  normal  incidence

absorption coefficient.

Does OTL-Suite use a diffuse reflection coefficient or
angle dependend?

Since OTL-Suite uses statistical absorption coefficients, then calculations will not take into

account  the  angle  of  incidence  of  a  path.  If  the  calculations  are  outdoors  then  we

recommend that  impedances  are  assigned  to  the  material,  as  impedances  will  take  into

account  the  angle  of  incidence  of  the  paths  and  are  the  correct  method  for  outdoor

calculations.  Perhaps  you  could  look  through  the  Material  Properties  database  to  find  a

material  whose  absorption  coefficients  are  close  to  the  absorption  coefficients  that  you

have available.

Can OTL-Suite calculate sound diffractions from edges?

Olive tree lab can calculate sound diffraction coefficients over multiple edges.

Does OTL-Suite support sound path summation?
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Olive tree lab supports two types of sound path summation, coherent summation and

incoherent summation.

What are indicative calculations?

Indicative calculations are faster calculations which ?run calculations in 1/3 Octave centre

frequencies only, omitting any wall entities in the calculations, displaying results in 1/1

octave bands in the indicative graph (located in the results graph tab on the right hand side

of the geometry viewport) after being appropriately processed.

What are precise calculations?

Precise calculation results are displayed in high frequency resolution in the output window

as well as in precise graph (shown in the results graph panel on the right of the geometry

viewport). ?Also shown in 1/3rd and 1/1 octave bands after being appropriately processed

from high frequency resolution results.

Which standards are applied in OTL-Suite?
For Outdoor Sound Propagation, OTL-Suite includes ISO 9613-2. Users can run ISO

calculations as well as PEMARD’s advanced calculation methods. 

For Room Acoustics, ISO 3382 Parts 1 & 2.

For Open-Plan Office, ISO 3382 Part 3.

?OTL-Suite precise calculations run PEMARD’s algorithm based on a hybrid tracing

approach and applies to both room acoustics and open-plan office calculations. 

What is the recommended calculation setting for running
room acoustics calculations?

The user can choose between an automatic termination of the ray tracing process or a

manual setting of the maximum images to be traced. If the automatic termination is

chosen, the algorithm will try to detect when the correct result has been reached. If the

automatic termination is disabled, the algorithm will terminate at the set maximum images

to trace, with the principle being the more images traced, the closest the calculation
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should be to the actual result. Setting the Hybrid Ray Tracing Method to 50000-100000

images to trace should be enough for many cases although this is strongly dependent on

the geometry of the room. It is best to start with a low value and gradually increase it until

the results are converged.

If you want quick calculations which apply in the entire room volume (i.e. no need for

mapping) use the Sabine/Eyring statistical models by pressing Ctrl+A in the geometry

viewport and clicking the 'Update Graph' in the 'Room' side panel to see the RT levels (if

you have any disabled or transparent walls in the Geometry, make sure you also select

them from the Object Tree). In the same side panel you can also see graphs of the

'Average Abs. Coeff' of the room and the 'Material Abs. Area'. 

The next quickest method to extract the results in a table form is too is to go to the Path

Detection>OPO\Room Acoustics tab in the 'Calc Options' side panel, and then set the

'Maximum Images to Trace' field to 1 and 'Number of Top Strongest Paths Pr Receiver' to

0 (as shown in the screenshot below). Run Precise Room Acoustics calculation, and you

can then get the Sabine/Eyring results in table form in the 'Output Window' which apply

again in the entire room.
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Can I calculate an impulse response?
Yes, in order to calculate impulse response, run impulse response calculations, found in

the calculations menu. Results are shown in the output window, under the Time Domain

tab.

You must set the scale to default in order to properly view the curve. To do so, right click

on the graph area, right click and select "set scale to default". Results can also be viewed

in db.

Can I auralise in OTL-Suite?
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Yes, auralisation allows the user to take a calculated impulse response and use it to

convolute either one of the built-in default sounds in OTL-Suite or an imported .wav file

(provided the .wav file has a 44.1 khz sampling rate and a 16 bit depth).

OTL-Suite also implements the Head Related Transfer Function (HRTF). This response

will characterize how the human ear itself receives the sound from a point source. An

impulse response for both left and right is calculated enabling binaural auralisation when

the final stereo signal is heard through headphones.

What is the difference between the ‘Impulse Response
Calculations’ and the ‘Auralisation’ calculation?

The  difference  between  the  'Impulse  Response  Calculation'  and  the  'Auralisation

Calculation'  is  in  the  frequency  resolution.  The  'Impulse  Response  Calculation'  is  about

half the resolution of the 'Auralisation Calculation' which has a CD quality resolution. The

'Impulse Response Calculation'  is  significantly faster however it  needs to be interpolated

up to a CD quality in order to be auralised. Therefore the 'Auralisation calculation' is more

accurate but takes longer to calculate.

Also, the HRTF is not calculated with the Impulse Response tool.

Can I create a .wav file of an Impulse Response without
convolving it?

In order to convert the Impulse Response to .wav file you will to export the Impulse data

as a .csv file so that it can be used by a third-party solution to map the impulse response

data points to the .wav file format.
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Can I plot a 3d noise map?

Yes, mapping allows the user to plot the level distribution over an area and view mapping

in 2d or 3d. Mapping is calculated with a resolution of 1/12 octave band centre frequencies

and shows calculation results in 1/3 octave bands between 25 and 10000hz over an area

of receivers at a density specified by the user. 

For outdoors, results show IL, EA before and after, Lp Before and After, Lp After ISO

broadband or in 1/3 octave band resolution. For Room Acoustics results show

Reverberation Time and T30 and Open Plan Office results show STI.

How can I tell what the exact dB values of the Sound
Pressure Level are on a mapping plot?

To get the exact values of  the mapping area, hover your mouse over a receiver  point  in

the mapping area and double click. A label will appear with the exact dB value (or dB(A) if

you have the 'Total/Average Spectrum' selected in the 'Frequency' drop-down menu in the

'Mapping' tab). When you hover over a receiver point in the mapping area, a red point will

appear indicating that you can double click as shown in the screenshot below.
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You  can  edit  label  sizes  to  increase  or  decrease  fonts,  and  you  can  remove  the  labels

using the eraser icon at the top.

If you are having trouble finding the receiver points you can switch to wireframe mode from the

'Render  Modes'  drop-down  menu  (at  the  top  centre  of  the  'Mapping'  window  toolbar).  The

receiver points are located at the vertices of the triangles.

You can also export  all  the values to the clipboard using the ‘Export  to  Clipboard button’   to
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further process in a third party program such as Excel.

Experiencing rendering issues in mapping?

OTL-Suite requires a reasonably good graphics card, especially in relation to mapping in

order to achieve excellent 3d rendering.

OTL-Suite users who only have an on-board graphics card, may sometimes experience

rendering issues while viewing mapping plots.

OTL-Suite’s calculations will not start or if they do they
are very slow.

If the calculations in OTL-Suite are very slow or won’t start, the first thing to try to do is to

reduce the number of surfaces in the model (see the ‘How big can a model be in OTL-

Suite?’ question in the FAQ). Also reduce the number of reflection/diffraction orders in the

‘Calc Options’ side panel. Start with only 1 order of reflection to see whether the

calculation is able to complete and then gradually increase the orders until the calculation

time seems manageable. It is best to start with simple settings and then gradually increase

the complexity iteratively.

If there are still issues with the calculation time (or the calculations not starting) then

contact us on support@pemard.com. 

Do lines play any role in calculations?

Lines (as well as points) have no contribution to the calculations of OTL-Suite and are only

included to aid in the construction of the 3d model, or for illustrative purposes.

If I want to calculate the sound level on a façade, how far
should I place a receiver from a façade?

It is best to place the receiver close to the façade, 0.1m should work well.

What is the ‘Maximum Path Length’ setting in the ‘Calc
Options’ side panel?

mailto:support@pemard.com
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The ‘Maximum Path Length’ sets the maximum length of the paths that will be taken into

account in the calculations. Any path with a length greater than the maximum path length

will not be included in the calculations.

I made a mapping calculation but there are gaps in the
calculated area I set up.

Most likely this is because no paths were found at the mapping points which are missing.

To check add a receiver in one of those missing areas and run the ‘Show all paths’ tool,

you can then adjust with the calculation options or geometry until you can find paths at that

point.  You  may  need  to  increase  the  order  of  diffractions/reflections  in  the  calculation

options and possibly reflections between diffraction points.

Does Sound Level Mapping calculation take into account
directivity of the sources?

Source directivity ought to be taken into account in the mapping calculations provided

OTL-Suite has the directivity information, something we cannot be sure of since we cannot

find the .clf file in the project. We recommend you try a mapping with one of the .clf files

included in OTL-Suite.

I plan on calculating the modes of a room first (mapping)
and locating pressure maxima to determine where bass
traps would be most effective.  Is OTL-Suite sensitive to
the location of the panels and do you feel that it would
help with this endeavor?

Yes, that would be an effective way to do it. OTL will consider the locations of the panels

so long as a sound path interacts with those panels.

Do incoherent sources alter the phase of the sources
relative to each other and is there a way to adjust the
amount of phase shift?
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All sources in OTL-Suite start with the same phase (at zero) and that phase cannot be

changed. Incoherent sources have their absolute value summed up so any phase

interference phenomena between different sources is not taken into account. If you set the

sources to being coherent the phase interference phenomena is taken into account (you

can set whether the sources are coherent/incoherent in the ‘Calculations’ tab of the ‘Calc

Options’ side panel). You can find more information in the 'Theoretical Background' section

of the help files.

What are the differences between the ‘3D model’,
‘Barriers’ and ‘Walls’ diffraction order settings in the
‘Calc Options’ side panel.

If your model does not contain any barriers you do not need to worry about the 'barriers'

setting. You should set the '3D model' to be equal to the 'Walls' setting which is the max

diffraction order that you want.

The meaning of the settings are as follows:

3D model

Represents the maximum number of diffraction points allowed for a sound path i.e. If a

sound path has one barrier diffraction and one wall diffraction but the maximum total

model diffractions per path is set to 1 then this path will be rejected from the calculation. 

Barriers

Represents the maximum number of barrier diffraction points allowed for a sound path.

Walls

Represents the maximum number of wall diffraction points allowed for a sound path.

It can be a bit confusing to understand at first so it might be a good idea to set up a simple

model with multiple walls and barriers and to play around with the settings. For example:

If the '3D model', 'Barriers' and 'Walls' are all set to 2 you will find 2 order of diffraction

paths that diffract on walls only, 2 order of diffraction paths that diffract on barriers only but

if a path diffracts from a wall and a barrier the maximum order of diffractions on both the
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walls and the barrier would be 1.

By contrast if the '3D model' is set to 3, 'Barriers' to 1 and 'Walls' to 2 then you would be

able to get a path with a maximum diffraction order of 3 that that diffracts on a barrier only

once and wall twice. You would not be able to get a diffraction order of 3 that diffracts on a

barrier twice and a wall once because of settings that limit those orders in the 'Barriers'

and 'Walls' field. Also the maximum diffraction order of paths that diffract on walls would

be two, and on barriers one.
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If you then changed the '3D model' setting to 4 and kept the other settings the same, you

would not actually get a diffraction order of 4 because the maximum diffraction order on walls

and barriers is limited to 2+1=3.

When making a calculation with a sound speed gradient I
get a warning about multiple grounds. Should I ignore it?

If the model only includes a positive gradient (with no wind) then it can be ignored. If there

is a negative gradient anywhere in the atmosphere then see Refraction

I made a calculation with atmospheric refraction and I am
getting extremely high sound levels (such as 200 dB).

An issue with the extremely high sound levels can occur due to a receiver being in the

shadow zone of sound sources. One limitation of the shadow zone is that it assumes a flat

terrain. If multiple terrains are present in the OTL-Suite model the XY plane at z=0 is used

as the ground for calculations. You can read more about it in the section of the help files in

'Calculations & Calculation options'>'Outdoor Sound Propagation

Calculations'>'Refraction' in the 'Shadow Zone Calculations with a General Terrain' section

at the end of the page.



323FAQ

Copyright © 2018  P.E. Mediterranean Acoustics Research & Development Ltd. All Rights Reserved.

You will need to use the 'generate average ground' tool from the 'cad tools' window which

will replace all your grounds with a single average ground. Please make sure that you

clone your existing configuration and do this in a new configuration so that you do not lose

your original grounds. 

Next some of the walls, sources or receivers may fall above or below the ground. Select

them and readjust their heights so that they are roughly in their original relative heights

above the ground. You can easily do this by selecting them and using the 'PgUp' and

'PgDn' shortcuts to shift them up and down in the z-direction.

Alternatively, if you are looking to investigate worst case scenarios it is probably better to

just reverse the wind direction in the 'meteo' side panel so that the dwelling area is not in

the shadow zone. Downwards refracting paths tend to be much louder than the creeping

wave of the shadow zone calculation.

What is the difference between the ‘Set’ and ‘Calculate’
options for the sound speed gradient section in the
‘Meteo’ side panel?

Set, indicates whether the user will set the sound speed gradient.

Calculate, indicates whether the user will define the necessary parameters to calculate the

sound speed gradient in the ‘Sound Speed Gradient Parameters’. These could be used in

cases where meteorological measurements are available such as Temp at height, Wind

speed, etc...

I made a calculation with multiple sources together and I
would like to see the contribution of each source
individually. Is this possible?

It is not possible to see the contribution of the individual noise sources in OTL-Suite,

however the individual contribution can be exported to a third party software such as Excel

from the Output Window, by right clicking a calculation and selecting ‘Export Transfer

Function Before/After to CSV/Clipboard’. The exported data will be the complex pressure

based transfer function that will need to be converted to decibels.

Can I run multiple Polar Plots with different frequencies?
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You can run multiple polar plot calculations with different frequencies by inserting different

axis in the 'Polar Plot Picker' window using the 'Add' button multiple times:

Once you click 'Add' and the 'Polar Axis Picker' window pops up, you can then click the 'Use

Last Axis' button in the 'Polar Axis Picker' to select the exact same axis each time you add a

new axis:
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For each new axis you can just change the frequency band. You will get a list of the axis that

will be calculated in the 'Polar Plot Picker' window:
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When you click the plot button all the axis in the list will be calculated at the same time. These

will be presented in the Output Window as separate plots:

Is it possible to do batch simulations in OTL-Suite.

It is not possible to do batch simulations in OTL-Suite.

Can I set different simulations so that they run
simultaneously?
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The only way to run multiple simulations at the same time is to open multiple sessions of

OTL-Suite and run each calculation at the same time. The calculations results will need to

be imported from one project to the other in order to be compared.

I changed the material of a barrier and the calculation
results are affected. But I thought that the attenuation
factor due to edge diffractions does not depend on the
surface material?

The reason there is further noise reduction with a more absorptive barrier is due to the

fact that every time you calculate one diffraction path the calculation includes four sub-

paths (not shown anywhere in OTL-Suite) which are shown in Fig 2 in the paper by Allan

Pierce and W. James Hadden (1981 - 'Sound diffraction around screens and wedges for

arbitrary point source locations') whose methodology is applied in OTL-Suite.

In essence and in combination of Fig. 2 there are the following paths, described by Eqs 2

in paper:
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- source to rec

- image source to image receiver

- image source to receiver

- source to image receiver

The absorption of the material of the barrier is included in the g(ζ) factor of Eq 1. So when

an  absorptive  material  is  introduced  the  paths  of  the  images  of  source  and  receiver

weaken and therefore there is a reduction in the noise level.

Are the SRI values of a material ever used in the
calculations in OTL-Suite?

SRI values, are part of the building acoustics module which is currently under development

and not available. OTL-Suite does not handle sound transmission, but if  you wish to see

the  Rw  and  SRI  values  of  structures,  then  you  can  do  so  in  the  multilayered  structure

builder as shown below:

Are paths calculated parallel to each other or after each
other?
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Yes, paths are calculated in parallel.

Would increasing the CPU of my computer increase the
speed of calculation in OTL-Suite?

Yes, upgrading the CPU would be beneficial.

I created a Plate-Air-Plate system in the Multilayered
Structure builder and the resulting SRI is strange.

It  is  important  to  keep  in  mind  that  the  calculated  SRI  shown  in  the  graph  in  the

Multilayered Structure Builder is the statistical SRI which averages the SRI of the structure

at  various  angles  of  incidence.  One  important  consequence  is  that  for  Plate-Air-Plate

structures the first  resonance dip of  the SRI shifts  with different  angles  of  incidence and

when  you  average  them  the  resonance  dip  gets  'smeared'  along  the  frequency domain.

You  can  see  this  in  the  figure  below  taken  from  the  textbook  'Noise  Reduction'  by  L.

Beranek:
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In Figure 13.21 above different  curves correspond to different  angles  of  incidence and if

you average these curves you will get a wide resonance dip across that range. By contrast

when you look at a single angle of incidence and change other parameters (such as mass)

the resonance dip remains fixed (Figure 13.19 below):
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What is the best way to model laminated glazing panes
in the Multilayer Structure Builder?

The best way is to model it by inserting each individual laminated layer for each pane. You

can  compare  the  differences  in  the  two  screenshots  below  (the  top  screenshot  is  a

laminate  structure  with  each  laminate  layer  inserted  individually,  and  the  bottom

screenshot  is  a  structure  with  the  same  dimensions/materials  but  with  each  pane

modelled as a monolithic glass pane):
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The difference affects the critical frequency (the second resonance dip).

How are sound bridges calculated in the Multilayered
Structure Builder

For the time being, only Sharp’s simplified method of taking into account sound bridges is
implemented  in  OTL-Suite based  on  Atalla's  [References]  paper.  One  can  smooth  the
response  by  adding  a  porous  layer  between  a  plate  and  cavity  to  account  for  some
damping losses in the structure, as shown in the screenshots below (top screenshot with
foam layer disabled, bottom image with foam layer enabled). In the future when we finish
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developing  the  Building  Acoustics  module  of  OTL-Suite  we  will  incorporate  the  latest
bridging model by Atalla.

When comparing SRI laboratory measurements of a
structure to the calculated results in the Multilayered
Structure Builder I get accurate results in the high
frequencies but large deviations in the low frequencies.
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Regarding low frequencies in SRI a variation of 10-15 dB is not actually unusual between

laboratory measurements.  The figure below is  taken from  the  2005 paper  ‘Using  Round

Robin Test Results for the Accreditation of Laboratories in the Field of Building Acoustics

in  Germany’  (attached  in  this  email)  and  compares  the  SRI  of  a  partition  in  different

laboratories:

The figure below is similar but for partitions with elastic boundary conditions:
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Therefore,  you  shouldn’t  be  too  concerned  with  trying  to  match  low  frequencies  with

laboratory measurements as the uncertainties are so high.

What are the limitations of the models used in the MLSB
in OTL-Suite?
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Possible  limitations  of  the  models  used  in  the  MLSB  of  OTL  are  as  follows:  panel

resonances are not taken into account, panels are infinite in dimension so no edge effects

are taken into account and the Niche effect is not modelled.

For the SRI calculations is it possible to calculate
specific angles of incidence? Does OTL-Suite take
incidence angles into account?

OTL-Suite only gives the 60 degree angle of incidence for SRI calculations (along with the

averaged), which you can find in the 5th column of the 'Tables>Frequency Spectra' tab in

the Multilayered Structure Builder. 
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Of Course, for the noise calculations specific angles are always considered for calculating

the reflection and diffraction factors (transmission is not yet modelled in OTL-Suite).
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I was trying to run a room acoustics calculation, and I
have received a warning saying that ‘This calculation is
not going to calculate an IR. In order to calculate an
impulse response, you need to change the spectrum
analysis.’ Do they mean the spectrum of the sources?

The warning is only relevant if  you want to calculate the impulse response, else you can

ignore  it.  If  you  want  to  calculate  the  IR  then  the  spectrum  refers  to  the  frequency

spectrum  in  the  ‘Calc  Options’  side  panel,  not  the  source  spectrum.  Just  click  the  'IR

Analysis' button in the Calc Options>Calculations side panel and OTL-Suite will  calculate

an impulse response:
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In the High Resolution graph in the Output Window, the
Level Before/Level After/Level Free Field curves are
always in 1/3 Octave resolution, whereas the IL/EA
Before/EA After curves have the resolution specified in
the Calc Options side panel.

Level  Before/After/Free  Field,  are  always  in  1/3rd  Oct  bands  since  they  include  source

characteristics which are usually given in 1/3 Oct  bands. IL, EA Before/After are shown in
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any  resolution  from  0.001  to  100KHz  because  these  parameters  are  independent  of

source characteristics and are only dependent on 3D model properties which we handle at

any resolution.

Please remember when we carry out experiments we try to eliminate from the results the

effect of the source since the phenomena studied are independent of the type of source one uses.

I sent a model which included a refractive atmosphere to
the origin and the results are different.

If your model contains multiple grounds and has a receiver in the shadow zone of a source

then  theoretically  the  results  changing  the  origin  will  change  the  results  because  when

multiple  grounds  are  present  the  XY plane  is  taken  as  the  reference  ground  (since  the

shadow zone model can only take one ground as reference OTL-Suite cannot know which

ground take as a reference. Therefore it  takes the XY plane as the reference by default

which is why sometimes there may be problems with the results).

This is why we added the new 'Generate Average Ground' tool as it is the only way to get

correct  results.  The tool  replaces multiple grounds with one averaged ground,  averaging

their  height  and  inclination  using  the  least  squares  method.  That  way,  when  a  shadow

zone calculation is performed it takes that averaged ground as a reference which means

the results will always be correct and you won't get the unnaturally high levels for the high

frequencies.

Because the original grounds get lost when you do this, it is a good idea to do this in a new

configuration. You can also just do this only with the problematic receivers that are in the

shadow zone and do the rest of the calculations with the multiple grounds.

I ran a Reverberation Time calculation and the results are
strange.

Check the normals  of  all  your  active surfaces.  Use the 'Auto Correct  Normals'  tool  from

the  'CAD  Tools  Window'  to  fix  most  of  them  and  then  inspect  each  active  surface  to

ensure  that  the  arrow is  pointing  towards  the  interior  of  the  room.  Surfaces  whose  both

sides are exposed to the interior of the room should be double sided. If an active surface

has a normal that is not pointing towards the interior of the room, select that surface, right-
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click, and select the 'Flip Normals of Selected Surfaces' option from the right - click menu.

You can find more information on surface normals in the 'Using CAD Tools' section of the

Help Files.

Also minimise as many of the surfaces as you can to speed up calculations. If the model

was imported from a .dxf/dwg file select the 'Optimised' option to minimise the surfaces.

Is there any way to see the paths used for the ISO
Calculation?  Does the ISO calculation only consider one
reflection order for each path?  

ISO  calculations  only  consider  one  reflection  for  each  path,  however,  the  Path  Explorer

detection is only possible for the Precise Calculations.

I ran an ISO calculation in OTL-Suite over a barrier and
the calculations don’t match my manual calculations.

Make sure you include paths from the sides of the barrier in your manual calculation. 

Alternatively if  you keep making the barrier  wider  the  OTL results  will  begin  to  approach

the results of manual ISO 9613-2 calculation with only the diffraction path from the top of

the barrier included:
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There may also be some minor  discrepancies  due to the way atmospheric  absorption  is

calculated. OTL uses the procedure specified in ISO 9613-1.

I have some noise sources which do not have a direct
line of sight with the receiver. I set the diffraction order
high enough so that diffraction paths should be found
but I couldn’t find any.

You may also need to enable the Non-Parallel diffractions on barriers and walls  found in

the ‘Advanced’ tab of the ‘Calc Options’ side panel.
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Why are the T60, Sabine and Eyring curves so different?
Does it depend on the room shape?

T60 (or T30, T20 and EDT) is the reverberation time calculated using OTL-Suite's Hybrid

Ray Tracing Method (which might result in slightly different values between two

calculations of the same setup which is inherent in the method). Sabine and Eyring are

statistical models that do not take into account sources and receivers in the room only the

room's shape and absorption properties. 

The main difference between the statistical models (Sabine and Eyring) and the Hybrid

Ray Tracing Method is that the statistical models assume a diffuse field whereas the
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Hybrid Ray Tracing Method does not. If the room field is not diffuse then there will be a

difference between the statistical models and the Hybrid Ray Tracing method, since the

Hybrid Ray Tracing Method takes into consideration the positions of the source and

receiver.
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Import Image     108

Impulse Response     204, 206
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Insertion Loss     218, 269
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ISO Settings     154
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Move    

Move Origin     136

Multilayered Structure Builder     244
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Noise Reduction Coefficient (NRC)     269

Noise Sources     31, 37

Line Source     73

Normals     31, 93, 131, 150
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Objects     31

Object Tree     37, 38, 42, 73, 79

Olive Tree Lab - Office     7, 191

Olive Tree Lab - Room     7, 177

Olive Tree Lab - Terrain     7, 154

Open Plan Office     191

Recommended Settings     192

Options     31, 37, 45

Options Menu     27, 37

Origin     154

Output     37, 93

Output Window    

1/3 Octave Curves     31, 79

Detailed Curves     79

Octave Curves     79

- P -
Pan     31

Parameters    

Barrier Type     37

Explorer Tabs     37

Ground Type     31

Meteorological Conditions     37

Noise Source     31, 37

Paths     37

Receiver     31, 37

Roof     31

Patch     37, 126

Paths     31, 37

Top Strongest Paths     165

Point Types     27

Polar Plot     31, 203

Precise Calculations     31

Preferences     37

Printing     31

Reports     266

Projects    

Example Projects     27

New Blank Project     27, 31

Open an Existing Project     27, 31

- R -
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Receivers     31, 37, 79

Reducing surfaces     93

References     346

Reflecting surfaces     154

Reflection Coefficient     154

Reflections     37, 150, 154

Refraction     54, 171

Refresh     31

Registration     19

Relative Levels     150

Reports     31, 266

Reset Settings     37

Results     31, 37, 211, 213, 216, 218

Reverberation Time (RT)     60, 177, 269

Righ Click Option     37

Room Acoustics Calculations     177

Recommended Settings     177

Room Modes     13, 186

Room Parameters     177

Rotate    

Sources     135

Rw     269
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Save    

Save as Image     266

Screenshots     266

Send To Clipboard     266

Send To Report     266

Saving a Project     27

Select     27, 31, 82, 115

Multiple Entities     37

Multiple Receivers     79

Multiple Source     73
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Shadow Zone     171

Short Cut Keys     275

Side Panels (Explorer Tabs)     27, 37

SketchUp     93

Snap to Grid/Surface     31, 73, 79, 87, 115

Solid Termination     244

Sound Absorption Coefficients     255

Sound Bridges     259

Sound Reduction Index     257

Sound Transmission Index (STI)     60, 191

Source Sound Level     269

Source Sphere Radius     45

Sources     73

Spatial Sound Level Distribution     160

SRI     257

Status Bar     27

Structures     244

Studs     269

Support Agreement     19

Surface Impedance     255

Surfaces     181
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Theoretical Background     22

Tool Bars     27, 31, 37

Transfer Function     205

Transparency     37

Tutorial     70

- U -
Updates     19

- V -
Views     31

- W -
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